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MEDICAL EDUCATION TECHNOLOGIES, INC.
BABYSIM SOFTWARE AND USERS GUIDE®©

METI SOFTWARE LICENSE TERMS

Medical Education Technologies, Inc. (METI) is licensed to provide the Software, which is an
integral part of its series of simulation systems. The Software is licensed for use on a designated
single computer system provided with the purchase of a simulator and set forth below as the
“Designated Equipment.” “Software” means a computer program, including any modifications,
updates, software development kits, application program interfaces, or additions, which may be
supplied to you by METI, in object code or executable form, in any medium, which may consist of
a graphical user interface, physiological models, scenario process, data acquisition and control
devices, or patient scenarios, and which includes any related materials such as flow charts, logic
diagrams, manuals, and other documentation which may be provided to you by METI for use in the
Designated Equipment.

Designated Equipment
BabySIM

The following terms govern your use of the enclosed Software:

License Grant

METI grants to you, the user, a personal, non-exclusive, non-transferable, except as otherwise set
forth herein, perpetual license to use one copy of the Software in the Designated Equipment under
the terms and conditions stated herein. The Software may be provided to you as a demonstration
version for evaluation purposes only, with limited operability and/or functionality. In such case, you
agree and acknowledge that METI has provided the Software solely for demonstration purposes
and that, should you subsequently choose to pay to METI the applicable license fee, as established
by METI from time to time, METI will provide a key or other mechanism to unlock the restricted
operability and/or functionality, and your license to use the Software shall convert to a perpetual
license in accordance with all other terms of this license.

Except to the extent that such prohibition is not permitted by applicable law, you shall not make
any modifications to the Software or remove any proprietary, regulatory or safety notices of METI
or third parties found in or on the Software. You further agree not to reverse engineer, decompile or
otherwise reverse assemble any portion of the software or create derivative works based upon the
METI software.
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Ownership

The Software is and shall remain the exclusive property of METI and/or its licensors. This license
confers no title or ownership in the Software and is not a sale of any rights in the Software. No
license other than that specifically stated herein is granted to you, and you shall have no right to
sublicense the Software nor any right under any patent, trademark, copyright, trade secret or other
intellectual property of METI other than that granted by this Agreement.

Copyright

All title and intellectual property rights in and to the content that may be accessed through use of
the Software, Scenarios and User Guide are the property of the respective content owner and may
be protected by applicable copyright or other intellectual property laws and treaties. This
agreement grants you no rights to use such content except as accessed through the Software. If
this Software contains documentation that is provided only in electronic form, you may print one
copy of such electronic documentation.
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Certificate of Compliance

Certificate: 1504921 Master Contract: 223202
Project: 1704296 Date Issued: 2005/09/23

Issued to: Medical Education Technologies Inc.

6000 Fruitville Rd
Sarasota, FL 34232

USA

Attention: Mr. Nigel Parker

The products listed below are eligible to bear the CSA Mark shown
with adjacent indicators ‘C’ and ‘US’

Issued by: Jim Saunders, P. Eng.

US

Authorized by: Gianluca Arcari, P.Eng.,
Product Group Manager

PRODUCTS

CLASS 8721 84 - ELECTRICAL EQUIPMENT FOR LABORATORY USE - Certified to
US Standards
CILASS 8721 04 - LABORATORY EQUIPMENT - Electrical

PART A Adult Emergency Care Simulator, Model ECS100, cord connected, rated 115/230V, 50/60Hz, 2/1 A;
12V dc, SA.

PART B Baby-Sim Emergency Care Simulator, Model BAB-101, cord connected, rated 115/230V, 50/60Hz,
2/TA; 12V de, 5A.

The 'Crand 'US" indicators adjacent to the CSA Mark signify that the product has been evaluated to the applicable CSA and ANSI/UL Standards, for use in Canada and the
U.S, respectively. This 'US" indicator includes products eligible o bear the 'NRTL' indicator. NRTL, i.e. National Recognized Testing Laboratory, is a designation granted
by the U.8. Occupational Safety and Health Administration (OSHA) to laboratories which have been recognized to perform certification to U.S. Standards.

DOD 507 Rev. 2004-06-30
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Certificate: 1504921 Master Contract: 223202

Project: 1704296 Date Issued: 2005/09/23

APPLICABLE REQUIREMENTS

CAN/CSA-C22.2 No. 1010.1-92 - Safety Requirements for Electrical Equipment for Measurement, Control, and
Laboratory Use, Part 1: General Requirements (Includes Amendment 1)

CAN/CSA-C22.2 No.1010.1B-97 - Amendment 2 to CAN/CSA-C22.2 No. 1010.1-92, "Safety Requirements for
Electrical Equipment for Measurement, Control, and Laboratory Use, Part 1: General Requirements"

UL Std No. 61010A-1 - Electrical Equipment for Laboratory Use; Part 1: General Requirements

DOD 507 Rev. 2004-06-30
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Product Certification History

Project Date Description

1704296 2005/09/23 Addition of Model BAB-101
1629830 2005/01/28 Alternate Construction
1504921 2004/01/16 Original Certification, Emergency Care Stimulator, Model ECS100







DECLARATION OF CONFORMITY

(In accordance with EN 45014)

Medical Education Technologies Inc.
6000 Fruitville Road
Sarasota, Florida 34232 USA

declare under our sole responsibility that the product,

Type of Equipment: Human Patient Simulator Manikin
Model Number: EC5-X (AC Input)

to which this declaration relates is in conformirty with the following
standards or other normative documents:

EMC: EN 55011:1998 / A1:1999 Group 1 Class A
EN 61326:1997 / A1:1998
EN 61000-4-2:1995
EN 61000-4-3:2002 / A1:2002
EN 61000-4-4:1995 / A1:2001 / A2:2001
EN 61000-4-5:1995
EN 61000-4-6:1996
EN 61000-4-11:1994
EN 61000-3-2:2000
EN 61000-3-3:1995 / A1:2001

following the provision of the EMC Directive 89/336/EEC.

Sarasota, Florida 34232 USA

Typed Name and Title

European Contact:







DECLARATION OF CONFORMITY

(In accordance with EN 45014)

Medical Education Technologies Inc.
6000 Fruirville Road
Sarasota, Florida 34232 USA

declare under our sole responsibility that the product,

Type of Equipment: Human Patient Simulator Manikin
Model Number: ECS-X (DC Input)

to which this declaration relates is in conformity with the following
standards or other normative documents:

EMC: EN 55011:1998 / A1:1999 Group 1 Class A
EN 61326:1997 / A1:1998
EN 61000-4-2:1995
EN 61000-4-3:2002 / A1:2002
EN 61000-4-4:1995 / A1:2001 / A2:2001
EN 61000-4-5:1995

following the provision of the EMC Directive 89/336/EEC.

Sarasota. Florida 34232 USA

Typed Name and Title

European Contact:
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MHI® Introduction

Introduction

As the worldwide leader in patient simulation technology and education, Medical Education
Technologies, Inc.™ (METI®) is excited to introduce the BabySIM®. Based on the powerful METI
HPS6™ software, the BabySIM incorporates highly developed infant patient physiological
models that generate realistic and automatic responses to clinical interventions and drug
administrations that are specific to infant patients.

METI BabySIM

What makes the BabySIM so unique is its versatility and usability. Combining intricate systems
design and flexible user-oriented software achieves a high-tech, high-touch synergy that creates
realistic learning experiences. The ultra-sophisticated system captures the complexities of
human physiology with heart and breath sounds, palpable pulses and a myriad of other features
that mirror a true and accurate representation of the human body. The intuitive design of the
BabySIM and the realistic physiological models make it easy for instructors as well as learners to
use the system.

The educational value of the BabySIM is summed up in the fact that critical care
interventions such as infant CPR, airway management, drug administration and defibrillation, to
name a few, can be applied to the simulator, better preparing healthcare professionals for critical
events involving infants. With the flexibility of using preprogrammed or user-initiated scenarios,
instructors can create real life drama to help hone and perfect the skills of their learners.
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Contained in this User Guide

This User Guide has been designed for quick access to information on how to use and maintain

your BabySIM system. Please make sure that you read and follow thd-C-a-l;tions/Warnings_'::on the

following four pages. This is for the safety of you and your learners as well as for the protection
of your simulator.

Each subsequent section has been designed to keep valuable information at your fingertips. The

:_Clinical Featuresrsection describes many of the physiological conditions and user interventions

possible with the system. This section is useful when incorporating the use of the BabySIM into
your course curriculum.

Thef Equipment Overviews provides a detailed inventory of your BabySIM system components
and how these components are interrelated. In addition, there is useful content pertaining to the
BabySIM optional equipment in this section. It is helpful to read this section before installing the

system by following the step-by-step instructions included in theié_gt_tip_g Started section.

software, but also how to operate in a Macintosh™ environment, useful information to those
unfamiliar with a Mac.
sy

The;Tabs section contains detailed content on each of the specific parameters.

and the functionality that each supports. Step-by-step instructions on various clinical
interventions are explained in this section along with how these interventions isolate critically
important learning objectives. In addition, a description is provided of the METI preconfigured
patient as well as detailed instructions on how to develop and save your own patients. Also
included is information on the Waveform Display Monitor and the Remote Control.

We encourage you to follow the guidelines in the'._(_:gr_e_/[\/l_a_ir_\t_e_n_a_n_cg section, as this will ensure
that your BabySIM is maintained to the highest standards. Warranty details as well as essential
breakdown, clean up and care information are included in this section, making it a very important
part of keeping your system in good working condition.

And finally, the:_lpg_e)_(iorganizes the User Guide into key words with page references to help you
find what you need.
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Cautions/Warnings

Please read and understand these cautions and warnings before beginning use of the BabySIM
system.

USE OF THIS EQUIPMENT IN AN UNSPECIFIED MANNER, MAY IMPAIR
DESIGNED PROTECTION.

Your safety is in your hands. Be sure to follow the instructions on the proper setup, breakdown
and use of the BabySIM.

SHock HAzARD

Electrical Safety

This product must be connected to an electrical outlet that is properly grounded. Precautions
should be taken so that grounding or polarization is not defeated.

Do not place defibrillator paddles on or adjacent to the ECG patient electrodes or the
PACE patient electrodes. Contact between defibrillator paddles and the ECG/PACE
electrodes may cause injury to the user and damage to the equipment.

The METI BabySIM has been tested to work with the Physio Control Model LifePak 11
defibrillator as well as ZolI® biphasic defibrillators. The use of other defibrillators should
be certified by METI prior to use.

Always have the Power and Communications Unit (PCU) power switch turned off and
unplugged when replacing fuses.

Always use the supplied power cords. Do not substitute.

Do not overdrive the Auxiliary Power Input circuit. Always use DC power sources rated at
12-13.5VDC.
Operate the system from a power source with the following rating:

- 115VAC, 50/60 hertz (cycles per second) (e.g. North America, Japan)

- 230VAC, 50/60 hertz (cycles per second) (e.g. Europe)

Do not spill fluids of any kind in or on any piece of BabySIM equipment.

Compliance with CSA 22.2 No. 1010-1:1992 and UL 61010A-1 requires the BabySIM to
be used indoors.

Do not attempt to disassemble the PCU or service any of the electrical components other
than the changing of fuses.
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Fuse Replacement

The recommended source for replacement fuses is Littlefuse®.

Replace fuses in the Power Entry Module with a 250V/T 2A, slow blow fuse.
(Recommended replacement, Littlefuse 218 002 series.)

Replace F1 with a 250V/T 10A, slow blow fuse. (Recommended replacement, Littlefuse
218 010 series.)

Replace F2 with a 250V/F 5A, fast blow fuse. (Recommended replacement, Littlefuse 217
005 series.)

Replace F3 with a 250V/T 1A, slow blow fuse. (Recommended replacement, Littlefuse 218
001 series.)

Replace F4 with a 250V/T 4A, slow blow fuse. (Recommended replacement, Littlefuse 218
004 series.)

Replace F5 with a 250V/T 5A, slow blow fuse. (Recommended replacement, Littlefuse 218
005 series.)

Latex Warning

METI simulators incorporate latex into their design. When performing certain maintenance pro-
cedures, the latex can become exposed. Users with latex sensitivity should take necessary pre-
cautions when handling the simulator while performing those procedures.
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General Use Warnings

USE OF THIS EQUIPMENT IN AN UNSPECIFIED MANNER, MAY IMPAIR
DESIGNED PROTECTION.

Power and Communications Unit (PCU)

Do not drop, step on, or stack anything on the PCU.
Do not operate the system in rain.

Do not clean the PCU front panel with chemical solvents. Disconnect the PCU from the
power source. Using a clean cloth, dampen with soapy water and lightly wipe. Afterwards,
dry with a clean towel.

Mannequin

Do not disassemble factory-assembled parts of the mannequin.

Make sure that mannequin is set up on a stable, sturdy work surface to avoid collapsing
and causing injury to users.

Do not introduce foreign substances into the airway - with the exception of small amounts
of approved lubricant.

The BabySIM should be operated in ambient temperatures below 104 degrees Fahrenheit
(40 degrees Celsius). Prolonged operation (> 2 hrs) in ambient temperatures greater than
104 degrees Fahrenheit (40 degrees Celsius) will result in anomalous behavior and
out-of-spec performance.

Only perform invasive procedures supported by the system as described in applicable
sections of the User Guide.

Do not pick the mannequin up by the limbs — support head and leverage weight with
torso.

Apply water to the mannequin only in accordance with the supported clinical procedures
identified in this User Guide.

CO, Cylinders

Follow the standard United States Department of Transportation, or applicable national
agency’s warnings and regulations for handling and using compressed gases.

Air and CO» regulators are factory calibrated to 50 psig (345 KPa) - do not tamper with or
attempt to adjust settings. All external air and CO» sources must be regulated to 50 psig
(345 KPa).

0.5



Introduction @B a bySI M®

Specifications

Size: PCU -590 mm x 370 mm x 260 mm
Mannequin — 25 3/4 inches (65.4 cm)

Weight: PCU - 16 Ibs (7 kg); Mannequin — 16 1/4 Ibs (7.37 kQ)

Environmental Specifications:
Operating 41°F to 104°F (5°C to 40°C)
Storage 41°F to 122°F (5°C to 50°C)

The following is for Compliance with CSA 22.2 No. 1010-1, UL 61010A-1 and EN61010-1:
Pollution Degree: 2
Installation Category I
Altitude up to 6,561 ft (2,000 M)
Humidity 92.5% up to 104°F (40°C)
Mains supply voltage fluctuations not to exceed + 10% of nominal supply voltage.

Pneumatic Specifications:

Air 50 - 95 PSI, with peak flow rates up to 1.5 liters per minute
CO» Maximum flow rate = 200 ml/min
Power:
PCU and Mannequin
AC Input AC 100 - 240VAC, 50/60Hz
Consumption  Approx. 94W
DC Input DC 12.0 - 13.5VDC

Consumption  Approx. 72W

Instructor Workstation
AC Input AC 100 - 240VAC, 50/60Hz
Consumption  Approx. 50W

DC Input N/A - Internal Battery
Remote Control

AC Input AC 100 - 240VAC, 50/60Hz
Consumption  Approx. 50W

DC Input N/A - Internal Battery

Waveform Display Monitor
AC Input AC 100 - 240VAC, 50/60Hz
Consumption  Approx. 28W

DC Input N/A - Powered by the PCU

AUX Power In 12VDC 4A
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Mannequin

BabySIM Clinical Features

The METI BabySIM represents the latest in the state-of-the-art simulation technology for
educating clinicians at all levels of medical education. Sophisticated mathematical models of
human physiology and pharmacology automatically determine the effect of user actions and
interventions on the patient, embodied by the mannequin. In this way, patient outcomes result
from clinical interventions and provide a platform for objective performance assessment.

Mannequin

The BabySIM mannequin displays the physical characteristics of a three- to six-month-old patient
with interchangeable male/female genitalia. Fully operational in the supine position, the mannequin
can be placed on standard operating room tables, ICU beds, on the ground or even in a vehicle (in
the case of a simulated accident).

The BabySIM Mannequin

The mannequin allows for the physical assessment of various clinical signs (i.e. heart/breath sounds,
palpable pulses, chest excursion, airway patency, etc.) that are dynamically coupled with the
mathematical models of human physiology and pharmacology.
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Physiological and Pharmacological Features

The BabySIM simulates patient reactions based on complex cardiovascular, pulmonary and
pharmacological models.

Normal and Difficult Airway

The mannequin provides an anatomically realistic upper airway (oropharynx, nasopharynx and
larynx), representing that of a three- to six-month-old patient.

Airway Module Features

Direct laryngoscopy as well as oral and nasal tracheal intubation can be performed.

Esophageal intubation is fully supported, in which case breath sounds, chest excursion
and carbon dioxide output are absent and gastric distension occurs.

A laryngospasm actuator closes the patient's vocal cords and prevents both ventilation
and intubation.

Bronchial Occlusion, when enabled, guarantees that no ventilation is possible, creating a
“cannot ventilate, cannot intubate" crisis scenario.

In addition, the patient's airway supports the use of standard clinical devices such as:

Endotracheal Tube
Laryngeal Mask Airway
Combitube

Lighted Stylets
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Pulmonary System

Pulmonary System

The BabySIM represents a realistic Pulmonary System, using both physical and mathematical
models to achieve an extremely accurate simulation of respiration. This system is tightly
integrated with the Cardiovascular System, as well as other models within the BabySIM system.

Pulmonary System Features

The simulated patient breathes spontaneously with a self-regulated rate and tidal volume
sufficient to maintain a target arterial carbon dioxide partial pressure, typically 40 mmHg, which
can be adjusted by the instructor. The respiratory system is capable of simulating crisis events.

The patient's lungs simulate consumption of oxygen and the production of carbon dioxide in
accordance with the principles of uptake and distribution.

Alveolar and arterial gas concentrations are dynamically coupled with spontaneous or
mechanical ventilation.

The lungs are realistically modeled with respect to the range of tidal volumes and functional
residual capacity.

Lung and chest wall compliance are modeled with independent control of the left and right
lung.

Ventilation results in the appropriate concentrations of alveolar and arterial carbon dioxide.
Presence or absence of exhaled carbon dioxide can be monitored using a colormetric
indicator.

Spontaneous and mechanical modes of ventilation are supported.

Symmetric and asymmetric lung ventilation is automatically supported in response to bilateral
and unilateral compliance and resistance changes, proper or incorrect intubation, as well as
pathophysiological states such as tension pneumothorax. This capability can be
accomplished automatically without intervention of the instructor.

The mannequin's upper chest rises and falls synchronously with the inflationary state of the
underlying lungs. This movement is synchronized with inspiration and expiration of
spontaneous, manual and automatic ventilation of the lungs and combinations thereof. The

depth of chest excursion correlates to the physiologic tidal volume displayed on the user
interface.

The simulated patient generates both normal and abnormal breath sounds, bilateral and
unilateral, which are appropriately synchronized with the respective phases of respiration.
Breath sounds are audible over the apex of each lung with the use of a standard
stethoscope.
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Pulmonary System Features

In the case of esophageal intubation, breath sounds, chest excursion and carbon dioxide
output are automatically absent but the stomach distends with positive pressure ventilation
attempts.

Pulse oximetry is fully supported. The reported oxyhemoglobin saturation correlates correctly
and dynamically with the alveolar oxygen concentration, the patient's intrapulmonary shunt
fraction and the temperature and pH of the arterial blood. The saturation value can be
displayed on the Instructor Workstation or on the optional Remote Control.

The pulmonary response to administered medications is automatic and dose dependent.

The physiological mathematical models continuously calculate the patient's arterial and
venous blood gases and pH. This data can be displayed on the Instructor Workstation or on
the optional Remote Control.

Seesaw respiratory patterns of breathing are demonstrated on the mannequin.

For further information on the Pulmonary System of the BabySIM, refer to the information

regarding'the Respiratory tab in the Tabs section-:of this document.
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Cardiovascular System

Cardiovascular System

Like the BabySIM’s Pulmonary System, with which it is tightly integrated, the Cardiovascular
System accurately simulates a wide variety of hemodynamic conditions and responses.

Cardiovascular System Features

The simulated patient generates heart sounds including a range of pathological ones that are
synchronized to the QRS complex of the ECG and are audible with a standard stethoscope
over the left and right upper sternal border, right lower sternal border and apex.

A 3-lead ECG is emitted from the appropriate positions on the patient’s chest for display on a
standard monitor. The simulator generates a normal sinus ECG, as well as a broad range of
abnormalities such as sinus tachycardia, bradycardia, ventricular fibrillation and asystole.

The hemodynamic response to the arrhythmias is physiologically correct.

Palpable brachial and femoral pulses are provided and are synchronous to the ECG. A pulse
deficit automatically occurs if the systolic arterial blood pressure falls below the following

thresholds:
Brachial: 30 mmHg
Femoral: 30 mmHg

The pulse threshold set points can be adjusted by the instructor to meet specific clinical and
educational requirements. The left and right brachial and femoral pulses are independently
controllable by the instructor for presence and absence in the case of trauma to a specific

extremity.

A standard blood pressure cuff and sphygmomanometer can be used to assess blood pressure
by palpation or by auscultating Korotkoff sounds.
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The invasive hemodynamic monitoring package provides the capability to measure and monitor
the following:

Arterial blood pressure

Left ventricular pressure

Central venous pressure

Right arterial pressure

Right ventricular pressure

Pulmonary artery pressure

Pulmonary artery occlusion (wedge) pressure
In addition, the following responses and interventions are available with the invasive hemodyamic

monitoring package:

The introduction and progressive insertion of a pulmonary artery catheter, synchronous
with the appropriate waveforms, can be simulated with the results shown on the patient
Waveform Display.

The patient has a baroreceptor reflex, the sensitivity of which can be controlled by the
instructor.

The cardiovascular system simulates both hypovolemia and hypervolemia as well as right
and/or left heart failure.

The patient's cardiovascular response to medications is automatic and dose dependent.
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Metabolic System

Metabolic System

Arterial blood gases (ABGs), including pH, PaCO», and PaO,, and venous blood gas values
(PvCOy, PvOo) are physiologically modeled within the system so that the results are made
available on the Instructor Workstation and on the optional Remote Control. The data displayed
corresponds accurately and dynamically to the alveolar concentration of CO5 and Oo. Metabolic
acidosis and alkalosis are simulated under instructor adjustment of the pH level, thus facilitating
simulation of patients with diabetic ketoacidosis. Bowel sounds are able to be auscultated to the
left and right of the umbilicus.

Genitourinary System

The mannequin is provided with both male and female genitalia. The genitourinary system
provides for excretion of urine with a flow rate that is controlled by the instructor.

Neurologic System

Cardiovascular and respiratory responses to sympathetic and parasympathetic activities are
modeled. In addition to the preconfigured sounds provided with the system, phonation, and
patient voice are available via a wireless microphone transmitter/receiver and speaker in the head
of the mannequin. An anterior fontanel is palpable that displays bulging upon activation via the
software.
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Pediatric Advanced Life Support (PALS) System

The unique integration of the BabySIM physical and mathematical respiratory models with its
sophisticated cardiovascular models makes the BabySIM an extremely powerful tool for
education in PALS, resuscitation and CPR. The following elaborates upon the capabilities of the
BabySIM as they relate to such training.

[ Airway Management and Ventilation: Alveolar and arterial gas concentrations appropriately
reflect the efficacy of the employed ventilatory technique, such as bag-valve-mask, and
endotracheal intubation. Administration of supplemental oxygen is entered by the instructor with
automatic and appropriate patient clinical responses.

[l Chest Compression: In accordance with PALS guidelines, effective chest compression of the
patient's sternum results in artificial circulation, cardiac output, central and peripheral blood
pressures, palpable pulses and CO5 return. Pressure fluctuations are seen on invasive catheter
waveforms. The presence or absence of exhaled CO, is directly related to chest compression
effectiveness and automatically and significantly increases when cardiac resuscitation is
successful.

[ Cardiac Arrhythmias: The instructor is able to select and maintain a desired arrhythmia and
control the simulated patient's response to clinical interventions.

[ Electrical Therapy: Conventional defibrillators can be applied to the simulator. With this device,
the delivered energy is quantified in real-time to trigger the appropriate patient response. The
ECG can be monitored via the defibrillator contacts (paddles or pads). Also, transcutaneous
pacemakers can be applied. The instructor is able to adjust the levels at which electrical capture
and mechanical capture occur.

[l Pharmacological Therapy: Common IV drugs required by the PALS algorithms are supported.

For further information on using the BabySIM in support of PALS, resusmtahon and CPR education,

refer to the Using the System section as well astthe Cardiovascularand Besplratory-parts of the Tabs
section of this User Guide.
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Trauma Features

Trauma Features

The BabySIM is equipped with a number of features specifically targeted to support training for
trauma care. The following provides a general overview of each feature.

[l Eye Signs: Each eye has functional eyelids that blink and pupils that can be adjusted
independently to three levels of dilation (e.g. pinpoint, normal, blown).

[ Needle Decompression of Tension Pneumothorax: Decompression of a tension pneumothorax
can be performed by inserting a needle at the mid-clavicular line of the second intercostal space
on the right side of the mannequin. Proper needle placement results in rapid decompression, a
rush of air exiting the proximal end of the needle, and improvement in pulmonary mechanics and
gas exchange.

[ Chest Tube Placement and Management: A chest tube can be inserted into the mid-axillary line
of the fifth intercostal space on the right side of the mannequin. Using ordinary pediatric chest
tube suction equipment, fluid and air can be withdrawn from the pleural space. The volume
removed influences the patient's physiology to reflect improvement in pulmonary mechanics and
gas exchange.

[ Secretions: Body fluids can be excreted from the eyes, ears and mouth.
j=mmmmmmmmmmsss=====-

of this User Guide.
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Pharmacology System

The BabySIM Pharmacology System facilitates the administration of IV drugs.

Pharmacology System Features

The pharmacology module contains pre-programmed pharmacokinetic and pharmacodynamic
parameters for six intravenous medications.

Atropine

Epinephrine

Dopamine

Fentanyl

Morphine

Succinylcholine

The patient mannequin allows for intravenous access through a permanent access catheter
located at the left femoral vein.

Bolus injections are administered utilizing standard syringes while continuous intravenous
infusions can be administered utilizing a wide variety of standard infusion pumps. Both
injection methods are entered from either the Instructor Workstation or optional Remote
Control. Once the dosage is entered, the patient response is automatic and dependent on
patient weight, physiological status, ongoing therapeutic interventions and injury/disease
status.

The patient appropriately and automatically responds to incorrect medications with no user
intervention necessary. Likewise, over- and under-dose response is appropriate.

The Drug Log feature of the software allows the instructor to quickly review all boluses and
current drug infusions given by the learner.

For further information on the BabySIM Pharmacology System, refer to information on the Drugs
tab in the Tabs section of this User Guide.
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BabySIM Patients and Scenarios

The BabySIM is a model-driven, script-controlled system designed to simulate a patient’s
physiological condition, clinical signs, symptoms and responses to certain clinical interventions.
The preconfigured Patient and multiple Scenarios provided with the HPS6 software supply the
basis for an unlimited number of clinical situations.

Patient Files

In the software, each patient is represented by a patient file that defines the initial condition of the
simulated patient's physiology and sets the values of the parameters and variables upon which
that patient’s physiological and pharmacological models are based. For example, a patient file
initially sets the respiratory rate of the simulated patient's lungs — as well as other specific
values. Once a patient file is loaded, the models automatically regulate the simulated patient's
physiology in accordance with the type of patient defined.

The BabySIM is supplied with one preconfigured patient, Baby Ryan, representing a three- to
six-month old male.

The preconfigured patient cannot be overwritten, but new patients can be created and saved, and
existing patients can be modified, depending on the needs of the instructor.

Scenarios

The BabySIM system includes four preconfigured scenarios, or clinical simulations, that
cover a range of events and crises:

Increased ICP

Infant Shock

RSV Bronchiolitis
Sedation Induced Apnea

By utilizing the Scenario Editor feature of the HPS6 Software, users can modify the preconfigured
scenarios or create custom scenarios to meet specific educational objectives.

Each clinical simulation includes a software scenario, which is a set of simulator commands that
instruct or cause the simulator to react or respond in a specific manner. Scenarios are used to
determine the initial and subsequent physiological states as well as the different conditions that
arise during the simulation exercise. Each simulation also includes logged documentation to
support its use.

Instructors may also modify events within a given scenario in real time to increase/decrease event
severity, and shorten or prolong the duration of an event at any time during a simulation exercise.
Any patient can be combined with any scenario, creating a wide variety of clinical care
simulations.
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For instructions on modifying scenarios and creating new scenarios, refer to information on the

vScenario tab located in the Iqu_gqthop_bf this User Guide. For instructions on modifying patients

and creating new patients, refer togthe Using_t_h_e_§¥s_tgr_n_-s_-q-c_=ti_(-)_r-1_:of this User Guide.

Patient Monitoring

The Waveform Display system allows for physiological waveforms and numeric data to be
displayed in real-time without requiring a full-function patient monitor. Users can select from a
number of parameters to configure the Waveform Display to address specific learning objectives.
The following patient monitoring parameters are supported:

3-lead ECG

Arterial Blood Pressure

Pulmonary Artery Pressure

Pulmonary Capillary Wedge Pressure

Central Venous Pressure

Pulse Oximetry

Body Temperature

Arterial Temperature

Rectal Temperature

Axial Temperature

Noninvasive Blood Pressure

Alarm limits with accompanying sounds can be configured for each parameter. When the
pulse/heart rate is monitored, an accompanying sound is played in synchrony with the cardiac
cycle. When pulse oximetry is monitored, the sound pitch dynamically correlates with the percent
saturation. A 3-lead ECG is emitted from the appropriate positions on the chest of the patient
mannequin for display on a standard monitor. The simulator generates a normal sinus ECG,
as well as a broad range of abnormalities including sinus tachycardia, bradycardia,
ventricular fibrillation and asystole.
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System Controls

The BabySIM has been designed to allow the instructor to focus attention on learner actions and
reactions by providing a flexible set of tools that adjust readily to the instructor’s needs.

Main Application Software

The Main Application Software provides the instructor a means to control all features of the
simulator. Instructors can select patient profiles and scenarios as well as control the flow of
the scenarios via the user interface. Various drug, cardiovascular, respiratory, fluid and other
parameters can be individually applied "on the fly" to enhance the course of a simulation
exercise. A Heads-Up Display (HUD) and set of simulation log windows provides a real-time
display of vital signs, blood gases, drugs administered and other events.

System Tools

Instructor Workstation: An Instructor Workstation enables the instructor to control all aspects of
the simulator. Instructors can select a given patient profile or scenarios, and control the flow of a
simulation exercise while monitoring patient parameters, drugs administered and other
interventions. Additionally, all patient parameters can be adjusted "on the fly" to enhance the
teaching points of the simulation in progress. The windowed, point and click design of the
software provides an intuitive, easy to learn, and easy to use operator/instructor interface.

Remote Control (Optional): A full-function wireless Remote Control device (laptop) enables the
instructor to control all aspects of the simulator from the bedside. The screens and control
structure of the Remote Control look and function identically to that of the Instructor Workstation.
Because the user interfaces on both the Instructor Workstation and Remote Control are identical,
instructors only have to familiarize themselves with a single control interface.

Battery Power (Optional): The patient simulator equipment can be operated on battery power.

Portable Simulator: The patient simulator equipment is fully portable and easily transported in the
hard-sided carrying case.

Apple Macintosh Computer Platform: Both the Instructor Workstation and the optional Remote
Control operate upon the Apple Macintosh computer platform. All Macintosh computers use the
OS X operating system — the operating system with a Unix foundation that supports real-time
simulation with an intuitive graphical user interface.
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Open System Architecture

The Main Application Software and the software for the Waveform Display both run on the
Instructor Workstation. Users can take the Instructor Workstation to another location to develop
simulations independent of the patient mannequin.
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Components Inventory

Equipment Overview

The METI BabySIM has been designed to be used in any learning environment. The BabySIM’s
standard features are easily integrated into a laboratory setting where the BabySIM can be
operated using controlled central air/gas supply sources and regular AC power. However,
because the portability of the BabySIM allows for its use in offsite locations, an optional Air
Compressor and an optional Auxiliary Power Supply are available for those areas that do not have
a central air/gas supply or an electrical power source.

Components Inventory

The BabySIM comes with all the necessary equipment for establishing an educational simulation
center for the study of infant care.

Standard Equipment

BabySIM Mannequin and Umbilical Assembly

Mannequin Carrying Case

PCU with Wireless Receiver

Instructor Workstation (Laptop) and Ethernet Cable

Waveform Display Monitor, Video Cable and Adapter

Replacement Parts Kit

Wireless Microphone

Detailed descriptions of this equipment can be found in the section BabySIM Standard

Equipment, beginning on:ﬁéée' 2730

IMPORTANT: METI packaging is specially designed to protect METI products during shipping.
It is important that you KEEP all of your original SHIPPING MATERIALS, including the boxes.
All warranty and repair items must be return shipped to METI in the original packaging.
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Optional equipment is available to accommodate special customer requirements. For example,
options like auxiliary power, air compressors, and a wireless remote enable instructors to create
real-life scenarios at authentic locations.

Optional Equipment

Auxiliary Power Supply

Air Compressors (In-Room and Out-of-Room)

Wireless Remote Kit (Laptop)

Shoulder Bag and Sleeves

Computer Stand

Gas Accessory Kit

CO, Regulator, Hose, and Tank Wrench

Detailed descriptions of this equipment can be found in the section Optional Equipment for the

BabySIM, beginning onipage 2.11 H

As you would with any shipment, crosscheck this inventory with your METI packing invoice to
verify that all components have been received.

Contact a METI Sales Representative at 866-462-7920 if there are any questions or if optional
equipment is needed.
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BabySIM Standard Equipment

The design of the BabySIM system allows students to focus on the patient mannequin while
giving instructors the ability to create an endless number of possible clinical situations.

Full-Body Infant Mannequin and Umbilical Assembly

All patient assessments and clinical interventions are played out on the BabySIM mannequin,
which represents a three- to six-month-old infant. At 25 3/4” (65.4 cm) in height and weighing
16 1/4 pounds (7.37 kg) , the mannequin is fully operational in the supine position and can be
placed on any flat surface such as a gurney, an emergency room operating table, the ground, or
even in a vehicle. The mannequin offers features like breath and heart sounds, palpable pulses,
baby sounds, genitourinary features and airway management features.

Full Body Infant Mannequin

A bundled system of hoses known as the fluidic/pneumatic pigtail and an electrical cable called
the electrical pigtail are attached to the mannequin in the perineum area. Both pigtails attach to
the Umbilical Assembly.

The Umbilical Assembly holds a bundle of color-coded hoses and an electrical cable. The
electrical cable, which provides power and transmits information from the Instructor Workstation,
has a specialized fitting that connects to the PCU’s 12-volt DC power source. The bundle of
colored hoses connects to the receptacle beneath the electrical cable on the PCU. These hoses
provide for a variety a functions:

IV Source (currently unused)
IV Drain

Trauma Source
GU Source
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Hard-Sided Mannequin Carrying Case

The Hard-Sided Mannequin Carrying Case is designed to
keep the mannequin secure during transport and storage.

Inside the case are foam inserts that hold the mannequin
in place and enough extra room for storing clinical
accessories.

With heavy-duty wheels and durable handles, the case can
be rolled or carried easily between locations.

Replacement Parts Kit

A Replacement Parts Kit is included with the BabySIM.
Details on how to use the replacement parts can be found in
the Using the System section of this User Guide.

The Replacement Parts Kit includes:

e Manual Blood Pressure Adapter
e PCU Fuse Kit

e Silicone Lubricant Spray

* Red Tape

¢ PCU Hose Fittings (2)

e Cable Clamps (2)

¢ Secretion Adapters (3)

e Interchangeable Female Genitalia
¢ (The mannequin is shipped with the male genitalia
e attached.)

¢ Hard-Sided

e Mannequin Carrying Case

Hard-Sided Mannequin
Carrying Case
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Standard Equipment

Power and Communications Unit (PCU)

The PCU is the hub of communication and power for the BabySIM
system. This unit is about 24" tall x 15" wide x 10" deep (610 mm tall
x 380 mm wide x 254 mm deep) and weighs about 10 pounds (5 kg).
Conveniently contained in a rolling, hard-sided case, the PCU is the
most central of all the BabySIM system components. Inside the PCU
is a DC power supply and the Wireless Ethernet Switch.

When in operation, the PCU should be placed horizontally so that the

cover opens upward as shown in the picture to the right. BabySIM PCU

Located beneath the cover on the PCU Interface Panel is the Wireless Receiver, the power switch
and a number of labeled ports.
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PCU Interface Panel

2.5



Equipment Overview gBabYSI M

PCU Power Ports, Fuses and Switch

Located in the upper left of the PCU are the electrical controls, the source of the power for the
PCU as well as the monitor.

1 ACIN : 6

FUSE: 250V /T 2A =
250V/T 10A

= F2 ;
N OFF 3 250V/F 5A
DISCONNECT - -

SUPPLY A
POWER F3
BEFORE on @ 250V/T 1A

SERVICING
AUX POWER .
MONITOR IN Fa
POWER 12VDC==4A 7 250V/T4A

F5
250V/T 5A

PCU Power Ports, Fuses, and Switch

In a standard laboratory configuration (using AC Power), the power cord is plugged into the
AC IN port. This should be done prior to plugging the cord into the power source, which should
be a surge-protected outlet to protect the integrity of the electrical system and reduce the chance
of blowing fuses.

NOTE: Beside the AC IN port is small fuse panel labeled Fuse: 250V/T2A. Before replacing a
burnt fuse, refer to the Cautions/Warnings found in the Introduction section of this User Guide.

The POWER SWITCH is used to turn the PCU ON and OFF, whether running on standard
AC current or utilizing a 12-volt DC power supply.

A green indicator light labeled POWER ON illuminates when the PCU is running.

n When the PCU is running off 12-volt DC power, the MONITOR POWER port supplies power
to the Waveform Display Monitor using the supplied adapter cord.

B The AUX POWER IN 12VDC-4A port allows the BabySIM system to be run from a 12-volt
DC power source such as the optional Auxiliary Power Supply.

ﬂ The five fuses housed in the ports labeled F1 through F5 are identified by their voltage and
amperage. To change a fuse, open the port cap with a flathead screwdriver so that the burnt fuse
pops out. Be sure to choose the correct fuse from the Spare Fuse Kit when selecting a
replacement. The new fuse is secured by replacing the cap and tightening it with a flathead
screwdriver.

NOTE: Before replacing a burnt fuse, refer to the Cautions/Warnings found in the Introduction
section of this User Guide.
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Standard Equipment

Umbilical Ports

The two large circular fittings labeled UMBILICAL are used to connect the mannequin via the
umbilical to the PCU.

UMBILICAL

Umbilical Ports

The upper circular port is the receptacle for the umbilical’s electrical cable and has a
notched fitting where the cable connects and locks into place. This connection establishes the
communication of electrical input/output and computer signals to the mannequin.

E The lower circular port is the receptacle for the pneumatic/fluidic portion of the umbilical
and has a white plastic fitting into which the five hoses wrapped in the umbilical are secured. The
pneumatic/fluidic assembly allows gases (CO5 and air) to flow to the PCU and back to the
mannequin.
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Instructor Workstation Uplink and Expansion Ports

There are three Ethernet and two RS-232 ports on the PCU. At present, only the INSTRUCTOR
WORKSTATION port is used. The other ports are available for future product enhancements.

INSTRUCTOR
WORK
STATION

UPLINK

3

Instructor Workstation Uplink and Expansion Ports

The INSTRUCTOR WORKSTATION port connects the Instructor Workstation (the laptop)
to the PCU through an Ethernet cable.

A Wireless Ethernet Switch inside the PCU directs signals from the Instructor Workstation to the
patient mannequin. The switch is maintenance-free and requires no usage or care instructions.

n The two RS-232 ports and the UPLINK and SPARE Ethernet ports are available as
expansion ports for future product development. They are currently not utilized.

Gas Supply Connections

At the bottom-left of the PCU Interface Panel are two ports labeled MAIN SUPPLY GAS AIR-OR-
CO5 and EXPIRED CO5 SUPPLY along with their pressure specifications: 50 PSIG/345 kPa.

MAIN
EXPIRED SUPPLY
CO: GAS

1
SUPPLY AIR-OR-CO:
50 PSIG/345 kPa 50 PSIG/345 kPa

® O

Gas Supply Connections

The MAIN SUPPLY GAS AIR-OR-CO, port is used to connect compressed air or gas via
a hose to the PCU. With this connection, various "life signs" can be displayed on the mannequin,
such as breathing and pulses.

n For the mannequin to exhale CO», a CO5 source must be connected to the EXPIRED CO»
SUPPLY port.

An optional Gas Accessory Kit is available for connecting CO» to the PCU.
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Standard Equipment

Audio Jack and Wireless Channel Set

The small jack labeled AUDIO OUT allows you to connect the simulator's audio outputs directly
into an available audio/visual system to amplify the patient’s sounds for a larger audience.

7)) AUDIO

& our

Audio Jack
Currently, only Heart Sounds are reproduced and all sounds are reproduced monaurally. At this
time, the Waveform Display Monitor does not utilize the audio feature of the PCU.

The Wireless Receiver works in tandem with the Wireless Remote Microphone to provide the
instructor with a means of verbal communication through the mannequin.

Wireless Channel Set

The dual antennas of the microphone pull out to increase range, and the receiver has a channel
selection and volume control feature to produce high quality sound. The receiver is powered from
a power supply inside the PCU.
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Computer Components

The BabySIM computer system is comprised of an Instructor Workstation and a Waveform
Display Monitor.

Instructor Workstation

The Instructor Workstation is a laptop computer that utilizes the METI HPS6 software to operate
as the main simulation control center.

Instructor Workstation

The computer runs the underlying mathematical models that generate the physiological data that
is realized on the mannequin. Instructors control the simulator session from the Workstation by
selecting patient profiles and scenarios that meet the objectives of the training module. A standard
Ethernet cable attaches the computer to the PCU.

Waveform Display Monitor

To view the patient physiological changes, a Waveform Display Monitor is provided with the
BabySIM. This monitor plugs directly into the Instructor Workstation using a video cable.

Waveform Display Monitor

The Waveform Display application is launched from the Instructor Workstation and appears
automatically on the monitor. Using the Waveform Display monitor and software, instructors and
learners can monitor the progress of various interventions and protocols on the patient.

IMPORTANT: All METI computer components are preconfigured for use with the BabySIM
system. There are no software installation or configuration steps required. Only approved METI
applications should be installed or run on the BabySIM computer system.
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Optional Equipment for the BabySIM

Additional components enable the BabySIM system to be customized to fit the specific needs
of a wide variety of education environments.

Wireless Remote Control

METI offers an optional Wireless Remote Control laptop to be used
when the use of a power cord is restrictive.

Preconfigured with the same software as the Instructor Workstation,
the Wireless Remote Control connects to the PCU using a wireless
signal.

To order this option, refer to product #HPS-501.

Computer Stand

METI offers an optional computer stand that is designed to support
the Instructor Workstation, the Waveform Display Monitor and the
optional Remote Control unit.

Each stand is made of sturdy metal and weighs less than 2 pounds

(less than 1 kg). Wireless Remote Control
and
To order this option, refer to product #STN-001. Computer Stand

Shoulder Bag and Sleeves

The optional Shoulder Bag with padded sleeves can be used to carry computer components to
another location or to store the system when it is not in use.

Shoulder Bag and Sleeves
The shoulder bag is soft-sided and large enough to hold all of the available computer components
as well as the various power supply and cables.

To order this option, refer to product #CAS-001.
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Auxiliary Power Supply

METI makes available two different Auxiliary Power Supply options for running the BabySIM
system in a remote location. Both components include a 12-volt DC power source and a 25’ (7.5
meter) cable with the appropriate fittings to connect to the PCU Interface Panel in the port labeled
AUXIN 12VDC.

=3

Auxiliary Power Supply Kit Auxiliary Power Supply Kit
#APS-001 #APS-002

The Auxiliary Power Supply should run the system for approximately three hours. Both of the
METI options are rechargeable using a local AC power source.

To order one of these option, refer to product #APS-001 and #ASP-002.

Any auxiliary power supply used with the BabySIM must agree with the following specifications:

AC Input: AC 100-240VAC, 50/60 Hz
Consumption: Approx. 94W
DC Input: DC 12.0 — 13.5VDC

Consumption: Approx. 72W
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Optional Equipment
Air Compressor

For educational environments with power but no central air/gas supply, two air compressors are
available as options. An air compressor designed for quiet operation is available for in-room use,
and an alternative air compressor is available for situations where the compressor resides in a
location, such as a storage room, set apart from the simulator.

Out-of-Room Air Compressor Quiet In-Room Air Compressor
#AIR-002 #AIR-003

Both Air Compressors are AC powered and include a regulator and an air hose with the
appropriate connector fitting.

To order this option, refer to product #AIR-002 and #AIR-003.

Gas Accessory Kit

The Gas Accessory Kit includes two complete assemblies for connecting a central supply of
compressed air and CO» to the PCU.

Gas Accessory Kit

Both assemblies have color-coded hoses (yellow for air and gray for CO») which are attached to
independent adjustable pressure regulators. These regulators are used to ensure the pressure
supplied to the system is 50 psig/345 kPa. The appropriate PCU fittings are attached to the other
end of the hoses for easy configuration.

To order this option, refer to product #GAS-005.
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CO5 Regulator Assembly

The CO» regulator attaches readily to a small CO5 canister.

Attaching the CO5 Regulator CO5 Regulator Connected

A wrench is supplied with the regulator to open the CO, valve on the canister. The regulator is
factory set for 50 psig/ 345 kPa.

Please refer to the Cautions/Warnings located in the Introduction section of this User Guide for
safety instructions.

Follow local warnings for the handling and use of compressed gas.
Use extreme caution when fastening the regulator into place.

Keep the CO5 canister in an upright position when attached to the regulator. Failure to do
so could cause damage to the CO5 regulator.
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Setting Up

Getting Started

The BabySIM system is comprised of four basic components:

The Mannequin
The PCU
The Instructor Workstation

The Waveform Display Monitor

Basic setup requires connecting these four components as well as the air/gas and electrical
supplies. Setting up the BabySIM system the first time should take approximately 30 minutes,
but setup time is reduced with practice.

Setting Up

The table below outlines the steps required for configuring the BabySIM system.

Setup Steps

Prepare the Work Area

—

Attach Umbilical Assembly to Mannequin
Position the PCU
Connect the Umbilical Assembly to the PCU

Connect Air/Gas Source to the PCU

Configure the Instructor Workstation

Configure the Waveform Display Monitor

Connect Instructor Workstation to Waveform Display Monitor

© 0O N o a » O DN

Establish Ethernet Connection

10 Power On the PCU

11 Power On the Waveform Display Monitor

12 Power On the Instructor Workstation

ol ,:I] Power On the Wireless Remote Control

13| Set Up the Wireless Remote Microphone

Further details for each of these steps are included in the pages that follow.
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Before Beginning

Proper operation of the BabySIM requires correct configuration. Before setting up the system,
keep in mind these basic guidelines:

Understand the Cautions/Warnings information located in the Introduction section of this
User Guide.

Follow the sequence of steps carefully:
Complete all steps in order,
Do not power on any components until instructed in the text, and
Do not attach air/gas supplies until instructed in the text.

KEEP all original shipping materials, including the BOXES - warranty and repair items must
be return shipped to METI in their original packaging.

If unpacking the BabySIM system for the first time, careful use of a box cutter protects both the
packaging and the product.

Because shipping materials should be stored and retained, be sure that all protective packing
materials and unused ancillary computer parts are secured as well.

A Setup Map and Quick Start Chart cover these same steps in abbreviated fashion and are
included with this User Guide.
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Setting Up

Step 1: Prepare the Work Area

Select a work area with enough room for the equipment as well as necessary hoses and cables,
providing ample space for easy access to the mannequin. As least a 10’ x 12’ (3 meter x 4 meter)
work area is recommended for movement and positioning of components around the mannequin.

The BabySIM Mannequin and Case

Place the mannequin in the supine position on the work surface (e.g. gurney, table, ground, etc.)
and prepare all other components.

In a lab environment, make sure that a multi-plug AC power outlet exists within the workspace.
This outlet should be surge-protected. The PCU, Instructor Workstation and the Waveform
Display all require power in this configuration.

In a remote setting, the OPTIONAL Wireless Remote Control, Air Compressor, and Auxiliary
Power Supply may take the place of the Instructor Workstation, laboratory gas and power
supplies.
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Step 2: Attach Umbilical Assembly to Mannequin

The fluidic/pneumatic pigtail, a bundled system of hoses, and the electrical pigtail extend from
the left side of the baby mannequin. Both pigtails attach to the Umbilical Assembly.

The electrical pigtail

The fluidic/pneumatic pigtail

The Mannequin with Pigtails

Attach the fluidic/pneumatic pigtail fitting to the Umbilical Assembly using the end with the
rounded hose attachment, called the pneumatic coupler.

Connection lock

R
) )
]

0

Fluidic/Pneumatic Connection to Umbilical

Once the two assemblies are fit into place, the tab lock secures them into position.

There are four unattached hoses coming from the Umbilical Assembly: red (IV Source, currently
not used), blue (IV Drain), orange (GU Source) and white (Trauma Source). These hoses are used
in various clinical procedures and are discussed with those procedures later in this User Guide.
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Setting Up

Connect the electrical cable from the Umbilical Assembly to the fitting on the electrical pigtail.
Use the small notches on the inside edge of the pigtail as a guide when sliding the fittings
together.

Line up notches for
proper connection.

Electrical Connection to Umbilical

Once the two ends are connected, rotate the fitting on the outside portion of the connection
clockwise until tight.

Tighten Fitting
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Step 3: Position the PCU

Position the PCU on the left side of the mannequin (where the pigtails and Umbilical Assembly
are located). Allow for enough space for movement around the mannequin without jeopardizing
the 12 foot Umbilical Assembly that extends from the mannequin to the PCU.

Place the PCU case flat on the floor (like an open suitcase) and open the door to expose the PCU
Interface Panel.

The PCU in Position
Do NOT plug in the PCU at this time.

Leave the power switch in the OFF position.

Step 4: Connect the Umbilical Assembly to the PCU

Attach the fluidic/pneumatic coupler to the lower UMBILICAL port on the PCU.
L

Fluidic/Pneumatic Coupler Connected to PCU
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Setting Up

Next, attach the electrical portion of the cable to the upper UMBILICAL port.

3

Electrical Cable Connected to PCU

Line up the small tabs and notches on the fittings to slide them together before turning and
tightening the connection.

Step 5: Connect Air and/or Gas Hose(s) to PCU

Connect either a compressed air source hose or a CO5 supply hose to the port labeled MAIN
SUPPLY GAS AIR-OR-CO». This connection provides either the air or carbon dioxide used to
create various mannequin “life signs.”

Connecting Air or CO5 to PCU

Compressed air and gas sources must be pressurized to 50 psig/345kPa.

In remote settings, or in locations without a central air supply, an OPTIONAL Air Compressor is
connected to the PCU at the MAIN SUPPLY GAS AIR-OR-CO5 port.

The OPTIONAL Gas Accessory Kit is available for locations with larger compressed gas
cylinders.

3.7



Getting Started rBa bYSI i

For the mannequin to expire CO», attach a CO, source hose to the EXPIRED CO, SUPPLY port.

Connecting Expired CO5 to PCU

CO5 sources must be pressurized to 50 psig/345 kPa.

When using a portable CO5 supply, the CO, Adapter connects with the CO5 supply and the PCU
to operate the mannequin on CO5 as well as to expire CO».

CO, Adapter

The branches of the Y-shaped adapter are connected to the MAIN SUPPLY GAS AIR-OR-CO»
and the EXPIRED COo SUPPLY ports and the remaining connection is made to the portable CO»

supply.
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Setting Up

Step 6: Configure the Instructor Workstation

Place the Instructor Workstation (laptop) at the location (e.g. desk, table) where it will be used.
Plug the AC power adapter into the power port on the laptop.

Plug the AC Adapter into the Laptop
Plug the other end of the AC adapter into a surge-protected AC power outlet.

For remote use, the laptop computer has battery power. Check to be sure that the battery is fully
charged (up to 6 hours of battery life) before relying on the laptop without an AC power source.

An OPTIONAL Computer Stand is available to support the Instructor Workstation.

Step 7: Configure the Waveform Display Monitor

Place the Waveform Display Monitor to the right of the Instructor Workstation in a location
easily visible for those examining the mannequin. Plug the AC power cable into the port on the
back of the monitor.

Plug the AC Cable into the Waveform Display Monitor

Plug the cable into a surge-protected AC power outlet.

The Waveform Display Monitor can also be powered through the PCU by plugging the cable
labeled MONITOR POWER (included with the monitor) into the Waveform Display Monitor and
connecting this cable to the PCU port labeled MONITOR POWER. This configuration is also
employed when using the OPTIONAL Auxiliary Power Supply in a remote setting.
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Step 8: Connect Instructor Workstation to Waveform Display Monitor

Connect the Macintosh cable adapter to the video cable. Tighten the thumbscrews on the video
cable to secure the connection.

L

Video Cable

Connect Video Cable and Apple Cable Adapter

Plug the remaining end of the Macintosh cable adapter (with the |D | icon) into the port on the
Instructor Workstation with the same icon.

Plug the Cable Adapter into the Workstation

Plug the remaining end of the video cable into the back of the Waveform Display Monitor and
tighten the thumbscrews to secure the connection.

Connect the Video Cable to the Monitor

The system is now configured to display the Waveform Display software on the external monitor.
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Setting Up
Waveform Display Monitors have external speakers that can be connected to the Instructor

Workstation so that the sounds produced come through the monitor’s speakers instead of those
on the Instructor Workstation.

Monitors also come with an audio cable and an audio extension cable. The extension cable is
used when required by the distance between the Workstation and Display Monitor.

Plug one end of the audio cable into the speaker port (not the headphone port) at the back of the
monitor.

Connect the Audio Cable to the Monitor

Plug the other end of the audio cable into the analog external speaker port identified by
the Audio Input Icon on the Instructor Workstation.

The Audio
Input Icon

Connect the Audio Cable to the Workstation

The Waveform Display Monitor is now completely configured with the Instructor Workstation.

Instructor Workstation and Waveform Display Monitor
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Step 9: Establish Ethernet Cable Connection

Plug one end of the Ethernet cable into the Instructor Workstation.

Connect the Ethernet Cable to the Workstation

Plug the other end of the Ethernet cable into the port on the PCU labeled INSTRUCTOR
WORKSTATION.

Connect the Ethernet Cable to the PCU
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Setting Up

Step 10: Power On the PCU

In standard laboratory settings, plug the power cord into the PCU port labeled AC IN.

i: / ~ Ao T 2.
Connect the Ethernet Cable to the Workstation

If operating at a remote setting with the OPTIONAL Auxiliary Power Supply, connect the supplied

power cable to the Auxiliary Power Supply before connecting the other end to the PCU port

labeled AUX POWER IN 12VDC.

Power on the Auxiliary Power Supply before pressing the PCU POWER SWITCH to ON.

—

£
€

/ ////////,‘

§§$§?
1

R

Locating the PCU’s Auxiliary Power Port
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Step 11: Power On the Waveform Display Monitor

Press the power button on the front of the Waveform Display Monitor.

Power On the Waveform Display Monitor
Step 12: Power On the Instructor Workstation

To turn on the Instructor Workstation, open the laptop and press the power button located in the
upper right-hand corner of the keyboard area.

When using the OPTIONAL Wireless Remote Control, power on the remote unit by pressing the
power button located on the keyboard area of the laptop.

Step 13: Set Up the Wireless Remote Microphone (If Desired)

To use the Wireless Remote Microphone, unfold the two antennas located behind the wireless
receiver on the PCU, attach the lapel microphone, and verify that the handheld microphone
transmitter base is set to the same channel as the receiver located on the PCU.

3.14



MEl'l Software Basics

Software Basics

The BabySIM system utilizes METI HPS6™ software designed to run on the Apple™
Macintosh™ platform, taking advantage of the Mac operating system’s powerful
simulation-friendly features.

Macintosh Fundamentals

Some users are unfamiliar with Macintosh, but those familiar with PC operating systems should
adapt quickly to the originator of the windows-based user interface.

Starting the Application

When the computer starts, a small Users window appears, displaying two choices,
Administrator and HPS User.

1. Select HPS User. The Login window opens, displaying the Password field.

Mac 05X

. HPS User
024

Password

:'110.‘:

Co‘ﬂ‘ack

The Login Window

2. Enter hps in the Password field.
3. Click the Login button.

The HPS6 application launches, displaying the HPS menu bar and the Patient Palette. (The HPS
menu bar the Patient Palette are discussed below.)

The HPS6 application should launch automatically with the Instructor Workstation.

However, to manually start the HPS6 application, click the HPS6 Launcher located in the Dock.
(The HPS6 Launcher and the Dock are discussed below.)
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Understanding the Desktop

The Macintosh desktop configured for the Instructor Workstation displays all the functionality
needed to operate the HPS6 software. Applications can be accessed either by opening the Mac
OS X window or by using the shortcuts assigned to the Dock.

Opening the Mac 0S X Window

The icon for the Mac OS X system hard drive is located initially in the upper right corner of the

desktop.

Click the icon to open the
Mac OS X window.

Mac OS X Icon

Clicking on this icon opens the window for the hard drive.

Documents

[y Movies
& Music
Fictures

#

— Mac OS X Drive

& Library
System
X Users

To view the applications on the
Macintosh, select Applications
in either the left or right panel.

— — — — — — — 3
4 items, 17.27 GB available

R

Mac 0S X Window

Selecting Applications in either the left or right panel displays the applications available on the

hard drive.

ann Applications -

(o= m] [ 2~ Q,

3 Network Name -

= Mac 0S X Drive / TextEdit

i MFS1 a System Prafarences (l

& Stufflt Standard 8.0.2

7 Desktop Stickies

-1 L& sherlock
Dacuments & safarl

& Movies ! Remote Desktop Connection S

@ Music QuickTime Player 3
Pictures P s

2 40 items, 17.27 GB available i

Available Applications

The applications on the Instructor Workstation include those programs, such as Text Edit, which
contain standard features that may be useful when working with the HPS6 software.
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Using the Dock

The Dock, initially located at the bottom of the desktop, displays shortcut icons to applications,
open files that are currently minimized, and other items like the Finder and Trash Can.

The Waveform Display icon

HPS6 Software

The Trash Can

The Finder

HPS6 Launcher

The Dock

To open or activate a item in the Dock, click the icon for that item.

To add an application to the Dock, locate the application on the hard drive, select the application
and drag it (see Dragging below) to the Dock.

To remove an icon, click on that icon and drag it off the Dock toward the desktop.

The Finder

The Finder is always active and the Finder window can be accessed by clicking anywhere on the
desktop or on the Finder icon in the Dock.

[ & Finder File Edit View Go Window Help ]
The Finder Menu

The Finder menu provides the tools for locating and managing files.
The HPS6 Launcher

The HPS6 application should open automatically when the Instructor Workstation starts. To
manually launch the HPS6 application, click the HPS6 Launcher icon located in the Dock. Once
the software is loaded, the HPS menu bar appears at the top of the window indicating that the
HPS6 application is running.

| 44 HPS Patient Edit Format Window |
The HPS Menu

The HPS menu provides the basic functionality needed for opening and running the Patient
software. Many of the options found on the menu are also located on the Patient Palette and the
Patient window.
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Working with Windows

A window is the main, rectangular area in which application elements are displayed. The elements
in a window vary from application to application. There is almost no limit to the number of
windows that can be open on the desktop at one time, but only one window at a time is active.
The active window appears at the uppermost level of the screen and the controls of the active
window are enabled. The title bar displays the name of the file that the window represents.
- = |

= Window Title Bars

log.cfg

Il
=l

0001-Drug.txt 0001-Physio.txt 1
. Archived Logs (-
28 E+ 28 Q

s 1xT

Window Controls

Events Log 9_12_05

The Active Window

1item, 29.52 GB available A

An Inactive and Active Window
Moving a Window

To move a window, click the window’s title bar and drag the window to the desired location (see
Dragging below).

Using Window Controls

The Window Controls are comprised of three colored buttons located in the upper left corner of
the window.

Click the green (+) Maximize button to enlarge the window.

Click the yellow (-) Minimize button to reduce the window and place it as an icon in the Dock.
To return the window to the desktop in its original size, click on the icon.

Click the red (x) Close button to close the window.

NOTE: Windows can also be closed and minimized by using the Window menu located on the
application’s menu bar.
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Switching between Windows

To make a window active, click anywhere on an inactive window. The new active window moves
to the foreground and title bar or the active window is highlighted. This action does not close any
windows, but all other windows on the desktop remain inactive.

Dragging

To move an object on the screen, position the cursor over the object, press and hold the mouse
button, move the object to the desired location and release the mouse button.

enn | Logs —3
A =Em|| &~ |
Scroll Bar
log.cfg 0001-Drug.txt =
____________________ -
V____ Scroll Arrows
Dragging N — |
?K vailable
S —
Size Box
Events Log 9_13_05
‘ y
Yy
Window Features
Scrolling

Windows that contain additional information that is out-of-view display scroll bars either along
the right side or the bottom of the window. Moving the scroll box inside the scroll bar adjusts the
view of the window’s contents. Clicking a scroll arrow moves the document one line while
holding down the scroll arrow causes continuous scrolling.

Resizing

Windows can be sized to any available dimension on the screen by dragging the Size Box
located on the bottom right corner of the window.
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Patient Start Up

When the HPS6 application is launched, a small window called the Patient Palette appears. The
Patient Palette displays a list of all the currently running patients.

Patients @ localhost

it B
epv i
New pen
D | Tim, Name

Click New or Open icons to create a new
patient file or access an existing one.

Any opened patient files appear in
the window of the Patient Palette.

The Patient Palette

The toolbar icons (New, Open, Show and Stop) represent options that are also available on the
HPS menu bar. The Show and Stop icons are disabled until a patient file is opened.

Opening a Patient File

Once the software is launched, open the preconfigured or any saved user-defined patient by
clicking the Open icon in the upper left corner of the Patient Palette. The Open File window
appears, displaying the available patient files.

[E) [6) Open file...
Patients T‘

.Babv Ryan.hps
Double-click the file name to open the
Patient window for the selected patient.

Selection

Baby Ryan.hps

- - Ready. -E:;l:l-c-:al ’Ek‘

Opening a Patient File

Select the file and click the Open icon or double-click the file name to start the patient and open
the Patient window.

Patient files can also be opened using the menu options or the shortcut keys found on the menu.
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Locating Patient Files

Patient files are generally stored in the Patients directory within the HPSVersion6 folder.
However, if files are saved in other locations, the drop-down menu on the Open File window can
be used to navigate to the appropriate directory.

N L
6 O applications
HPSVersionb

Baby Ryan.hps

Navigating the Open File Menu

Creating a New Patient

To create a new patient, click on the New icon and select the Untitled Baby Patient option.

&) Patients @ localhost ()

lumﬂh

Creating a New Patient

The Patient Palette indicates that the system is preparing the untitled baby patient based on the
underlying patient, Baby Ryan. By starting with Baby Ryan, who displays normal, healthy vital
signs and physiology, new patients each have an established point from which to customize
patient parameters. Once the new patient is prepared, the Patient window opens with the new,
undefined patient. (The Patient window is described in detail on page 4.10.)

For complete details on creating a new patient, please refer to Developing a New Patient found
in the Using the System section of this User Guide.
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Using the Patient Menu

The Patient menu located on the HPS menu bar also contains the options for opening and
creating new patients.

New »
Open... ¥0
Open Recent >
Save 85
Save As... {3858
Stop

Pause {3
Fast Forward  {+3F
Page Setup...

Print... P

The Patient Menu

Several of these options can be used as alternatives to the buttons and icons on the Patient
Palette and the Patient window. Options can be chosen by either selecting them with the cursor
or by using the shortcut keys shown on the right.

Opening a Recent Patient File

As a shortcut, patients files that have been used recently can be opened from the HPS menu bar
by selecting the Open Recent option from the Patient menu.

¢ HPS [l Edit Format Window

New >
Open... %80

Open Recent » Fussy Baby.hps
Baby Ryan.hps

Clear Menu

Opening a Recently Viewed Patient

The last ten patient files that have been opened are displayed in a menu to the right of Open
Recent. Once a patient file is selected, the Patient window opens to display the corresponding
patient.

Utilizing Shortcut Keys

Many options shown on the HPS menu offer shortcut key alternatives that are displayed to the
right of the option’s name. For example, the Save As... option can be performed by
simultaneously selecting the Shift, Command (the key with the & and the cloverleaf icons), and
S keys, represented by the symbols on the right.

Save As... + 35

Save As... Option with Shortcut Keys
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Working with Multiple Patients

Whenever two or more patient files are running, it is possible to switch between patients by
selecting the inactive patient file and clicking the Show icon on the Patient Palette.

Ervy &y & O
Mew Open  Show Stop
o Time MName
1 00:02:00 BabX Ryan
2 00:01:18 Fussy\Baby

L3

To move from one running patient to
another, select the desired patient file.

Click the Show icon.

Switching between Two Patients

Once the new file is selected, the Patient window for that file appears in the foreground of the
desktop. The previously viewed Patient window moves to the back.

Double-clicking the selected patient file also activates the desired Patient window.

Note: Open more than one patient slows computer performance and is not recommended.
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The Patient Window

Once the patient file is prepared and loaded, the Patient window appears with the name of the
patient (e.g. Baby Ryan) as well as the name of the host server (e.g. localhost).

eee Baby Ryan (1)) localhost (=
0O =% 00:01:41 MIEM W
Save Stop Logs Detach Tab Recorder Patient Time Connections
m MAP c.o. Simulatien Scenario Cendidhgn Crugs Fluids Cardiovascular Respiratory
o 16 The patient’s name appears in the title bar.
ABP CVP PAP : H :
a5/53 1717 The number indicates the number of patient
files opened during the active session.
Sp02 Ty Hb Baby Ryan
36.00 | 12.24 Name, Age, and Gender:
Ryan, 6-month-old male
History of Present lliness:
Healthy Infant
Left Vol. LT Right Vol Past Medical History:
. None
76 111 38-week gestation, uncomplicated vaginal delivery; APGAR 9/8.
PAOz || PACO2 zg Enegxitzlri:r;ﬁgf:g?\s Infant went home on day of life 1
103.7 38 37.3 Past Surgical/Anesthetic History:
M
Pa02 pH PaCO2 currenl%‘:dlcallons:
Vitami ith i
95.0 7.46 37.0 Family rlllasr?;?;:w' e
PvO2 PvCO2 Mot contributory
Social History:
32.9 43.9 oo \mzn.?r:\vzations.
Hep B
DTaP
IPY
HiB i
TBody | Weight TBlood ) prgeumococcal up to date £
36.5 8.0 37.0 e

The Patient Window

This window serves as the primary user interface.

Using the Patient Toolbar Icons

The Patient toolbar is located beneath the title bar, displaying several icons used to provide basic

system functionality.

Save Stop

00 =

Logs Detach Tab Recorder

00:01:41 HWEN

Patient Time

-

Connections

The Patient Toolbar

Menu options for these functions can also be found on the HPS menu bar.
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Save

Clicking the Save icon saves the active patient file. Files can also be saved using the Save option
located in the Patient menu or by simultaneously holding down the S and Command (®) keys.

When the Save icon is clicked, the current version of the patient file overwrites (replaces) the
previous version. Preconfigured patients such as Baby Ryan cannot be overwritten, so selecting
Save in this case prompts a warning requiring the patient to be saved to the user directory as a
new patient file.

When saving a new patient file, the Save file as... window appears, providing the means of
naming the patient file and navigating to a location in the directory where the file can be stored.

Stop

Clicking the Stop icon prompts a warning to save the patient file.

Warning!
ﬂgﬂl g
Any changes that have been made to this patient will
be lost. Would you like to save the patient before
closing it?

Don't Save Cancel {—Save—)

The Patient Toolbar

Clicking the Save button on the Warning box functions in the same way as choosing the Save
icon (see Save above) while clicking Cancel returns the user to the Patient window without
saving the file. Clicking Don’t Save closes the active Patient window without recording any
unsaved changes to the patient file.

The patient file can also be stopped by clicking the Stop icon on the Patient Palette.
Logs

Clicking the Logs icon opens the Logs Drawer at the bottom of the Patient window.

Social History:
Immunizations:
TBody Weight TBhod Hep B
36.5 8.0 37.0 o8

Pat_Time Event
Event Log 00:09:00 Patient Loaded: Baby Ryan

w2 |
Physiologic Data Log £
Drug Log ‘

The Logs Drawer

The buttons on the Logs Drawer provide access to the Event Log, Physiologic Data Log and
Drug Log. The menu option for showing the Logs Drawer is found under the Window menu in
the HPS menu bar. When the Logs Drawer opens, the Event Log appears by default.
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The Logs Drawer displays three buttons:

Event Log (default) - chronological list of parameter adjustments, fluid interventions and
administered drugs

Physiologic Data Log - record of patient’s heart rate, blood pressure, arterial blood gas
values, temperatures and other numerous phsiological values.

Drug Log - chronological list of all drugs administered to the patient, either as a bolus or via
an infusion

Each time the patient is started, the system automatically captures the information that is stored
in these three logs. The files that represent this data are saved in the Logs folder located inside
the HPSVersion6 folder on the hard drive.

Clicking the Log Viewer button on the Logs Drawer creates a separate window for the selected

log.
Click the Log Viewer button.
Event Log P;E’;‘cmc-tﬂ E:E;I Loaded: Baby Ryan
Physiclegic Data Log %7
Drug Log \4
Opening a Log Viewer
The Event Log

The Event Log displays a chronological list of events that are time-stamped based on the
simulated running time of the patient in hours, minutes and seconds.

888 Log Viewer - Baby Ryan (1) @ localhost

| Pat_Time Event
00.00:00 Patient Loaded. Baby Ryan
00:01:52 User: Eye Blinking set to Automatic
00.02:00 User. Eye Blink Rate set 1o Fast
00:02:21 User: Heart Sounds set to S3 and 54
00.02:40 Scenario Loaded: ‘Infant Shock’
0D.02:41 Scenario: ‘Infant Shock” entered state: "Baseline’

A chronological listing of events appears
in the window of the Event Log.

Physiologic Data Log Drug Log
The Event Log

Parameter modifications and user interventions such as defibrillation or pacing are listed in the
Event Log, which also document if the intervention was initiated by the user or resulted from a
change specified in a running scenario.

The Event Log does not record events such as the application of a facemask to the patient,
changes in ventilator settings or the auscultation of heart or breath sounds. Patient assessment
or similar user interventions must be recorded independently.
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The Physiologic Data Log

The Physiologic Data Log lists more than 20 different physiological parameters and is updated
every five seconds and recorded based on the simulated time of the patient in hours, minutes and
seconds.

The order in which the physiological data appears can be rearranged in both the Logs Drawer and
the Log Viewer. To rearrange, click on the column header and drag the column to the desired

location.
8ene Log Viewer - Baby Ryan (1) @ localhost
Pat_Time HR SBP DEP CVPW DPAP PCWP co VT
00.06:52 152 103 73 [ 1% 1z 7 1.7 &0
00:06:57 152 103 73 21 a9 5 1.7 &0
00:07:02 152 100 7l B 20 7 1 1.7 7
000707 152 103 7l 5 19 12 8 1.7 79
Qoor:12 151 99 71 5 21 11 9 1.7 79
Q00717 151 100 71 [ 18 a 3 1.7 74
Q0:07:22 151 100 69 5 16 L3 5 1.7 74
Q0:07:27 150 99 71 5 20 1z ] 1.7 74
Q0:07:32 143 98 70 21 11 .
oworas e s 7 20 | Columns can be reordered by dragging
Q0.07:41 148 k13 (33 5 16 &
moras 17w« 20 1| them to a different location.
Q00751 147 G5 (i1 20 11
00:07:56 146 95 (59 P 16 5 3 1.7 7 U
00:08:01 146 96 (519 5 18 7 6 1.7 79 1
00:08:06 145 96 (519 5 19 5 8 1.7 7 v
Event Log Physiologic Data Log Drug Log

Moving Data in the Physiologic Data Log

Because a large amount of data is recorded in the Physiologic Data Log, the horizontal and
vertical scroll bars can be used to locate needed information.
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The Drug Log
The Drug Log records all drugs administered to the patient, either as a bolus or via an infusion.

Bolus dose logs display when the drug was given, the drug’s name, the dose amount
administered and the origin of the dosage (i.e. User or Scenario).

Drug infusion logs record when the infusion was started (or discontinued), the drug’s name and
the rate of infusion, either as dose per unit time or as the dose per kilogram per unit time
(normalized infusion). An infusion is considered to be “running” at the set rate until the infusion is
altered, turned off or the patient is stopped.

Each entry is recorded based on the simulated time of the patient in hours, minutes and
seconds.

enn Log Viewer - Fussy Baby (2) @ localhost

Par_Time Drug
00:49:59 User: epinephrine bolus administered: 80.0 mcg

00:55:32 User: epinephrine bolus administered: 80.0 mecg

Event Log Physiologic Data Log
Bolus Data in the Drug Log

Bolus doses in the Drug Log are recorded as individual entries and are not the cumulative dose
given to the patient. In the example shown above, a single epinephrine dose of 80 mcg followed
by a second epinephrine dose of 80 mcg appears as two separate entries of 80 mcg and 80 mcg,
not as one entry of 80 mcg followed by a total of 160 mcg.
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The Logs Folder

The Logs folder holds the data files from each of the logs for every patient session. Located in
the HPSVersion6 folder, the Logs folder is accessed by navigating the Mac OS X drive (e.g.

Applications/HPS6/Logs).

e .. o Woes o
— = i (I | S ———————
& w=m B § @ A
Back Forward View ! Computer Home Favorites Applications Search

85 items, 31,6 GB available

.'!" 'l__' Extras b _ log.cfg
|| ¥ HPsE = 0001-Drug.txt
| | F% HPS6 Launcher | 0001-Events.txt
w10 [ Logs » 2 0001-Physio.txt
S Model h b L 0002-Drug.txt
|| Patients £ 0002-Events.txt
[ Plug-ins 1 0002-Physio.txt
| [ ScenarioProcessor = 0003-Drug.txt
| [ Scenarios o 0003-Events.txt
| [ ilities » 2 0003-Physio.txt
i | B Waveform Display 2 0004-Drug.txt
i = 0004-Events.txt
= 0004-Physio.txt

P

L—

The Logs Folder

The three log files created for each session correspond to the Drug, Event and Physiologic Data
logs for that session. A number is created sequentially as a prefix to each file (in groups of three)

with the largest number representing the most recent session.
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Detach Tab

When the Detach Tab icon is clicked, a separate window appears displaying the active tab.

METI
Baby Ry
@ = &y Baby Ryan
Save Stop Logs Detach Tab Recorder
1 Name, Age, and Gender:
Simulation  Scenal Ryan, 6-month-old male
e S co ——— History of Present lliness:
129 67 1.6 Healthy Infant
e T e " Past Medical History:
5 175 30-week gestation, uncomplicated vaginal delivery: APGAR 8/2
y Na perinatal complications. Infant went hame on day of life 1
[ Na known drug allergies.
Past Surgical/Anesthetic History:
E N Current Medications:
98 1251 Vitamin with iron
,  Family History:
Name;gﬁ g_":;ﬁ Nat contributary
History of Presentl]  Sovial History:
Laft Vol. SN Right Vol. Leallhy Infant Immunizations
115 79 111 Past Medical Histor heps .
Pa02  [EEUGLN PACCR hone PV -
39-week gest
107.1 40 40.0 No perinatal &
) oH ) No knawn drug Zilergies a
Past Surgical/Anesthetic History:
99.1 7.44 39.5 None
| | VTN | o.ooo | Current

A Detached Simulation Tab

If a tab such as the Conditions tab has multiple menu options (e.g. Trauma and Assessment),
then the active option is displayed in the new window. Multiple tabs can be detached and used
to isolate specific controls. (For more information on tabs, see the Tabs section of this User
Guide.)

The menu option for detaching tabs is found under the Window menu in the HPS menu bar.
Recorder

Clicking the Recorder icon opens the Event Recorder, a separate window that initially displays
a list of the patients opened during the current session.

800 Event Recorder e
Stopped o]
Record Clear events

localhost

P Fussy Baby (closed)

Event Recorder

To record events, select the patient and click the Record button. Each event created using the
parameters available under the various tabs is recorded and listed in the Event Recorder window.
To stop the recording process, click the Stop button. To clear an event, select the event and click
on the Clear events button. The menu option for displaying the Event Recorder is located under

the Window menu in the HPS menu bar. For more information, see Using the Event Recorder
on page 6.36.
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Patient Time

The Patient Time display keeps track of the simulation time. By default, the digital readout
records and presents real time.

Pause
—

Simulation Time ———77 00:16:33 ‘ !

Patient Time

1 Play

Fast Forward

Patient Time

Three buttons appear to the right of the readout showing icons for the Pause, Play and Fast
Forward functions. The active button has a red icon.

Pause - “freezes” the simulation in its current state. Any ongoing parameter changes, drug
effects or scenario events remain suspended until either the Play or Fast Forward buttons
are clicked. While time is paused, all parameters cycle through a continuous loop of
approximately 10 seconds. Changes made during the use of Pause are not saved or put into
effect.

Play - runs the physiological models in real time. Parameter changes, drug effects and
scenario events play out at their normal, model-driven rate.

Fast Forward - runs the physiological models at approximately four times normal speed.
Parameter changes, drug effects and scenario events continue at an accelerated pace until
either the Pause or Play buttons is clicked. Spontaneously breathing patients breathe at an
accelerated rate.
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Connection Icons

The two connection icons, Disconnect and Connections, appear on the right side of the Patient
toolbar. Clicking the Connections icon opens the Connect to Simulator drawer.

o) Connect to Simulator

o E“'i‘i Simulators
BabySIM 58
scular Diratary

Erl = Available simulators

Connections icons

Simulator IP address

Host
10.127.127.126:28997

Connection Icons and
Connect to Simulator Drawer

A list of available simulators appears in the Connect to Simulator drawer.

Select the appropriate simulator and click Connect
or

Double-click on the appropriate simulator.

Even if only one simulator is present (which is often the case), the connection process must be
followed.

When the software and simulator are successfully connected, the connection drawer closes and
the Disconnect icon is enabled.

To close the drawer without connecting to the simulator, click on the Connections icon. To
disconnect the software from a patient mannequin, click on the Disconnect icon.

To switch the simulator from one active patient to another:

1. Select the simulator in the Connect to Simulator drawer and click the Disconnect button
at the bottom of the drawer.

2. Select the desired patient file in the Patient Palette and click the Show icon.

3. Select the simulator in the Connect to Simulator drawer and click the Connect button at
the bottom of the drawer.
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Viewing the Heads Up Display (HUD)

The Patient Window

The Heads Up Display (HUD), located on the left side of the Patient window, displays
twenty-three selected patient parameters that register the patient’s physiological condition.

HR c.0.
129 - 1.6
ABP CVP PAF
S w

Sp02 Het Hat
98 36.00 12.24
Left Vol [ESRSURAEN Right Vol.
1 79 111

SpontAR

eH
7.45

TBady
36.5

37.0

The Heads Up Display (HUD)

When adjustments are made to the parameters in the software, the underlying models determine
all the appropriate physiological changes, and the effects of the adjustments appear on the HUD.
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HUD Parameters

Parameter Units Notes
HR bpm (beats/min)
MAP mmHg

(o0) Ipm (liters/min)
ABP mmHg

CVP mmHg

PAP mmHg

SpO0y %

Determined dynamically based on blood and fluid
o losses and intravenous infusion of colloid, crystalloid,
Het %o packed red blood cells and whole blood, hence helping
determine the O, transport in the blood.

Hgb g/di

Measured volume inside the mannequin, ideally, the

Left Vol. mi alveolar volume.

Not a measured volume, but a desired tidal volume
generated by the models. Tidal volumes measured at
Spont. VT ml the patient circuit (mechanical ventilation) generally do
not match the value displayed in the HUD and often
report a value less than the desired tidal volume.

Measured volume inside the mannequin, ideally, the

Right Vol. mi alveolar volume.

The partial pressures of respiratory gases (CO2 and O)

PA02 mmHg in the patient’s alveoli. A software model of the lungs
controls these values.

Determined by the underlying physiological models. For
a spontaneously breathing patient, this value should
Spont. RR bpm (breaths/min) | match the observed respiratory rate of the mannequin.
For a mechanically ventilated patient, Spont. RR does
not match the value displayed on the ventilator.

The partial pressures of respiratory gases (CO5 and Oy)

PACO, mmHg in the patient’s alveoli. A software model of the lungs
controls these values.

P302 mmHg

. Respiratory acidosis or alkalosis simulated in real time
pH (unitless) depending on the alveolar concentration of O,.

PaCO, mmHg

PV02 mmHg
PvCO5 mmHg

c Not tied to the underlying physiological models.
Fahrenheit unavailable.

TBody

Sets the patient’s weight used by the pharmacological
Weight kg models. The patient’s body mass index and body
structure cannot be altered or defined.

Linked to the oxyhemoglobin dissociation curve. Thus,
hyperthermia causes a rightward shift, while
c hypothermia causes a leftward shift to the standard

oxyhemoglobin dissociation curve. Beyond this, not tied
to the underlying physiological models. Fahrenheit
unavailable.

TBlood
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Working with Tabs

Beneath the toolbar on the right side of the Patient window is a series of tabs that provide access
to the physiological controls used during a simulator exercise.

|'r Simulation Scenario Condition Crugs Fluids Cardiovascular Respiratory |

The Seven Tabs

The tabs display seven different categories offering varying functionality:
Simulation (default) - view patient information and medical history
Scenario - run and create patient scenarios
Condition - set parameters for assessment and trauma conditions
Drugs - administer drugs
Fluids - affect plasma and blood volumes
Cardiovascular - set a wide array of parameters affecting cardiovascular physiology
Respiratory - control airway, lung and respiratory control parameters

Clicking on a tab displays the functionality available for selecting and setting parameters within
the identified category. Several categories are further divided into sub-categories found on a
pull-down menu.

Each of the tabbed categories, sub-categories and patient parameters are discussed
individually in the Tabs section of this User Guide.
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Numeric and Discrete Parameters

On the Condition, Cardiovascular and Respiratory tabs, parameter settings provide a large
number of alternatives creating a wide range of physiological responses.

There are two types of settings for parameters:

Numeric - set either a measured value (e.g. 20 ml) or a multiplied value (e.g. Heart Rate Factor
2.0 is two times the baseline Hear Rate)

Discrete - select one of two or multiple options

Once a parameter is selected and set, the patient’s physiology changes according to the model

for that parameter.

Parameters with numeric settings are generally changed by clicking in the relevant field and
entering a new value in place of the existing one. A slider is available that moves through the
range of parameter values until established at the desired numeric value.

Parameters with discrete settings are changed by clicking on the appropriate radio button.

Parameter Settings

Once a parameter is selected, the panel to the right displays the available settings.

/)

and a parameter.

Select a tab, a sub-category,

lSin1uI.1to-1 Scenario Cendition Drugs Fluids Cardiovascular Respiratory ]
Show S ing = Click the radio button to
/ choose a discrete value.
Parameters IntrapleuralXolu
Breath Sounds %) BotH ™ Left ~ Right
Chest Wall Compliance Factor - - =
Fraction of Inspired 02 Owerride Value Oﬂ\sef
Functional Residual Capacity 0 : RIS h i
e el Vel e | (O seconds Enter or use the slider to
Lung Compliance Factor 100 set numeric values.
20 30
ml l'/ minutes
- 2 (" Set )
e e e e e~ e i~ e k
Description Click Set.
Intrapleural Volume (Left)
Intrapleural Volume {Right) L
Value: 0to 100 ml Default 0 ml
Onset: 0 teo 60 seconds s
0 to 60 minutes Default 0 minutes b

Setting Values for Parameters

Click the radio buttons for the desired discrete values and enter or use the slider to establish the
numeric values. Then, click the Set button.

4.22



MEl'l Software Basics

The new parameter values immediately begin to affect the patient’s physiology. Depending on the
parameter and its settings, changes can be dramatically instantaneous or can take place more
slowly over time.

Heart Rate Factor

Value Onset
R E Minutes
o _ Seconds Changes to values can take
3.00 50 place gradually (Onse}

/ over an established time.
150 —T | 5|

T minutes
|
|
|
|
|

0.30 —0 Set

Values Increasing Over 5 Minutes

In the example above, the Heart Rate Factor is set to increase 1.5 times over 5 minutes.
Gradually, the effects of this change will appear on the HUD as the heart rate increases. If the
Onset time had been set to 0 (the default), the change would have taken place immediately.

In some instances, the parameter setting produces a model-driven response.

Six parameters have this capability:
Fixed Neuromuscular Blockade (located under Assessment on the Condition tab)
Fixed Heart Rate (located under Heart on the Cardiovascular tab)
Fraction of Inspired O Override (located under Lung on the Respiratory tab)

Fixed Neuromuscular Blockade (located under Respiratory Control on the Respiratory
tab)

Respiratory Rate Override (located under Respiratory Control on the Respiratory tab)
Tidal Volume Override (located under Respiratory Control on the Respiratory tab)

These parameters all have a default setting of -1 that signals the software to perform
physiological changes based on the models without instructor intervention.
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In the example below, setting the Fixed Heart Rate to -1 means the heart rate automatically rises
when the selected patient becomes hypovolemic. The loss of volume is factored into the
mathematical models and results in a compensatory rise in the simulator’s heart rate.

Fixed Heart Rate

Value Onset
"'E‘ Minutes

. " Seconds
beats / min e

275 6O

The -1 parameter setting

allows the models to drive —® 0

the patient’s responses.

beats / min minutes

I:}. 1 I}g [ Set

A Model-Driven Parameter

Setting the value to any other number (e.g. 60 beats/min) fixes the parameter at that number
regardless of the underlying patient physiology or user intervention.
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Saving Data

Patient information can be saved locally on the hard drive or transferred to external storage via
a CD or a USB memory device. Files are created in a simple text (TXT) format. Consequently,
transferred files can be printed on any computer (PC or Mac) that has printing capability.

Backing up files is especially important when custom patients and scenarios have been created.
Whenever important files exist, it is recommended that the files be stored on a second source
and a hard copy of the records be generated.

Saving Patient Files

Before the Patient window is closed, the patient file can be saved using either the Save icon on
the Patient window or the Save or Save As options located on the Patient menu. Clicking the
Stop icon on the Patient window also prompts a warning that provides an option to save.

If the file is being saved for the first time, the Save file as... window appears.

[ZXa):) Save file as...
Shared T’
Baby Ryan.hps
Fussy Baby.hps Locate the proper folder.
Enter the new name.
setechQn: Click Save.
High Fever Baby
- Ready. Cancel Save

Saving a New Patient File
Enter the new name in the Selection field and click Save.

Patient files should be stored at a preset location in the Users/Shared folder. The navigational
pull-down menu at the top of the window provides the means for locating the appropriate folder.
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Saving to a CD

To save to a CD-ROM:

1. Insert a blank CD in the CD drive at the front of the Instructor Workstation. A dialog box
appears with a field highlighted by default for labeling the CD.

You inserted a blank CD. Choose what to do
from the pop-up menu

coDRr =
Action: & Open Finder |
Name untitled CD
= MakeAs zctiopheldetzult You inserted a blank CD. Choose what to do
= from the pop-up menu
Enter a name for the CD ianore
CDR —
: . Action & Open Finder )
into the Name field. =
Name:  BabySIM L0qs|

Click OK.

__ Make this action the default

Eject Ignore ok )

Naming the CD

2. Enter the new name in the Name field (overwriting the default name).

3. Click OK.

4. Locate the folder with the information you wish to save (e.g. log files, custom patients,
custom scenarios).

5. Select and drag the appropriate files from the drive to the CD.

| @ BabySIM Logs -
. = m Q-
Locate the files on the EED | L8
% Network .
hard drive. 3 Mac 05 x Drive Select and drag the files to
e e rrrm—| the CD icon or CD folder.
8n0n Logs -
| J e m| | 4| Q-
3 Network N
! Mac 05 X Drive .
¥ MFS1 = .
_ BabySIM Logs 43 0001-Events.txt |
A% Desktop R 7
A Applications .
Documents =
s Movies l0g.cfg
& Music ' 0001-Physio.txt
Pictures
1 of 4 selected, 20.27 GB available 4

Dragging Files to a CD
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6. Double-click on the CD icon to open the window for the CD and confirm the files have

been copied.

9% Network
| Mac O3 X Drive
! MFS1

A7 Desktop

A Applications
Documents

fiss Movies

J; Music

. Pictures

- BabySIM Logs

MName
0001-Drug.txt
000 1-Events.txt
0001-Physio.txt

Open the CD to view its contents.

3 items, 660.6 ME available

B

CD Contents

®

@rn Disc

7. Drag the CD file to the Trash icon on the Dock. When the CD file is over the —
Trash, the icon changes to a Burn CD icon.

A dialog box appears with the options to Burn, Cancel or Eject.

Do you want to burn the disk “BabySIM Logs™

You can use the disc on any Macintosh computer or PC

Burn Speed: Maximum

Lject

rul

(- Cancel—)

A
-

Burning a CD

Generally,

select the

Maximum Burn Speed.

Burn

Burn CD Dialog Box

CDs can also be burned by selecting the File menu from the Finder and then selecting the

Burn Disc option.

Click the Burn button on the dialog box. Once burning is complete, the CD reappears on the

desktop.

To remove the CD from the CD-ROM drive, drag the CD file to the Trash icon
in the Dock. The icon changes to an Eject icon, and the CD is ejected.

CDs can also be ejected by selecting the CD file and choosing the Eject

option from the Finder’s File menu or by pressing the F12 key.

Ejecting a CD
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Saving to a USB Memory Device
To save to a USB memory device:

1. Insert the USB memory device into an available USB port on the back of the Instructor
Workstation. An icon appears on the desktop indicating that the memory device has been
recognized.

USB Memory Device Icon

2. Locate the appropriate folder on the hard drive under HPSVersion6 containing the file(s) to
be saved.

3. Drag the file(s) from the folder on the hard drive to the memory device icon on the desk-
top. The files are copied automatically onto the device.

4. Drag the icon to the Trash to disconnect the memory device.
5. Remove the memory device from the USB port.
Printing Files

Printing may not be performed from the Instructor Workstation. Instead, transfer the needed files
to a CD or USB memory device and insert the CD or memory device into a computer with print-
ing capabilities.

HPS files are saved in a text (TXT) format, so either a PC or Macintosh system can be used to
print the files.

Saving as a Text file removes most formatting. To print in the most readable format, open the
file and reformat the document. The contents of the text document can also be selected,
copied, and pasted into word processing software for further modification.
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Tabs

Patient physiology and background is created and controlled through the HPS6 software using
the patient parameter settings in tabbed sections that organize all of the various parameters by
system and functionality.

The Simulation Tab

The Simulation tab appears when the patient file is opened. This tab provides basic information
about the patient such as the patient’s name, history and photograph.

" Simulatien Scenario Ceondition Crugs Fluids Cardiovascular Respiratory

MHIM

Get basic information on
the patient.

Baby Ryan

Name, Age, and Gender:
Ryan, B-manth-old male
History of Present lliness:
Healthy Infant
Past Medical History:
Nane
39-week gestation, uncomplicated vaginal delivery; APGAR 9/9.
Ma perinatal camplications. Infant went hame an day of life 1
Ma known drug allergies.
Past Surgical/Anesthetic History:
Nane
Current Medications: . .
Vitamins with iron Read the patient’s history.
Family History:
Mat cantributory
Social History:
Immunizations: .
Hep B

mTaD

The Simulation Tab

Information on user-created patients must be provided by the instructor or administrator. For
details on Developing a New Patient see pages 6.2 and 6.3 of this User Guide.
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The Scenario Tab

Selecting the Scenario tab opens a window providing the tools needed to create or play patient
scenarios that duplicate clinical situations by automatically simulating patient responses to a
series of events.

Simulation | Scenario | Condition  Drugs  Fluids  Cardiovascular  Respiratory
L3

Show: Player =

) \ Choose the Player or Editor option.

Scenario 'w

Play scenarios selected from
the Scenario pull-down menu.

Current State State time

00:00:00 Next

The Scenario Tab

By default, Player is selected in the Show pull-down menu and the Scenario Player is displayed
on the Scenario tab.

Initially, four preconfigured scenarios are available in the Scenario Player for the infant patient:
Increased ICP
Infant Shock
RSV Bronchiolitis

Sedation Induced Apnea

These scenarios can be played by selecting them from the Scenario pull-down menu. Additional
scenarios can be created or scenarios can be modified using the Scenario Editor displayed by
selecting the Editor option from the Show pull-down menu.

The Editor option is discussed later in this section on page 5.9.
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Playing Scenarios

Any patient may be selected for any available scenario; however, patients with preestablished
conditions may not work well with scenarios anticipating a patient with a different physiological
status. For example, selecting a patient with profound neuromuscular blockade for a scenario
expecting a spontaneously breathing patient will not yield the results expected by the scenario

author.

To play a scenario:

1. Open the scenario using the Scenario pull-down menu on the Scenario tab.

2. Navigate between the states of the scenario by using the buttons at the bottom of the

Scenario tab.

3. Add interventions (learner, instructor, or automatic) when desired.

Patients respond realistically to all scenario events and interventions.

Opening a Scenario

To open a scenario, select either Open or Open Recent from the Scenario pull-down menu.

Simulation

Show: Player

Scenario

Cendition Drugs Fluids Cardiovascular

. )

Scenario | ¥

Open Recent

L3

Respiratory

il |

Select Open from the Scenario pull-down menu.

Opening a Scenario

Selecting Open activates the Open file window, displaying the available scenario files.

S

Select the desired file from the
available Baby Scenarios.

Open file...

Baby Scenarios

Infant Shock.hsé

RSV Bronchiolitis.hsé
Sedation Induced Apnea.hsé

Se

lecting a file enters the file

name in Selection field.

Click

Selection:

the Open button once the

desired scenario has been selected.

Increased ICP.hsé

/]

1 Ready. Cancel { Open

4

Selecting a Scenario File
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In the the Open file window:

1. Locate the folder that contains the scenarios using the navigational pull-down at the top
of the window. (The preconfigured scenarios are located in the Baby Scenarios folder
shown in the example above.)

2. Select the desired scenario file.
3. Click Open (or double-click on the scenario file).
The chosen scenario appears in the Scenario panel.

When you select Open Recent from the Scenario pull-down menu, the most recently used (with
a limit of ten) scenarios appear as options.

Scenario |w) s
Open... 4H%0 =
j Increased ICP.hs6
RSV Bronchiolitis.hsé

L3

Select the desired scenario
from the Open Recent list.

Clear Menu

Opening a Recently Used Scenario
Select the desired scenario from the list.
The chosen scenario appears in the Scenario panel.

Multiple scenarios can be opened at one time. Additionally, it is possible to run multiple patients
with multiple scenarios, but doing so may result in a drop in the computer’s performance.
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Understanding the Scenario Script

When a scenario appears, the states that comprise the scenario appear in the Scenario panel.

Simulation Scenario Cendition

Crugs

Fluids

Cardiovascular  Respiratory

Show: Player

Scenario v | Infant Shock.hsé

= 0
v | |

Baseline

Shock

Warsening Shock
Cardiopulmanary Failure
Improved

The states that comprise the scenario
appear in the Scenario panel.

N

The name of the active scenario
appears in the Opened Scenarios box.

The name of the active state
appears in the Current State box.

Current State

Baseline

State time:

00:00:36 Next

An Opened Scenario

The simulation begins in the first listed state. In the example above, this state has been labeled

Baseline. Selecting a state reveals the Events and Transitions headings for that state.

Warsening Shock
Cardiopulmanary Failure

Simulation Scenario Cenditicn Drugs Fluids Cardiovascular Respiratory
Show:  Player o
Scenario 'w! | Infant Shock.hs6 H i | b
¥
Events &
Transitions
Shack

Selecting a state reveals the

Impraved
Events and Transitions headings.
C ] s
Current State State time:
Baseline 00:57:54 ~ Next

Selecting a State

Each state contains both headings, but not all states have events and/or transitions.
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Select a state’s Events or Transitions heading to see the events or transitions for that particular

state.
Simulaticn Scenario Cendition Drugs Fluids Cardiovascular Respiratory
Show: Player T‘
Scenarioc | w| Infant Shock.hs6 T‘ i s
Baseline
Shack Selecting the Events and

Worsening Shack

v Transitions headings reveals the
E
vents , ;.
set Raspiratory Rate Factor to 0.2 over 15 seconds state’s events and transitions.
set Heart Rate Factor to 0.6 over 15 seconds
set Eyes: Blink Control to Eyes Closed
Transitions
if Systolic Blood Pressure = 65 mmHg then go to Improved
Improved
€ 3 4 »
Current State State time: Goto
Baseline 00:59:13 ~ Next

Expanding Events and Transitions

States may contain any number of events and/or transitions.

Events set specific parameters that take place when a state is active. Certain events are set

to take place over a period of time.

Transitions offer conditional parameters that take place only when (and if) conditions are met.

As an example, the event “set Temperature: Arterial blood to 37 degrees Celsius” automatically
changes the patient’s blood temperature to 37.0 degrees Celsius, which is reflected in the
readouts on both the HUD and on the monitor. On the other hand, the transition “If Time in State
is > 30 seconds then go to Worsening Shock” occurs only if the selected state remains active
beyond 30 seconds. At this point, the scenario would automatically go to the state labeled

Worsening Shock.

To view all the events and transitions for a scenario, click the Expand All button.

Crugs

Fluids

Cardiovascular

Resy

Click the Expand All button to
reveal all events and transitions.

Shock.hsé

Il

Click the Collapse All button to
show only the states.

| | D]

Expand All and Collapse All Buttons

Click the Collapse All button to return to a view showing only the scenario’s states.
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Navigating between States

Generally, scenarios are designed with states that occur beginning at the top and ending at the
bottom. The preconfigured scenarios included with BabySIM are designed in this fashion.
However, scenarios can be created that intentionally skip or repeat states, often depending on
the nature of the intervention. Since scenarios are usually developed with a specific order in
mind, reversing or altering that order may cause unrealistic results.

To move from the active state to the state that follows, click the Next button.

Simulation Scenario Condition Drugs Fluids Cardiovascular Respiratory
Show: Player T‘
Scenario | v | Infant Shock.hs6 T‘ i [
Baseline Click the Next button to move to the
v
Events next state (downward) on the list.

set Venous Capacity Factor to 1.1 over 15 seconds

set Fluid Loss Volume (Blood) to 150 ml over 15 seconds L

set Shunt Fraction to 0.13 over 30 seconds

8 el Cinift 8 N7 e -30 SECOndS

Time for each state begins as soon petorte 1.2 over 15 seconds
Right Ventricle to 0.5 over 15 seconds
as that state becomes active and is

. . Stsemic Vasculature to 0.9 over 15 seconds a
recorded in the State time box. o 1.4 ver 15 secands
Current State State time:
Shock 00:01:09 l‘\lem_k

Moving from One State to the Next State
The name of the new active state appears in the Current State box and the time that state has

been active is shown in the State time box.

In the example above, clicking Next while the Baseline state is active makes the Shock state,
the next state in sequence, the active state.

To move from the active state to any other state (no matter the sequence), select the desired state
and click the Go to button.

Click the Go to button to make

i / the selected state active.
Select the desired state. / State time: Go to (
Shock 00:00:35 Next

Changing States with the Go to Button

The selected state becomes active and its name appears in the Current State box.
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Closing Scenarios

Scenarios run until closed. To close a scenario, select the Close option from the Scenario menu.

Scenario |w] | Infant Shock.hs6 [ | hoill 8 |
Open... 480 Select the Close option from the Scenario

—Opm = b=/ menu to close the active scenario.
| Flaes . s oapiAl )
| LI05€E L gt WV |

Closing a Scenario
Even though a scenario has closed, the physiological changes made to the patient during the
scenario remain.

Working with Multiple Scenarios

The patient’s condition may be affected by events from any active scenario; therefore, running
multiple scenarios enables the instructor to alter patient physiology using the states defined in
more than one scenario.

Switching Scenarios

To switch between multiple open scenarios, select the desired scenario from the pull-down list to
the right of the Scenario box.

With multiple scenarios open,
choose the desired scenario
from the pull-down list.

Scenario

Switching between Open Scenarios

The selected scenario becomes available for manual adjustments, but the physiological changes
dictated by both scenarios continue to take place.

It is also possible to simultaneously run multiple patients with scenarios, but this is not
recommended because computer performance is often hampered when two or more patients
and the Waveform Monitor Display are operating.

Repeating Scenarios

The physiological changes made to the patient remain unless returned to their baseline numbers
by further events and transitions in the scenario. In other words, the condition of the patient
retains the effects of the scenario events unless specifically reset.

To be sure that a scenario is identically repeated, close the original scenario and stop the patient.
Then, reopen the same patient and open the same scenario.
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Editing Scenarios

In addition to the four preconfigured scenarios, new or revised scenarios can be created and
saved using the Scenario Editor.

To create or edit a scenario:

1. Select the Editor option from the Show menu at the top of the Scenario tab.

Simulation Scenario Ceondition Crugs Fluids Cardiovascular Respiratory

Show v Player )

Scenario | ¥ | i b

Selecting the Scenario Editor

2. Select the New, Open or Open Recent option from the Scenario menu to choose
whether to create a new scenario or to open and edit an existing one.

3. Add states, events and transitions as desired by selecting the New State, New Event and
New Transition options from the Scenario menu.

4. Save the new or modified scenario using the Save or Save As options from the Scenario
menu. Naming the file using the Save file as navigational window during the Save
function also names the scenario.

Once a scenario has been saved to a folder on the hard drive, that scenario is available for all
patients.

A more detailed explanation of the method of editing and creating scenarios is contained in the
pages that follow.
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Modifying Existing Scenarios

Either to permanently change or to create a new version of an existing scenario, in the Scenario

Editor:
Open an existing scenario by selecting the Open or Open Recent option from the Scenario

menu.
Tt
Scenario |") .:. EHSI

Open Rec&n 3

Close

New State “CEEiN
New Event [
Mew Transition — NCC-361

Opening an Existing Scenario
When Open is selected, the Open file window appears, providing the navigational tools to
locate, select and open the appropriate scenario file.

808 Open file...

Baby Scenarios

Increased ICP.hse

Infant Shock.hs6

RSV Bronchiolitis.hsé
Sedation Induced Apnea.hsé

Selection
Infant Shock.hs6

- Ready  Cancel ) f Gpenka

Opening the Scenario File
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Selecting the Open Recent option displays the most recently used (with a limit of ten)
scenarios as options.

Scenario | v s
Mew {+ 3N
Open... {+3#0
L3

RSV Bronchiolitis.hs6é
Increased ICP.hs6

Clear Menu

New Event >

Opening a Recently Used Scenario

The scenario file opens in the Scenario Editor. When the opened scenario appears, options
become active for adding, editing and saving states, events and transitions on the Scenario

menu.
Simulation Scenario Conditicn Drugs Fluids Cardiovascular Respiratory
Show: | Editor s) | The name of the scenario file appears
e / to right of the Scenario menu.
Scenario ‘;1 Infant Shock.hsb
New {r#EN
| open... o0 |
Open Recent >
Close o RwW The Scenario menu contains the
Save {8V . . . .
Save as... - options for adding, editing and saving
New State NN states, events and transitions.
New Event >
New Transition  “C{r38| o ‘

The Editor’s Scenario Menu

See below for details on adding or editing new states (page 5.13), new events (page 5.16) or
new transitions (page 5.28).
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Developing New Scenarios

To create a new scenario in the Scenario Editor, select New from the Scenario menu.

Scenario | v v )
Open... 30 X
Open Recent >
New Event »

Opening a New Scenario

The new scenario initially displays only an Untitled name and a blank Scenario panel.

Simulatien Scenario Cendition Drugs Fluids Cardiovascular Respiratory

Show: | Ed 5| i i
OV ZNE For For new scenarios, an Untitled

| Untitled1 x + | name appears that is changed
when the scenario is saved.

Scenario |

The Scenario panel for a new
scenario is blank until new states,
events and transitions are added.

No Selection

The New Scenario’s Initial Panel
Once the Untitled scenario appears, options are available on the Scenario menu for adding
states, events and transitions as well as for saving the new scenario.

See below for details on adding or editing new states (page 5.13), new events (page 5.16) or new
transitions (page 5.28) or for saving the scenario (page 5.34).

5.12



METT Tabs

Adding, Editing and Deleting States

Scenarios are organized by the states that are simulated with the patient as diagnoses and
interventions take place. As organizing structures, states by themselves do not cause changes
to the patient’s physiology. Those occur based on the events and transitions defined for the state.

States are added in a set sequence and cannot be moved. Creating states in the order they occur
in the scenario enables easier navigation using the Next button, but navigation can occur in any
order and scenarios may involve skipped or repeated states, dependent on user intervention.
(See Navigating between States on page 5.7.)

To create a new state, select the New State option from the Scenario menu.

Scenario |w| Untitled1 = i | b
New {+38N
Open... 30
Open Recent »
Close T #wW
Save .V
Save as...
LS

New Event >

Selecting a New State

The new state (initially named NewState) appears in the Scenario panel.

5 Mb

- NewSlate1

Selecting a New State

5.13



Tabs gBabVSI M®

Select NewState to display the Events and Transitions headings and to activate the Change
state name to field in the lower panel.

Scenario ' w! Untitledl H i | b

¥ LS
Events
Transitions

Change state name to:

NewStatel C Apply )

Displaying a New State

Enter the new name in the Change state name to field and click the Apply button (or press the
Enter button on the keyboard).

Scenario ' v!  Untitled1 2 v |

Baseline
Events
Transitions

Once the new name is entered in the
Change state name to field, click Apply.

// \\ §
Change stelte/mé

Baseline ( Apply R‘

€

Renaming a New State

The new name appears in the Scenario panel.

To edit the name, select the state in the Scenario panel, highlight the old name in the Change
state name to field, enter the new name, and click Apply.

To delete the state, select the state in the Scenario panel and press the delete key. Deletions are
irreversible. Always be sure that the state is not needed before performing the delete function.

Selected states can also be deleted by selecting the Clear option from the Edit menu.
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After creating the state, events and transitions are added to define the state. (See below for

details regarding adding events and transitions.)

Additional states in the scenario are added in order and cannot be moved.

If the exact sequence of states is unknown when the scenario is first being created, it may be
helpful to add unidentified states between known states to ensure a proper progression of states
when the scenario is finished. These unidentified states can then be later defined as necessary

intermediated states or deleted if they are unneeded.

Scenario  v!  Untitled1

Baseline

>
Warsening Shock
Cardiopulmanary Failure

)ewStateb

To delete a state, select the
state and press the delete key.

r
Change state/mme’/

Shock

To rename a state, select the state,
enter the new name in the Change
state name to field and click Apply.

( Apply )

Editing State Names and Deleting States

States can be deleted by first selecting the state and then choosing Clear from the Edit menu or

pressing the Delete key.

All events and transitions defined for the deleted state are also deleted.
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Adding, Editing and Deleting Events

Events set the specific parameters that take place when the state is active. An event may alter a
parameter (e.g. increase the Heart Rate Factor), administer a drug (bolus or infusion) or trigger
the move to a new destination within the scenario.

To add events to a state:
1. Select the state in the Scenario panel

2. Choose an option from the list displayed by selecting the New Event option from the
Scenario menu.

Scenario | w| Untitledl = il )
New 3N
| open... oo |
Open Recent » . .
Selecting the New Event option
Close {rEBW . \
o sy from the Scenario menu displays
SVEEE a list of six possible events..
New State
N | New "Set" Event N #S
New Transition {381 New "Bolus” Event {38
e — 5 New "Call” Event NGHC B

New "Go To" Event NGOG |
New "Infusion” Event _{r38U
New "Multiply” Event X {r#M

m. )

Change state name to

Baseline

Editing State Names and Deleting States

3. Set the parameters for the event. (The type of parameter is determined by the type of
event.)

Editing an Event

Once an event has been created, it can be modified by selecting it and entering new values for
its parameters. This occurs in the same way that the event was created and defined.

Deleting an Event

To delete an event, select the event and press the delete key. Deletions are irreversible. Always
be sure that the event is not needed before performing the delete function.

Events can also be deleted by selecting them and then selecting the Clear option from the Edit
menu.
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There are six different options for new events:

New “Set” Event

New “Bolus” Event

New “Call” Event

New “Go To” Event

New “Infusion” Event

New “Multiply” Event
Each of these options has a unique purpose and different parameter settings.
“Set” Events

A “set” event establishes a specific parameter within a scenario. All adjustable parameters (i.e.
numerical and discrete) can have a “set” event. A parameter that has a “set” value remains
unaffected at that setting until changed by another event.

In some cases, the “set” event can have an “onset” time, thereby allowing for smoother
hemodynamic or respiratory changes. For example, the event set Heart Rate Factor to 1.5 over
1 minute changes the Heart Rate Factor parameter from the patient’s default value to a value of
1.5 over a minute’s time. In these cases, the destination value (e.g. 1.5) can be greater than or
less than the starting value.

When a parameter is set to a specific value, the instructor can change the parameter to a new
value to override the scenario’s instructions. However, if an “onset” time is established in the
scenario instructions, it is NOT possible to override the command until the onset of
the value has completed.
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To establish a “set” event:
1. Select the appropriate state.

2. Choose New “Set” Event from the New Event option of the Scenario menu.

Scenario |w] Untitledl = I[P

New {+#EN

Open... t+¥0

Open Recent »

Close oBwW Select New “Set” Event.

Save 4wV

Save as...

Mew State TN

New Transition {8l New "Bolus" Event L N{4#8B L.
New "Call" Event N{+38C |
New "Go To" Event N{r#8G

Change state name to_ Mew "Infusion” Event N {+38U

Baseline New "Multiply” Event  C{r3M \

Selecting a New “Set” Event

The phrase set ? to ? appears beneath the Events heading of the selected state.

3. Select set ? to ?. The lower panel changes to display three fields beginning with the set
field.

Scenario |w!  Untitled1 = i [

Baseline
Events

set Pto ?
/ansa‘-r:‘ons
Select set ? to 2.
Complete the set field by

€ ) choosing an option from
set 7 / the pull-down list.
| Alveolar CO2
Alveolar Enflurane (Iltes “ Apply )
Alveolar Halothane
Alveolar Isoflurane
Alveolar 02
Alveolar Sevoflurane
Arterial CO2
Arterial 02
Automatic Chest Compression Efficacy En &

k_ L4

Selecting a Parameter to Set

4. Using the pull-down list, complete the set field by selecting the parameter.

5.18



METT Tabs

Generally, the default value for the parameter appears in the value field on the second line.

5. Depending on the nature of the parameter, change the value field by entering a new value
or by selecting a value from a pull-down list.

set Baby Sounds * o

None over 0 minutes R
Baby Talk Apply
Cooing
Cough

N .
Gooing \ For discrete parameters, select the
High-pitched Cry

Screaming value from the pull-down list.
Sneezing I

Selecting a Value for the Parameter

6. Once the correct value is selected or entered, click the Apply button (or press the
keyboard’s Enter key).

Scenario ' w!  Untitled1 &) il | »

Baseline
Events

set Baby Sounds to Crying
Transitions

Click Apply and the new “set”
event appears under the Events
heading of selected state.

€ B e

set Baby Sounds +' to

Crying 5] over 0 minutes

( Apply ,'*‘

Setting the Parameter Values

The new “set” event appears under the Events heading of selected state.

7. (OPTIONAL for ONSET values) If the parameter is numerical and is to be onset over time,
complete the final field in the panel by entering a decimal value for minutes. (e.g. 0.5 is
equivalent to 30 seconds.)

set Respiratory Rate Factor e to

2 over 0.5 minutes
x Apply

Selecting an Onset Value for the Parameter

8. (OPTIONAL for ONSET values) Click Apply (or press the keyboard’s Enter key).
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“Bolus” Events

A “bolus” event is used to administer a drug bolus within the scenario. For example, the event
give bolus of epinephrine 80 mcg in an active state automatically administers 80 mcg of
epinephrine to the patient, irrespective of any user input or the patient’s physiology. The effects
of the drug are not removed until the patient is stopped or until additional physiological changes
have reversed their influence.

To add a “bolus” event:
1. Select the appropriate state.

2. Choose New “Bolus” Event from the New Event option of the Scenario menu.

Scenario | v Untitled1 = il b
New 13N
Open... {+380
| Open Recent » |
Close aaw Select New “Bolus” Event.
Save {8V
Save as...
New State #EN
| New "Set" Eve N A{rags
New Transition {8l S BT
New "Call" Event S fEchEe)
New "Go To" Event DEEEl
Change state name to_ New "Infusion” Event  “{r2eU
Help_arrives New "Multiply” Event  {@r&M )

Selecting a New “Bolus” Event

The phrase give bolus of ?? appears beneath the Events heading of the selected state.

3. Select give bolus of ??. The lower panel changes to display two fields beginning with the
give bolus of field.

Help_arrives
Events

give bolus of 7 7
/ Transitions

Select give bolus of ??. | —————————————— Select the drug from the
| pull-down list.

give bolus of ?
latropine

ply -
fentanyl k
morphine

succinylchaoline

Selecting the Drug for the Bolus Event

4. Using the pull-down list, select the appropriate drug from the list and complete the give
bolus of field.
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Depending on the drug selected, the second field displays a measurement of either mg on
mcg (milligrams or micrograms).

5. Highlight the ? in the measurement field enter the bolus dose (e.g. 80 mcg).

Help_arrives
Events
give bolus of epinephrine B0 meg
Transitions

After selecting the drug, define The newly defined bolus event
the dosage and click Apply. appears under the Events heading.
give bolus owephrme )
80| mcg T Apply |

Entering and Applying the Bolus Dose

6. Click Apply.
The new “bolus” event appears under the Events heading of selected state.
“Call” Events

A “call” event includes the events and transitions of one state within another state. In other
words, a call State B event added to State A makes the events and transitions of State B a part
(or subroutine) of State A. In this way, the use of a “call” event allows states to be used multiple
times without the necessity of redefining their events and transitions.

For example, in a scenario where the same three events are repeated in multiple states, a state
named “Do Three Things” can be used to define those three events, so that this state can be
subsequently called to be included in other states when appropriate.

A “call” event only works within one scenario and only works to call states.
To add a “call” event:

1. Select the appropriate state.
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2. Choose New “Call” Event from the New Event option of the Scenario menu.

Scenario |w] Untitled1 H il | b

MNew TN |
Open... +#0

I Open Recent > I
Close {HEW
S G EV
— Select New “Call” Event.
ave as...
New State N#N

New "Set" Event {rE8s

Mew Transition {3l New "Bolus" Eyefit {8

-

New "CGo To" Event L3 G
~ New "Infusion” Event  C{r38U
Baby_becomes_anxious New "Multiply” Event  C{r3M \

Change state name to

Selecting a New “Call” Event

The phrase call ? appears beneath the Events heading of the selected state.

3. Select call ?. The lower panel changes to display the call field.

Baby becomes anxious
Events

Transitions
Baby shaort of breath
Help arrives

Select call ? and use the
pull-down list to select the
state to call.

call Baseline
Baby_becomes_anxious

N ( Apply )
Help_arrives

Selecting a State to Call

4. Using the pull-down list, select the appropriate state from the list to complete the call field.
5. Click Apply.

The new “call’event appears under the Events heading of selected state.

|

Scenario | v Untitled1 H helll

Baseline

Baby becomes anxious « ”
Events The “call” event appears after
Transitions the call field is completed

Baby short of breath
Help_arrives

and Apply is clicked.

A “Call” Event
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“Go To” Events

A “go to” event moves the scenario automatically from one state to another state. In other words,
instead of navigating manually between states using the Next and Go to buttons on the Scenario
Player, the instructor can design the scenario to move to from state to state without additional
involvement. However, the use of a “go to” event advances the scenario without any modifications,

so interventions have no effect until this movement is complete.

A “go to” event only works within one scenario and only works to move to another state. Because
a “go to” event moves the scenario to a different state, no other events listed after the “go to” event

take effect.
To add a “go to” event:

1. Select the appropriate state.

2. Choose New “Go To” Event from the New Event option of the Scenario menu.

Scenario |w]  Untitledl

: :
v i | s

New
| Open...
Open Recent

Close
Save
Save as...

New State

3N
80

&+ 3EW
{38V

NEN

New Transition C{4-3l1

th Blinking

New
New
New

Baseline

Change state name to

New " |
"Multiply” Event  C{r3EM )

New

"Set” Evént {4 ES
"Bolus" Event {438
"Call" Event owc

Select New “Go To” Event.

Infusion” Event X 438U

Selecting a New “Go To” Event

The phrase go to ? appears beneath the Events heading of the selected state.

3. Select go to ?. The lower panel changes to display the go to field.

Baseline
Events

Transitions
Baby becomes anxious
Baby shart of breath
Help arrives

goto Baseline

set Eyes: Blink Contral to Both Blinking

Baby_short_of_breath
Help_arrives

Select go to ? and use the pull-
down list to choose the state to
go to from the selected state.

Choosing a State to go to from the Selected State
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4. Using the pull-down list, select the appropriate state from the list to complete the go to
field.

5. Click Apply.

The new “go to”event appears under the Events heading of selected state.

Baseline
Events
set Eyes: Blink Cantrol to Bath Blinking

Transitions
Baby becomes anxious

Ef:ﬂv short_of_breath The “call” event appears after
elp_arrives

the call field is completed
and Apply is clicked.

go to Baby_becomes_anxious

 Apply k

A “Go To” Event

“Infusion” Events

An “infusion” event is used to administer a drug infusion (or to stop a drug infusion) within the
scenario. Once an infusion is administered, it continues to run until stopped either through an
additional event in the scenario or user intervention. Infusions are set at an infused rate (mcg/min)
or as a normalized infusion (mcg/kg/min).

For example, the event infuse epinephrine at 0.8 mcg/kg/min starts a 0.8 mcg/kg/min infusion
of epinephrine, irrespective of any user input or the patient’s physiology.

The effects of the drug are not removed until the patient is stopped or until additional
physiological changes have reversed their influence.

To add an “infusion” event:

1. Select the appropriate state.
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2. Choose New “Infusion” Event from the New Event option of the Scenario menu.

Scenario | v  Untitled1 H il | b

New 3N

Open... +#0

Open Recent

| Close G HEW |
Save 48V
Save as... .
Select New “Infusion” Event.

New State NHEN

New "Set" Event {r3es

Mew Transition {31 New "Bolus" Eve {8

New "Call" Eve {r3eC

Change state name to. e ¢° T gEi
Help_arrives  New "Multiply" EverX  CfrEM _“

Selecting a New “Infusion” Event

The phrase infuse ? at ? appears beneath the Events heading of the selected state.

3. Select infuse ? at ?. The lower panel changes to display two fields for entering the drug
name and the rate of dosage.

Help_arrives
Events
give bolus of epinephrine 80 meg
infuse 7 at ?
Transitions

Select infuse ? at ? and use
the pull-down list to choose the
drug to be infused.

s |

infuse ? At
Idopamine

Choosing the Drug to be Infused
4. Using the pull-down list, select the appropriate drug from the list to complete the infuse
field.

5. Complete the infusion dosage by highlighting the ? in the dosage field and selecting a rate
of infusion (i.e. mcg/min or mcg/kg/min) from the measurement pull-down list.

6. Click Apply.
Scenario | v | Untitled1 ] il | s

Baseline

Baby_becomes_anxious The “infusion” event appears after

Baby short of breath i .

Help._arrives the drug is selected, dosage is
Events . .

give bolus of epinephrine 80 meg Completed and Apply IS C“Cked'

Transitions

An “Infusion” Event

The new “infusion” event appears under the Events heading of selected state.
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“Multiply” Events

A “multiply” event is used to apply a factor to a numerical parameter that increases or
decreases the existing value of that parameter. Unlike a “set” event, which can multiply the
default value of a numerical parameter, the “multiply” event factors against the patient’s current
physiological values.

For example, the event multiply Heart Rate Factor by 1.5 over 1 minute(s) changes the heart
rate from its current value to a value 1.5 times greater over the course of a minute. On the other
hand, the event multiply Heart Rate Factor by 0.5 over 1 minute(s) reduces the current heart
rate in half over that same time period. (In contrast, setting the Heart Rate Factor of 1.5 over 1
minute establishes a heart rate 1.5 times the patient’s default value and NOT the current value.)

As shown the examples above, the “multiply” event can have an “onset” time, thereby allowing
for smoother hemodynamic or respiratory changes. Only when the onset of the value has
completed can the instructor manually change the parameter’s values.

To add a “multiply” event:
1. Select the appropriate state.

2. Choose New “Multiply” Event from the New Event option of the Scenario menu.

Scenario |¥] | Untitled1 =) aAILS

Mew {+ 3N
Open... +#0

| Open Recent >
Close T BW
Save 3V
Save as...
New State SN Select New “Multiply” Event.

New "Set" Event

New Transition {31 New "Bolus” Event NOHE ETo
New "Call" Event N4 #C
New "Go To" nt N{r#C
New "Infusigh” Event X{r3U
Baby_becomes_anxious A

Change state name to

Selecting a New “Multiply” Event

The phrase multiply ? at ? appears beneath the Events heading of the selected state.
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3. Select multiply ? to 2. The lower panel changes to display three fields beginning with the

multiply field.

multiply 7 by ?
Transitions
Baby short of breath

\ Select multiply ? at ? and use

Hardware Pacing Curent
Heart Beat Period
Heart Rate

Heart Sounds

Heart Sounds Volume
Hematocrit
Hemorrhage

(==Y

i

v

Help_ arrives / the pU”-dOWn list to choose the
€ parameter to be multiplied.
multiply > *' by
S EIALLIOT O arnspireu Ul wverriue
Functional Residual Capacity e
Apply

Choosing the Parameter to be Multiplied

4. Using the pull-down list, complete the multiply field by selecting the parameter.

Choose only numerical parameters that may be factored. Discrete parameters (e.g. Breath
Sounds, Pupil Dilation) are shown in the list, but selecting these parameters may produce

unexpected results.

5. Highlight the ? in the value field enter a factor to increase or decrease the parameter’s rate.

6. (OPTIONAL for ONSET values) If the parameter is to be onset over time, complete the final
field in the panel by entering a decimal value for minutes. (e.g. 0.5 is equivalent to 30

seconds and 2.0 is two minutes.)

|

Scenario | v| Untitledl

Baseline
Baby becomes anxious
Events
call Baby short of breath

Complete the value field and
(optionally) specify an “onset”

Click Apply to add the
“multiply” event to the selected

time.

Heart Rate\&

multiply

15 over 1

-

minutes

) bvi

state.

‘Apply k

Choosing the Parameter to be Multiplied

7. Once the correct value is selected or entered, click the Apply button.

The new “multiply event appears under the Events heading of selected state.
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Adding, Editing and Deleting Transitions

Transitions are conditional expressions (if X, then Y) that direct the scenario based on
preestablished contingencies. The first part of the expression (the “if” phrase) establishes the
contingency while the second part (the “then” phrase) defines the action to be taken. “If”
phrases specify relationships (i.e. equals, greater than, less than, etc.) between values for time,
drugs, conditions and physiological factors and the command set forth in the “then” phrase.

For example, the transition “if Time in State > 60 seconds then go to Baby_short_of_breath”
moves the scenario to the Baby_short_of_breath state after the specified amount of time, sixty
seconds, has passed. Other transitions could offer alternative paths in the scenario by requiring
an action to be set in motion by the patient’s physiological condition or the cumulative dosage of
a drug administered to a patient. In some cases, these actions won’t occur because they are
triggered only when the condition is met.

To add transitions to a state:
1. Select the state in the Scenario panel.

2. Choose the New Transition option from the Scenario menu.

Scenario |w]  Untitledl +) v

New T8N

Open... T¥0

Open Recent »

Close T EW i
save 0BV 15 over 1 mnuste 4 O€leCt New Transition.
Save as...

New State HEN
New Event

Selecting a New Transition

The phrase if ? = ? then go to ? appears beneath the Transitions heading of the selected
state.

3. Select if ? = ? then go to ?. The lower panel changes to display five fields beginning with
the if field.
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Scenario 'w| | Untitled1

o il
Baseline
Baby becomes anxious
Events

call Baby short of breath

multiply Heart Rate Factor by 1.5 over 1 minute(s)
Transitions

Baby short of breath k

Help arrives
Select the transition and the lower panel
changes to display the fields for the
conditional expression.

it 7 = is =)

? then gotw =
go to +
 Apply )

Selecting the Transition

3. Using the pull-down list, select the desired condition from the If field.

i <is - (

Temperature: Esophageal (body)

=
o fto -

Tidal Velume Factor | el o .
Tidal Volume Override Select the condition for the if
Time in Scenario . .

ime | N | field from the pull-down list.

€ Tracheal Deviation )

Wenous Capacity Factor
Venous CO2 Shift C [ Apply :
Volume/Rate Control Factor i
Wedge Pressure X

Selecting the Condition

When a condition is selected, the field below changes to display the measurement for the
condition field’s value.

vy

|
if  Time in State | is v= . .
= Select the relationship.
? then acto
seconds =
=
Selecting a condition changes the value field -

below to display the appropriate measurement.

( Apply )

Selecting a Relationship for the Condition

4. Select the relationship from the pull-down list in the field to the right of is.

There are six available relationships.
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Condition Relationships
Meaning

equal to

not equal to

greater than

greater than or equal to

less than

less than or equal to

5. Enter or select a value for the value box that follows the relationship field.

If a numerical parameter is chosen as the condition, the measurement that appears the value
box corresponds to the chosen parameter. If a discrete parameter is selected, a pull-down
list with the available parameter settings becomes active.

As conditions in transitions, drug parameters are measured on a per kilogram (of the patient’s
weight) basis. Transitions are triggered when the administered dose meets or exceeds the
entered value (in mcg/kg or mg/kg) times the patient’s weight (e.g. 8 kg for Baby Ryan).

Select or enter a value.

to

if  Time in State

60

seconds

call

then
set

|
give bolus of

N

infuse

= |
v

( Apply )

[

Choose an action for the
condition from the pull-
down list in the then field.

Choosing an Action

6. Complete the then field by selecting the action caused by fulfillment of the specified

condition.

The fields following the then field change to provide the appropriate definition to the chosen
action. These fields correspond to the fields used to define events discussed earlier in this

User Guide.

Action

call

give bolus of
go to

set

infuse

Reference Pages

See pages 5.21 and 5.22

See pages 5.20 and 5.21

See pages 5.23 and 5.24

See pages 5.17 through 5.19

See pages 5.24 and 5.25
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7. Complete the action expression by entering or selecting information for each of the fields.

if Time in State

Complete the fields defining the action.

goto Baseline

Baby_becomes_anxious

Help_arrives

then

Qo to A4

Click Apply.

Apply .

Completing the Transition

8. Click Apply.

The new transition appears under the Transitions heading of the selected state.

Defibrillation Transitions

When creating automated transitions using the Defibrillation variable, note that after defibrillation
the system takes up to three seconds for the values to return from the sensed value (e.g. 16
Joules) to the original value of zero. To prevent unintended successive transitions, a state with a
three second delay may be required between successive states that transition on defibrillation.

Scenario v

Defibrillation Example.hst

Check _for 16_Joule Shock
Events
Transitions

Delay 3 Seconds
Events
Tr: jti

vl

@ 3 seconds then go to Check#2 fo
Check#2 for T

JOUTE ST
Events
Transitions
Marmal_Sinus Rhythm
Events

set Cardiac Rhythm Cverride to Sinus
Transitions

\

if  Defibrillation

Joules

goto  Delay_3_Seconds

16 then

]

- -

Inserting a three second delay ensures
that the Normal Sinus Rhythm state
can only be reached if two separate 16
Joule defibrillations are performed.

o

go to

a |
v

~ Apply

Sample Transitions for a Defibrillation Scenario
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Editing Transitions

Once a transition has been created, it can be modified by selecting the transition in the Scenario
panel and altering both the parameters and their values. Transitions are edited in the same
manner in which they are created.

Deleting Transitions

To delete a transition, select the transition in the Scenario panel and press the delete key.
Deletions are irreversible. Always be sure that the transition is not needed before performing the
delete function.

Transitions can also be deleted by selecting them and then selecting the Clear option from the
Edit menu.

Changing the Location of Events and Transitions

Events and transitions can be moved within the scenario by using either a drag and drop method
or the Cut and Paste commands. (For a review of dragging, See Dragging on Page 3.5.)

Within a state, events occur simultaneously regardless of order except in the cases of “call” or
“go to” events. When a “call” event occurs, the called state’s events take place prior to any
subsequent events in the original state. Whenever a “go to” event occurs, the scenario shifts to
the “go to” state and no further events are run from the original state.

Transitions occur only when their conditions are met.
Events and transitions can be moved to correct any problems with their original locations.
To drag an event or a transition to a different location:

1. Click on the event or transition and hold the mouse button down.

2. Drag the event or transition to the new location. (An indicator line appears as the event or
transition name is dragged past possible locations.)

Scenario | ¥ " Untitled1 3] || b

Baby_becomes_anxious
Events set Bespiratory Rate Factor to 1 over 30 seconds
multiply Heart Rate Fac},‘g by .5 over 1 minute(s) rl
Transitions
Baby_short_of breath
Events
set Respiratory Rate Factor to 1 over 30 seconds| deSIred |Ocat|0n and drOp |t |nt0 place

Transitions

Drag the event or transition to the

=
Help_arrives 5

[ y Jai»

Dragging an Event to a New Location
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3. Release the mouse button, dropping the event or transition into the desired location.
To cut and paste an event or transition into a different location:
1. Select the event or transition.

2. Choose the Cut option from the Edit menu [or use the Command ( & ) + X shortcut keys].
The event or transition disappears from its original location.

3. Select the new state where the event or transition will be located.

4. Choose the Paste option from the Edit menu [or use the Command ( & ) + V shortcut
keys].

Copying Events and Transitions

Events and transitions can be copied and pasted within any state of the scenario by using the
Copy and Paste commands.

To copy and paste an event or transition into another state in the scenario:
1. Select the event or transition. (Only one event or transition can be selected at a time.)

2. Choose the Copy option from the Edit menu [or use the Command ( & ) + C shortcut
keys]. The event or transition is copied onto the unseen clipboard.

3. Select the new state where the event or transition will be located.

4. Choose the Paste option from the Edit menu [or use the Command ( & ) + V shortcut
keys]. If needed, the newly copied event or scenario can now be edited.

Using the same method, an event or transition can also be copied and pasted into a different
scenario.

To copy and paste an event or transition into another scenario:
1. Select the event or transition. (Only one event or transition can be selected at a time.)

2. Choose the Copy option from the Edit menu [or use the Command ( & ) + C shortcut
keys]. The event or transition is copied onto the unseen clipboard.

3. Open the second scenario using the Open or Open Recent options from the Scenario
menu.

4. Select the state in the second scenario where the event or transition will be located.

5. Choose the Paste option from the Edit menu [or use the Command ( & ) + V shortcut
keys]. If needed, the newly copied event or scenario can now be edited.
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Saving Scenarios
To use the scenario with any patient the scenario file must be named and saved.

Modified preconfigured files must be renamed before they can be saved. Renamed
preconfigured scenarios and user-created scenarios can be overwritten, so multiple saves can
be performed on those scenarios as changes are made. Saving a scenario file removes the
previous version of that scenario.

Initially, new scenarios appear in sequence as Untitled files (e.g. Untitled1 or Untitled?2).
To save a scenario:

1. Select the Save [or use the Shift + Command ( & ) + V shortcut keys] or the Save as option
from the Scenario menu. When saving a preconfigured file, only the Save as option
functions because the file must be renamed.

Scenario |*] | Untitledl =4 | [
New N )
| open... oxo T

SES N seh ’ Select Save or Save as from

the Scenario menu.

h Blinking
Close OBW ¢

Save

Save as... p,
MNew State NCEN

'y
New Event P 5overd minute(s) v
New Transition <4381 ¢ . BEIC

Selecting Save As

Named scenario files are saved automatically with the Save option.

New, unnamed scenario files that are saved or any files saved using the Save as option
activate the Save file as navigational window.

2. Navigate to the location in the directory where the scenario files are to be stored (the
/Users/Shared folder).
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3. Enter the name for the scenario in the Selection field.

The full file path for a scenario or patient is limited to a maximum of 104 characters. For
example: /Users/Shared/subdirectory1/subdirectory2/reallygoshdanglongpatientorscenariofilename

s} g App!icatkwons
HPSVersion6
v Scenarios B
Baby Scenarios
Factory Test Scenarios
(5] (o] Save file as...

/

elsers—————— ]

hpsuser
Shared

Use the Save file as window to locate the

folder where the scenario file is to be stored.

I
(&) (@) Save file as...

Selection:

Shared H

B % Ready.

"Infant Shock.hsé

Selection:

. Ready.

Enter the scenario name in the
Selection field and click Save.

Selection

New Scenario Name

T - Ready. “ Cancel © £ Save k\

Navigating to the Scenario File’s Folder

4, Click Save.
The scenario file is now available to all users with access to the folder where the file was

saved.
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Using the Event Recorder

The Event Recorder records parameter changes made to the active patient. These recorded
changes can subsequently be added to a scenario as events. By observing the physiological
changes to the patient, modifications to the parameter values can be made using the Event
Recorder prior to adding those events to the scenario.

To use the Event Recorder:

1. Open the Event Recorder by clicking the Recorder icon on the Patient toolbar.

= _ Click the Recorder icon

- (7™ Ji i
L) - - on the Patient toolbar. =

Save  Stop  Logs Detach Tab Recorder Connections

Opening the Event Recorder

The Event Recorder opens as a separate window, displaying a list of the names of all the
patient files opened during the session. Patient files that have been closed are included in
this list.

By default, the status field shows that the Event Recorder is Stopped.

2. Select the active patient whose events are to be recorded.

88e Event Recorder =

. Stopped (N

Record Clear events

localhast

-/ Selected the patient and
Fussy Baby (closed) . .
click the Record icon.

Starting to Record

3. Click the Record icon.

The status field shows that the Event Recorder is Recording.
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4. Set the new parameters, observing the physiological changes in the patient.

Parameters are set using the Condition, Drugs, Fluids, Cardiovascular, and Respiratory
tabs, discussed later in this section.

8eoe Event Recorder = |

! — The status field shows that the
e Event Recorder is Recording.
=

set Shunt Fraction to 0.04

set Tidal Volume Factor to 2.2

set Shunt Fraction to 0.05

set Eves: Blink Speed to Fast
Fussy Baby (closed) The recorded events appear as the

parameter changes are set.

Recording Events
Reset the parameters until the desired physiology is achieved.
As an example, the Event Recorder shown below displays the Shunt Fraction and
Tidal Volume Factor parameters found in the Respiratory Control section beneath the

Respiratory tab and the Eyes: Blink Speed parameter found in the Assessment section of
the Condition tab.

The Shunt Fraction parameter has been reset in this example (from 0.04 to 0.05).
Managing Events in the Event Recorder
Events and closed patient files can be deleted from the Event Recorder.

To remove an event, select the event and either press the delete key or click the Clear icon. To
clear all the events from an active patient, select the patient file and either press the delete key
or click the Clear Events icon. To remove a closed patient file (and all its events), select the
patient file and either press the delete key or click the Remove icon.

To stop recording events, click the Stop icon.

Events recorded in the Event Recorder cannot be saved unless moved to a scenario. (See
Moving Recorded Events to a Scenario below.) Once the Event Recorder is closed, its events
are no longer available.

To close the Event Recorder, click the red button in upper left-hand corner of the window or,
with the Event Recorder active, choose the Close Window option from the Window menu.
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Copying Recorded Events to a Scenario

Recorded events can be copied from the Event Recorder to a scenario in the Scenario Editor by
using either a drag and drop method or the Copy and Paste commands. (For a review of
dragging, See Dragging on Page 3.5.)

To copy a recorded event to a scenario using drag and drop:
1. Select the event to be copied in the Event Recorder, holding down the mouse button.

2. Drag the event to its new location in the scenario. A blue line appears to indicate where
the event is being placed.

T

Simulation ~ Scenario  Condition  Drugs  Fluids  Cardiovascular ene Event Recorder o
. Recording o
Show: Editor +] - Stap Clear
localhest
B, - Baby Ryan (1)
Scenario ¥ Respiratory Distress.hs6 - set Shunt Fraction to 0.04
Baseline set Shunt Fraction to 0.05

Baby becomes anxious
Baby shart of breath

set Eyes: Blink Speead to Fast
Fussy Baby (closed)

Events set Tidal Volume Faglorto 2.2
set Shunt Fraction to 0.05 Y
set Eyes: Blink Speed to Fast
Transitions
Help arrives

Dragging a Recorded Event to a Scenario

3. Release the mouse button. The event is now in the scenario.
To copy a recorded event to a scenario using the Copy and Paste commands:
1. Select the event to be moved in the Event Recorder.

2. Choose the Copy option from the HPS Edit menu [or use the Command (& ) + C
shortcut keys]. The event is copied onto the unseen clipboard.

3. Select the state in the scenario where the event will be located.

4. Choose the Paste option from the HPS Edit menu [or use the Command (& ) + V
shortcut keys]. If needed, the newly copied event can now be edited.
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Tabs

The Conditio

Selecting the Condition tab opens a window that provides a means of changing parameter

n Tab

The Condition Tab

settings that control patient conditions related to assessment and trauma.

By default, Assessment is selected in the Show pull-down menu located above a panel with a
list of Parameters and a panel with settings for those parameters. At the bottom of the window

is a Description of the selected parameter.

I Simulation Scenario | Condition | Drugs Fluids Cardiovascular Respiratory
shonl T M | Condition parameters include those
W—mds for Assessment and Trauma.

Bowel Sounds
Bowel Sounds: Left Abdomen
Bowel Sounds: Right Abdomen

The list of Parameters is
located in the panel on the left. | pockade

TOTTCETTET
Heart Sounds
Micropheone Volume

- sase o 4. ‘.'

Description

4

Baby Sounds

Value:

MNone (Default)
Baby Talk
Cooing

Volume
None

Max
None
Baby Talk m
Cooing

Cough
Cr\-’igg The settings for the selected parameter

eeina i appear in the panel on the right.

e | v
—— Min

0

A Description of the selected parameter
appears in the bottom panel.

]

Each parameter has settings specifically designed to accurately and realistically affect the infant

patient’s physiology.

The Condition Tab

Condition Parameters

Assessment
Baby Sounds
Bowel Sounds
Bowel Sounds: Left Abdomen
Bowel Sounds: Right Abdomen
Breath Sounds
Eyes: Blink Control
Eyes: Blink Speed
Fixed Neuromuscular Blockade
Fontanel
Heart Sounds
Microphone Volume
Patient Weight

Temperature: Arterial (blood)

Temperature: Esophageal (body)

Trauma

Chest Compression Efficacy

Intrapleural Volume

Needle Decompression
Pericardial Fluid (Acute)
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Assessment

Choosing Assessment in the Show pull-down menu displays the Parameters field in the left
panel with an alphabetical list of parameters used in evaluating the patient’s physiology.

Currently, there are fourteen Assessment parameters, each of which is described in the
paragraphs below.

Baby Sounds

Value: None (Default)

Baby Talk
Cooing

Cough

Crying

Gooing

High Pitched Cry
Screaming

Sneezing

Baby sounds are selected using this parameter. The sounds are played in a
continuous loop until unselected. The volume control slider is used to increase or decrease the
baby sound volume.

Bowel Sounds

Value: None
Normal (Default)
Hyperactive
Hypoactive

Normal and abnormal bowel sounds are selected using this parameter. Sounds are played in a
continuous loop on both the left and right side of the abdomen. The volume control slider is used
to increase or decrease the bowel sound volume.
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The Condition Tab

Bowel Sounds: Left Abdomen

Value: Enabled (Default)
Disabled

Bowel Sounds Left Abdomen is used to enable or disable the playing of bowel sounds on the left
side of the abdomen.

Bowel Sounds: Right Abdomen

Value: Enabled (Default)
Disabled

Bowel Sounds Left Abdomen is used to enable or disable the playing of bowel sounds on the left
side of the abdomen.

Breath Sounds

Value: Normal (Default)
Biphasic Wheeze
Bronchovesicular
Crackles
Prolongation
Rhonchi
Stridor
Wheeze

Normal and abnormal breath sounds are selected using this parameter. Breath sounds are
independently synchronized with ventilation of the left and right lungs. The volume control slider
is used to increase or decrease the breath sound volume.
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Eyes: Blink Control

Value: Automatic (Default)
Eyes closed
Both blinking
Left blinking
Right blinking

This parameter is used to control eyelid blinking, with a blink rate specified by the Eyes: Blink
Speed parameter. By default, eyelid blinking is automatically controlled, but can be overridden by
the instructor.

In Automatic mode, the eyelids are normally blinking. However, the eyelids will automatically
close under any of the following conditions:

- Spontaneous Minute Ventilation < 200 ml

- Neuromuscular Blockade > 30%
-S202 <70 %

Thus, the eyelids will close in the presence of drugs sufficient to induce cessation of spontaneous
breathing. Likewise, non-pulsatile cardiac rhythms (e.g. Coarse and Fine Ventricular Fibrillation,
Pulseless Ventricular Tachycardia, Pulseless Electrical Activity (PEA) and Asystole) will result in
the eyelids closing. Eyelid blinking will resume when none of the aforementioned conditions are
met.

Other settings allow the user to have one or both eyes either blinking or closed and will override
the automatic response.
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Eyes: Blink Speed

Value: Normal (Default)
Slow
Fast

This parameter is used to control the eyelid blinking frequency. Presently, blinking frequency is
not linked to the physiological models. However, the response can be scripted using the Scenario
Editor.

Fixed Neuromuscular Blockade

F,XSF Value: -1,0to 100%  Default -1 (model driven)
muscular

Blockade

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The degree of neuromuscular blockade is determined automatically by the pharmacokinetic and
pharmacodynamic models based on the neuromuscular blocking agents administered and the
time course of their injection. For some educational applications, however, the instructor may
wish to set a fixed degree of neuromuscular blockade that remains stable for an indefinite
period of time. This can be accomplished using the Fixed Neuromuscular Blockade parameter.
The default value of -1 instructs the pharmacologic models to determine the degree of
neuromuscular blockade based upon the drugs injected and their pharmacologic properties.

When any other positive value is assigned to this parameter, the degree of neuromuscular
blockade is set to that level. For example, Fixed Neuromuscular Blockade 80 causes the
simulator to set the degree of neuromuscular blockade to 80%, regardless of the presence (or
absence) of neuromuscular blocking drugs. Clinically, the spontaneous tidal volume is markedly
reduced.
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Fontanel

Value: Normal (Default)
Bulging

The anterior fontanel is a fibrous, membrane-covered gap in the bony cranium located at the
juncture of the two parietal and two frontal bones. The fontanel should feel flat. When the infant
is calm, a bulging fontanel can indicate increased intracranial pressure. When Bulging is
selected, the anterior fontanel on the mannequin will expand to simulate conditions such as
increased intracranial pressure in an infant.

Heart Sounds

Value: Normal (Default)

83 and S4

Early Systolic Murmur
Mid Systolic Murmur
Late Systolic Murmur
Holosystolic Murmur
Late Diastolic Murmur

Normal and abnormal heart sounds are selected using this parameter. Sounds are synchronized
with the cardiac cycle. The volume control slider is used to increase or decrease the heart sound
volume.
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The Condition Tab

Microphone Volume

Microphone Volume is used to adjust the volume of sound coming from the wireless microphone.
To increase or decrease the volume of the microphone, and thus the patient's voice, use the
volume control slider.

Patient Weight

Value: 2 to 20 kg
Default 8 kg

This parameter sets the patient weight used by the pharmacologic models.
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Temperature: Arterial (blood)

Tﬁqnnistor

(
N\
PA catheter

-~

Value: 32 to 42 degreesCelsius Default 37 degrees Celsius

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The temperature measured in arterial blood can be set using this parameter and can be displayed

on the Waveform Display.

Please note that changes in arterial temperature may alter the shape of the standard
oxyhemoglobin dissociation curve as described below:

Within limits, as temperature increases, so does the amount of oxygen released from
hemoglobin; in contrast, as temperature decreases more oxygen remains bound to

hemoglobin.

Hyperthermia therefore causes a rightward shift, while hypothermia causes a leftward shift to
the standard oxyhemoglobin dissociation curve.

Any other arterial temperature links to the physiologic models can be scripted using the Scenario

Editor.

Temperature: Esophageal (body)

[ Themmlstor.
"

A 1

-

—

Tempee rature probe

Value: 32 to 42 degrees Celsius Default 36.5 degrees Celsius

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The temperature measured in the esophagus can be set using this parameter and can be
displayed on the Waveform Display.

The esophageal temperature is not linked to the physiologic models. However, changes can be
scripted using the Scenario Editor.
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Trauma

Choosing Trauma in the Show pull-down menu displays the Parameters field in the left panel
with an alphabetical list of parameters used in evaluating the patient’s physiology.

Currently, there are four Trauma parameters, each of which is described in the paragraphs below.

Chest Compression Efficacy

Value: 100% (Default)
0%

The Chest Compression Efficacy parameter is used to determine the effectiveness of the chest
compressions administered by the caregiver. The 100% setting indicates that chest
compressions are completely effective, while the 0% setting prevents them from having any
effect on intrathoracic pressure.

Intrapleural Volume

Intrapleural Volume (Left)
Intrapleural Volume (Right)

Value: 0to 100 ml Default 0 ml

Onset: 0 to 60 seconds
0 to 60 minutes  Default O minutes

Normally, the visceral and parietal pleural surfaces are closely approximated with virtually no
volume in between. The intrapleural volume parameters allow intrapleural volume to accumulate,
for example, as happens during pneumothorax, hydrothorax, or hemothorax. Accumulation of a
“displacing” volume in the intrapleural space causes compression of the lung tissue because
both lung tissue and intrapleural volume are contained within the chest wall. Thus, attempts to
inflate the compressed lung are prevented by the relative indistensibility of the chest wall at
higher lung volumes.
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Needle Decompression

Value: Enabled
Disabled (Default)

The Needle Decompression parameter is used to activate the needle decompression to relieve a
pneumothorax hardware in the mannequin.

Pericardial Fluid (Acute)

Value: 0to 20 ml Default 0 ml

Onset: 0 to 60 minutes Default O minutes

~

Pericardial Fluid (Acute) is used to simulate the amount of fluid within the pericardial sac. This
parameter may be used to simulate the infant with a cardiac tamponade.
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The Drugs Tab

The Drugs Tab

Selecting the Drugs tab opens a window that provides a means of administering medications
from the Instructor Workstation. Based on normal clinical practices, medications may be given
as a bolus, an infusion, or as an infusion based on the patient’s weight in kilograms (normalized
infusion).

By default, All drugs is selected in the pull-down menu located above the window showing the
available drugs.

! Simulation Scenario Condition | Dmgs‘. Fluids Cardiovascular Respiratory |
L.y
All drugs F The pull-down menu allows specific
ATROPINE atropine types of drugs to be selected.
DOPAMINE dopamine ;
epinephrine
FENTANYL fentanyl

. . hi

The list of available drugs morpne

. . succinylcholine
appears in the window.

atropine The administration options for the
@ Bolus 1 mg selected drug appear in the bottom panel.
"?JS on . : 0
nfusion/kg ( Administer )

ng/ml

The Drugs Tab

The pull-down menu offers the option of selecting a specific drug category.

Drug Categories

Narcotics

Neuromuscular Blockers

Cardiovascular

ACLS

Once a drug is selected in the window, the bottom panel displays the settings for administering
the selected drug.
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Administering Medications
To administer medications:

1. Select the drug. The bottom panel displays that drug’s administration settings.

Simulation Scenario Condition | Drugs | Fluids Cardiovascular Respiratory
All drugs = Select the drug.
ATROPINE atropine
DOPAMINE dopamine i
[ epinephrine

FENTRNTL fentanyl

Click the button for the method
used to administer the drug.

morphine

succinylcholine

Enter the dosage.

epinephrine

— Effector Site
. Bolus

0.8 mcg/kg/min Concentration
O Infusion o
Infusion /kg £ Set N Click Set (or Administer
for Bolus).

Administering Drugs

2. Click the radio button for the appropriate method of administering the drug. Some drugs
may have only one acceptable method.

3. Enter the dosage in the field to the right of the methods. This field will be labeled either
mcg or mg (for bolus), meg/kg (for infusions) or meg/min/kg (for normalized infusions).

4. Click the Administer button to enter a bolus injection or the Set button to start an
infusion.

Interpreting the Effector Site Concentration

When a drug is administered to a patient, the onset and duration of its effect depend upon the
rate of absorption into the bloodstream, distribution to various organs, tissue binding, access to
those tissues where the pharmacological effect takes place, interaction with receptor sites, and
elimination by various routes. The effect of a drug is modeled by a static relationship between the
drug concentration in a hypothetical effector site (of negligible volume) and a measurable effect.
Because of the hypothetical nature of the effector site, its concentration is called an “apparent”
concentration, and is defined as the plasma concentration in a steady-state situation that results
in the same degree of drug effect. This concentration, shown in the lower right-hand panel as
Effector Site Concentration, is displayed in nanograms per milliliter (ng/ml).
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The Fluids Tab

The Fluids Tab

Selecting the Fluids tab opens a window that provides a means of controlling the amount of fluid
lost by or infused into the patient. The upper panel provides scrollable access to the various fluid
parameters and the bottom panels display the controls for entering the amount of fluid to be lost
or infused and establishing the time frame during which the fluid loss or infusion will take place.

' Simulation Scenario Conditicn Drugs | F{uids.. Cardiovascular Respiratory |
L3
_ Fluid . Fluid _mrusiq When the Fluid tab is selected, the
L Reme L e 427%™ window displays a choice of six fluids.
. (Blood) “_(Plasma) - b U
< 2 Selecting a fluid activates the control
) settings for that fluid.
Fluid Loss Violume (Blood)
Value Onset
0 @Minutes
I ) second ;
L Enter a Value and an Onset time to
set the amount of fluid lost or added.
v}

mil minutes

.__\' Set "__.

The Fluids Tab

Currently, there are six fluids that can be controlled using the Fluids tab.

Fluid Parameters
Fluid Event Use/Effect

Reflects a decrease in total blood volume. “Blood Loss” proportionally decreases
S VT M A6 [T X 21 61eTe | B both the red blood cell volume and the plasma volume according to the current
hematocrit.

Reflects a decrease in plasma volume. “Fluid Loss” decreases the plasma volume
without changing the red blood cell volume. It refers collectively and generically to
all fluid losses, including evaporative, transcellular (e.g. ascites, pleural effusion),
bowel, and third space fluid losses.

Reflects an addition to the plasma volume without changing the red blood cell
Infusion (Colloids) volume. Colloids include modified fluid gelatin starch solutions (pentastartch and
hetastarch), dextran and human albumin.

Fluid Loss Volume (Plasma)

Reflects an addition to the plasma volume without changing the red blood cell
Infusion (Crystalloids) volume. The term crystalloid is used to describe salt solutions for infusion, for
example, normal saline, dextrose in water and Ringer’s Lactate.

A preparation of 70% red blood cells and 30% liquid plasma, often administered in
severe anemia to restore adequate levels of hemoglobin and red cells without
overloading the vascular system with excess fluids.

Infusion
(Packed Red Blood Cells)

The term whole blood is used to refer to blood that has not been separated into its
Infusion (Whole Blood) various components. It represents a preparation of 40% red blood cells and 60%
liquid plasma.
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Controlling Fluids

To control fluids lost or infused:

1. Select the fluid by clicking on the icon in the scrollable window. The bottom panel displays

that fluid’s control settings.

. Fluid

s Loss
4 ¥olume

“_{Blood)

Use the slider or enter the amount
of fluid in the Value panel.

N

Fluid Loss Volume (Blood)

., Fluid ., Infusion ., Infusion
&4 \-'I\?(t:?ﬁme ’.:‘é\.(ﬁillmds) y :ﬁ\.{ﬁ?stallmds
" (Plasma) - ?‘ : ?‘
=== | Click the radio button in the Onset panel
to set the method of time measurement.
Ons
= Use the slider or enter the amount
S / of time in the Onset panel.
60
60|
minutes
Click Set.
: .___' Set \I/

Setting Fluid Loss or Infusion

right of the slider.

. In the Value panel, use the slider to choose a value or enter the value in the field to the

. In the Onset panel, click a radio button to select in Minutes or Seconds that will determine

the time measurement for the fluid loss or infusion.

. Use the slider to choose the amount of time over which the fluid loss or infusion will take

place or enter that amount in the field to the right of the slider.

5. Click Set.

The amount of fluid lost or infused appears in the Value fields as the loss or infusion takes place.
This amount increases until the total value is achieved at the end of the onset time.

In the example above, 60 milliliters (mL) of blood loss have been set to occur over 60 minutes. In
this scenario, the field beneath Value will show an additional milliliter of blood loss each minute
until the full 60 minutes have elapsed and a total of 60 milliliters of blood has been lost.
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Hematology Model

The

physiological model calculates hematocrit values (i.e. percentage of total blood hemoglobin)

dynamically and continuously, taking into account blood and fluid losses, as well as the
intravenous infusion of fluids such as whole blood, packed red blood cells, colloids, and
crystalloids.

Instructors can now create patients with both normal and pathophysiological hematocrit
levels. In addition, learners discover how administering various fluids impacts hematocrit, the
oxygen-carrying capacity of blood, and the resulting patient response.

The

following important assumptions were made in the design of this initial Hematology Model:
Blood is comprised of two components: red blood cells and plasma.

Plasma is comprised of two components: colloid and crystalloid. The term colloid is used to
describe substances that generate a clinically significant colloid osmotic pressure, for
example, fresh frozen plasma, albumin and hetastarch. The term crystalloid is used to
describe salt solutions for infusion, for example, normal saline, dextrose in water and
Ringer's Lactate.

The mixing of blood and its various constituents is instantaneous and homogeneous. In other
words, one liter of crystalloid administered intravenously equilibrates immediately and
homogeneously throughout the entire circulation.

This initial Hematology Model does not yet distinguish between the differing clinical effects
of colloids versus crystalloids. For example, osmotic pressures and capillary leakage rates
are not taken into account. Likewise, fluid kinetics and how fluids distribute within the
circulation, the interstitial, and intracellular spaces are also not presently modeled.
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In the Hematology Model, the following model variables, definitions, and relationships have been
established:

Red Blood Cell Volume: The volume of red blood cells within the circulation.
Plasma Volume: The volume of plasma within the circulation.

Total Blood Volume: The volume of blood (i.e. Red Blood Cell Volume + Plasma Volume)
within the circulation.

Blood Volume Loss: The amount or rate of decrease in the total blood volume. A given
amount or rate of blood loss proportionally decreases both the Red Blood Cell Volume and
the Plasma Volume according to the current hematocrit.

Plasma Volume Loss: The amount or rate of decrease in the plasma volume. A given amount
or rate of plasma loss decreases the plasma volume without changing the red blood cell
volume. Plasma Volume Loss refers collectively and generically to all plasma fluid losses,
including evaporative, transcellular (e.g. ascites, pleural effusion), bowel and third space
losses.

Hematocrit: The ratio of Red Blood Cell Volume to Total Blood Volume, expressed as a
percentage.

The Hematology Model is affected by the choices made using the parameters provided by the
Fluids tab. In the table below, this effect is shown as an increase (4), decrease (f) or unchanged.

Fluid Loss Fluid Loss Infusion Infusion Infusion Infusion
Effect Volume Volume (Colloids) (Crystalloids) (Packed Red (Whole

(Blood) (Plasma) Blood Cells) Blood)
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The Cardiovascular Tab

Selecting the Cardiovascular tab opens a window providing a means of changing parameter
settings that control patient conditions related to the circulatory system. Catheters is selected in
the Show menu located above the Parameters panel and the panel with the settings for those
parameters. At the bottom of the window is a Description of the selected parameter.

" Simulation Scenario Condition Drugs Fluids | Cardiovascular | Respiratory 1

Y  Catheters
External Cardiac Stimulation
Heart

— | Cardiovascular parameters are
rarerial | organized under Catheters, External

cathel Pulses Cardiac Stimulation, Heart, Pulses
Cathe] . SY3temic mosphere | gnd Systemic headings.
PA Catheter Balloon Inflation
The list of Parameters is @ Peripheral Artery
located in the panel on the left. The settings for the selected parameter
~ Lefevere| @PPEQr IN the panel on the right.

-

Description
Catheter: Arterial -
value: A Description of the selected parameter
Atmosphere appears in the bottom panel.
Peripheral artery (Default)
Left ventricle 1

The Condition Tab

The Show menu contains five sub-sections, each with its own set of parameters.

Cardiovascular Parameters

Catheters Pulses Systemic
Catheter: Brachial Baroceptor Gain
Arterial (Overall) Factor
Catheter: ] Baroceptor Gain
Central Venous (Peripheral) Factor

Catheter:

Pulmonary Artery Baroceptor Maximum Pressure

PA Catheter

Balloon Inflation (wedge) Baroceptor Minimum Pressure

Elastance: Extrathoracic Arteries

Elastance: Intrathoracic Arteries

Elastance: Pulmonary Arteries

Resistance Factor:
Pulmonary Vasculature

Resistance Factor:
Systemic Vasculature

Resistance Factor:
Venous Return

Venous Capacity Factor
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Catheters

Choosing Catheters in the Show pull-down menu of the Cardiovascular tab displays the
Parameters field in the left panel with an alphabetical list of parameters used in affecting the
patient’s physiology.

Catheter: Arterial

Value: Atmosphere
2= ) Peripheral artery (Default)
T P, S Left ventricle

The arterial pressure displayed on the Waveform Display is set using this parameter. A
non-pulsatile “zero” pressure signal is emitted when the Atmosphere position is selected and
can be used to simulate zeroing a pressure transducer. This may also be used to remove the
arterial pressure waveform if desired (i.e. the beginning of a scenario with an “unmonitored”
patient). The Left ventricle position is useful for simulating cardiac catheterization procedures,
or for demonstrating left ventricular end-diastolic pressure and its relationship to pulmonary
artery occlusion (“wedge”) and central venous pressure.

Catheter: Central Venous

Value: Atmosphere
Extrathoracic vein

- o

Intrathoracic vein (Default)

The venous pressure displayed on the Waveform Display is set using this parameter. A
non-pulsatile “zero” pressure signal is emitted when the Atmosphere position is selected and
can be used to simulate zeroing a pressure transducer. This may also be used to remove the
central venous pressure waveform if desired (i.e. the beginning of a scenario with an
“unmonitored” patient).
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Catheter: Pulmonary Artery

!]i

Value: Atmosphere
_— Intrathoracic vein
- : Right atrium

..:..r'i fik Right ventricle
. Pulmonary artery (Default)

The pulmonary artery pressure displayed on the Waveform Display is set using this parameter. A
non-pulsatile “zero” pressure signal is emitted when the Atmosphere position is selected and
can be used to simulate zeroing a pressure transducer. This may also be used to remove the
pulmonary arterial pressure waveform if desired (i.e. the beginning of a scenario with an
“unmonitored” patient). The pulmonary artery catheter can be “floated” into position by
sequencing through the right heart positions. This may also be scripted into a scenario using the
Scenario Editor.

Catheter: PA Catheter Balloon Inflation (wedge)

Value: Balloon inflated

’:& Balloon deflated (Default)

Inflation of the pulmonary artery catheter balloon is simulated by selecting the Balloon Inflated
option of the PA Catheter Balloon Inflation (wedge) parameter. The appropriate pulmonary
artery occlusion or “wedge” waveform is then displayed on the Waveform Display.
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External Cardiac Stimulation

Choosing External Cardiac Stimulation in the Show menu displays the Parameters field in the
left panel with a list of parameters used to defibrillate or pace the patient from the HPS6
software. Each parameter displays a current value, a slider showing a range of acceptable
values and a corresponding field where new values can be entered.

Defibrillation

Value: 0 to 360 Joules
Default 0 Joules

The Defibrillation parameter is used to simulate a specified amount of energy discharged via an
external cardiac defibrillator. Setting this parameter results in the characteristic spike in ECG,
followed by a return to pre-defibrillation rhythm. Defibrillation has no direct effect on the
electrical conduction system of the heart; thus cardioversion may be scripted using the Scenario
Editor.

Pacing Capture Threshold

Value: 0 to 200 mA
Default 50 mA

The Pacing Capture Threshold parameter determines the minimum pacing current necessary in
order to pace the heart via an external cardiac pacer. Also see Pacing Current. Pacing current
values below the pacing capture threshold will have no effect on the patient’s heart rate.
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Pacing Current

Value: 0 to 200 mA
Default 0 mA

The Pacing Current parameter is used to simulate a specified amount of current discharged via
an external cardiac pacer. Setting this parameter results in the characteristic pacing signal on the
ECG waveform when the pacing current is at or above the capture threshold. Also see Pacing
Capture Threshold.

Pacing Rate

Value: 40 to 170 beats/min
Default 80 beats/min

The Pacing Rate parameter determines the cardiac rate (in beats/min) when the pacing current

is at or above the pacing capture threshold. Also see Pacing Current and Pacing Capture
Threshold.
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Heart

Choosing Heart in the Show menu displays those parameters used to affect how the patient’s
heart functions or the ECG displayed on the physiological monitor. Heart parameter values are
controlled using either numerical or discrete settings, depending on the parameter.

Baroceptor Gain (Cardiac) Factor

Value: 0 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

This parameter selectively adjusts the influence of mean arterial pressure (MAP) on the cardiac
effectors (heart rate and contractility). A factor of less than 1 corresponds to baroreflex
depression (e.g. less heart rate response to MAP changes). A value greater than 1 leads to a
stronger response to MAP changes. Setting Barorecptor gain (cardiac) factor to 0 can simulate
the absence of baroreflex control of the heart in a transplant patient. The effect of this factor and
the Baroreceptor Gain (Overall) Factor is multiplicative.
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Value: Sinus (Default)

Sinus Tachycardia

Sinus Tachycardia (120)

Sinus Bradycardia

Sinus Bradycardia (40)

Sinus with PACs

Atrial Fibrillation

Atrial Fibrillation (80)

Atrial Fibrillation (120)

Atrial Flutter

Atrial Flutter (150)

Sinus with 10% PVCs

Sinus with 25% PVCs

Ventricular Tachycardia

Ventricular Tachycardia (151)
Pulseless Ventricular Tachycardia
Pulseless Ventricular Tachycardia (151)
Coarse Ventricular Fibrillation

Fine Ventricular Fibrillation

PEA

Normal Junctional

Normal Junctional (50)

Paroxysmal Junctional Tachycardia
Paroxysmal Junctional Tachycardia (130)
Left Bundle Branch Block

Left Bundle Branch Block with PVCs
Right Bundle Branch Block

Third Degree AV Block

Mobitz Type | (Wenckebach)

Mobitz Type Il

Myocardial Ischemia (mild)
Myocardial Ischemia (moderate)
Myocardial Ischemia (severe)
Myocardial Ischemia (moderate) PVCs
Asystole

Cardiac Rhythm Override is used to change the patient’s underlying cardiac rhythm. To change
the cardiac rhythm, select the desired rhythm and click Select. If a number appears following the
cardiac rhythm, this also overrides the heart rate to the rate indicated. Cardiac rhythms without
a number indicate that the heart rate can be independently controlled by using the Heart Rate

Factor parameter.
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Contractility Factor: Left Ventricle

== % factor Value: 0.1 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

ABPt C.O. ¢4

The baseline (before baroreceptor and drug influences are taken into account) left and right
ventricular contractility are adjusted with these parameters. A value of 2 doubles the baseline
contractility. A value of 0.5 decreases it by 50%. These parameters are typically used to
configure a patient with decreased (or increased) myocardial contractility. Alternatively, they can
be used in a subsequent scenario state to create acute myocardial depression.

Contractility Factor: Right Ventricle

} factor Value: 0.1 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

PAPY CVP+

The baseline (before baroreceptor and drug influences are taken into account) left and right
ventricular contractility are adjusted with these parameters. A value of 2 doubles the baseline
contractility. A value of 0.5 decreases it by 50%. These parameters are typically used to
configure a patient with decreased (or increased) myocardial contractility. Alternatively, they can
be used in a subsequent scenario state to create acute myocardial depression.
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Fixed Heart Rate

Value: -1, 31 to 275 bpm Default -1 bpm (model driven)

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

Typically, the heart rate is determined automatically by the physiologic models, which account for
pharmacologic interventions and changes in patient physiology. The Fixed Heart Rate
parameter is used to set the heart rate to a given number of beats-per-minute. Once set,
administered drugs have no effect on the resulting heart rate, but continue to influence other
components of the physiologic models. For example, administering epinephrine after setting the
Fixed heart rate to 70 bpm results in an increased blood pressure (due to increased SVR) while
holding the heart rate at 70 bpm.

Fixed heart rate can be set between 31 and 275 bpm, with a setting of —1 returning control of the
underlying heart rate to the physiologic models.

NOTE: Settings between -1 and 31 cause an indeterminate result and are not
recommended.

Heart Rate Factor

Value: 0.3 to 3 (no units) Default 1

Onset: 0 to 60 seconds

0 to 60 minutes Default 0 minutes

Typically the heart rate is determined automatically by the physiologic models, which account for
pharmacologic interventions and changes in patient physiology. The Heart Rate Factor
parameter is used to change the heart rate (HR) before baroreceptor, other physiological controls,
and drug influences are taken into account. A value of 2 doubles the baseline HR. A value of 0.5
decreases the baseline HR by 50%. Note that the baroreceptor and other physiologic controls
heavily influence the resulting HR. Thus, the observed HR may differ significantly from the set
baseline HR. The Heart Rate Factor parameter can be used to configure a patient with an
altered baseline HR. It is also used to create acute changes in HR during a scenario.

5.63



Tabs rBa bYSI M

Heart Sounds

Value: Normal (Default)
S3
S4
33 and S4
Early Systolic Murmur
Mid Systolic Murmur

Late Systolic Murmur
Holosystolic Murmur
Late Diastolic Murmur

Normal and abnormal heart sounds are selected using this parameter. Sounds are synchronized

with the cardiac cycle. The volume control slider is used to increase or decrease the heart sound
volume.

Pericardial Fluid (Acute)

Value: 0 to 20 ml Default 0 ml

- ' Onset: 0 to 60 seconds

~\

Pericardial Fluid (Acute) is used to simulate the amount of fluid within the pericardial sac. This
parameter may be used to simulate the infant with a cardiac tamponade.

0 to 60 minutes Default 0 minutes
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Resistance Factor: Aortic Valve

+ factor Value: 1 to 1000 (no units) Default 1
Onset: 0 to 60 seconds
e 0 to 60 minutes Default 0 minutes
ABPy C.O. ¥

This parameter adjusts the resistance to blood flow across the aortic valve. The default value of
1 corresponds to the baseline aortic valve resistance of the selected patient; a value of 2
doubles the resistance. This parameter is used to create the hemodynamic effects of a reduced
aortic valve area, as in the case of aortic stenosis.

Resistance Factor: Mitral Valve

1‘*. factor Value: 1 to 1000 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

F‘JIE'ILF“Il C.O.+

This parameter adjusts the resistance to blood flow across the mitral valve. The default value of
1 corresponds to the baseline mitral valve resistance of the selected patient; a value of 2 doubles
the resistance. This parameter is used to create the hemodynamic effects of a reduced mitral
valve area, as in the case of mitral stenosis.

Resistance Factor: Pulmonic Valve

Value: 1 to 1000 (no units) Default 1

& 4 Factor
PAPt Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

This parameter adjusts the resistance to blood flow across the pulmonic valve. The pulmonic
valve parameter is used to create the hemodynamic effects of a reduced pulmonic valve area, as
in the case of pulmonic stenosis. Setting this parameter to a high value creates the hemodynamic
effects of a large gas embolus causing an air-lock in the right ventricular outflow track.
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Pulses

Choosing Pulses in the Show menu displays the options for the Brachial and Femoral pulses,
the two pulses palpable on the BabySIM mannequin.

" Simulation Scenario Condition Drugs Fluids | Cardiovascular | Respiratory |

Show: | Pulses B Select the Brachial or Femoral pulse.

Pulses

‘a Brachial

= : Femoral

1 Select the pulse location.

Brachial Pulse Deficit

®) Both O Left () Right

30 mmHg

Turn pulses On or Off.

= o lil Vi 300 Reset the pUlSe threshold.

30

mmHg 4
—Set—

Pulses

Pulses that are On are palpable at their respective locations when the systolic blood pressure is
above the pulse deficit threshold. Selecting Off disables the pulse.

Since the default deficit is 30 mmHg the Brachial or Femoral pulse is palpable if the systolic
blood pressure is above 30 mmHg and the On option has been selected. If the systolic blood
pressure falls below 30 mmHg, the pulse “drops out” and is no longer palpable.

Palpable Pulse Thresholds

Location Systolic Pressure Threshold

Brachial 30 mmHg

Femoral 30 mmHg
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Systemic

Choosing Systemic in the Show menu displays those parameters used to affect the patient’s
systemic vascular system. Systemic parameter values are controlled using numerical settings.

Baroceptor Gain (Overall) Factor

Value: 0 to 100 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The baroreceptor control section of the physiological models automatically and dynamically
controls the simulated patient’s heart rate, contractility, systemic vascular resistance, and venous
capacity. The baroreceptor gain factor is a feedback multiplier that determines how vigorously
the patient responds to changes in mean arterial pressure (MAP). A value of less than 1.0
corresponds to baroreceptor depression (i.e. less heart rate response to changes in MAP). A
value greater than 1.0 leads to a stronger response to MAP changes.

Baroceptor Gain (Peripheral) Factor

Value: 0 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

This parameter selectively adjusts the influence of mean arterial pressure (MAP) on the
peripheral effectors (systemic vascular resistance and venous capacity). A factor of less than 1
corresponds to baroreflex depression (e.g. less systemic vascular resistance response to MAP
changes). A value greater than 1 leads to a stronger response to MAP changes. The effect of this
factor and the Baroreceptor Gain (Overall) Factor is multiplicative.
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Baroceptor Maximum Pressure

Value: 60 to 220 mmHg

Onset: 0 to 60 seconds

0 to 60 minutes

Default 120 mmHg

Default 0 minutes

The baroreceptor control mechanism attempts to maintain the mean arterial pressure (MAP) at a

value halfway between the baroreceptor minimum pressure and baroreceptor maximum
pressure. It does so primarily by influencing the heart rate, but also by influencing the myocardial
contractility and arterial and venous vascular tone. The two parameters (minimum and maximum)
must be adjusted together in order for the baroreceptor reset to be recognized by the software.
Setting only the minimum or maximum pressure will not reset the baroreceptor response.

Baroreceptor maximum pressure defines the MAP at which [P

the baroreceptor inhibitory activity on heart rate is maximal.
Further increases in MAP above this value do not result in
further increases in baroreceptor activity. Decreases in MAP
below the baroreceptor maximum pressure cause proportional A
decreases in baroreceptor inhibitory activity on heart rate.

1

Bavorecephor

Presoure

Seanario Progravmabls Bavavecaptor Asivation
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Baroceptor Minimum Pressure

Value: 40 to 160 mmHg Default 80 mmHg

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The baroreceptor control mechanism attempts to maintain the mean arterial pressure (MAP) at a
value halfway between the baroreceptor minimum pressure and baroreceptor maximum
pressure. It does so primarily by influencing the heart rate, but also by influencing the myocardial
contractility and arterial and venous vascular tone. The two parameters (minimum and maximum)
must be adjusted together in order for the baroreceptor reset to be recognized by the software.
Setting only the minimum or maximum pressure will not reset the baroreceptor.

Baroreceptor minimum pressure defines the MAP at which the [Pieee

baroreceptor inhibitory activity on heart rate is minimal. ' Barorcegior

Further decreases in MAP below this value do not result in Pee | o
further decreases in baroreceptor activity. Increases in MAP ! P "
above the baroreceptor minimum pressure cause proportional . Fuessure
increases in baroreceptor inhibitory activity on heart rate. Scenario Programmable Bvorscapor Adivation

Elastance: Extrathoracic Arteries

fus 4 value Value: 0.1 to 10 (mmHg/ml)  Default 3.02

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

pulse
pressure

ABPt

This parameter adjusts the elastance of the extrathoracic arteries. By altering the arterial
elastance one can vary the systemic pulse pressure. Increasing the elastance value results in a
wider pulse pressure. The systemic systolic and diastolic pressures should both increase and the
pulse pressure will be greater.

This parameter should be altered in conjunction with the Elastance: Intrathoracic Arteries.
Generally, both parameters should be altered in the same direction, i.e. both parameters should
either be increased or decreased.
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Elastance: Intrathoracic Arteries

Sz 4 vualue Value: 0.1to 10 (mmHg/ml)  Default 7.76

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

pulse
pressure

ABPt

This parameter adjusts the elastance of the intrathoracic arteries. By altering the arterial
elastance one can vary the systemic pulse pressure. Increasing the elastance value results in a

wider pulse pressure. The systemic systolic and diastolic pressures should both increase and the
pulse pressure will be greater.

This parameter should be altered in conjunction with the Elastance: Extrathoracic Arteries.
Generally, both parameters should be altered in the same direction, i.e. both parameters should
either be increased or decreased.

Elastance: Pulmonary Arteries

}yalue Value: 0.1 to 5 (mmHg/ml) Default 1.27
(NEE
HEEEL ref Onset: 0 to 60 seconds
PA P | 0 to 60 minutes Default 0 minutes

This parameter adjusts the elastance of the pulmonary arteries. By altering the arterial elastance
one can vary the pulmonary pulse pressure. Increasing the elastance value results in a wider
pulse pressure. The pulmonary systolic and diastolic pressures should both increase and the
pulse pressure will be greater.
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Y

i

f

fFactor

PAP t

Value: 0.1 to 10 (no units)

Onset: 0 to 60 seconds

0 to 60 minutes

The Cardiovascular Tab

Default 1

Default 0 minutes

This parameter adjusts the baseline (before baroreceptor and drug influences are taken into
account) pulmonary vascular resistance (PVR). A value of 2 doubles the baseline PVR. A value of
0.5 decreases PVR by 50%. This parameter can be used to configure a patient with an altered
baseline PVR or to create acute changes in PVR during a scenario.

Resistance Factor: Systemic Vasculature

.-'"jl.ll:-u

& 4 Factor

Value: 0.1 to 10 (no units)

Onset: 0 to 60 seconds
0 to 60 minutes

Default 1

Default 0 minutes

This parameter adjusts the baseline (before baroreceptor and drug influences are taken into
account) systemic vascular resistance (SVR). A value of 2 doubles the baseline SVR. A value of
0.5 decreases SVR by 50%. This parameter can be used to configure a patient with altered
baseline SVR such as the infant with hypertension or in septic shock. The parameter can also be
used to create acute changes in SVR during a scenario.
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Resistance Factor: Venous Return

. Value: 0.1 to 100 (no units Default 1
A8 § Factor ( )

FAF' I' Onset: 0 to 60 seconds
C.O.4 0 to 60 minutes Default 0 minutes

CVP}

This parameter adjusts the resistance between the extrathoracic and intrathoracic venous
compartments. The default value of 1 corresponds to the baseline venous return resistance of
the selected patient. A value of 2 doubles the resistance; a value of 0.5 reduces the resistance
by 50%. This parameter is used to cause impeded venous return to the right heart. Clinical

examples include increased intra-abdominal pressure, venous gas embolism, and valsalva
maneuver.

Venous Capacity Factor

Value: 0.1 to 10 (no units) Default 1

Onset: 0 to 60 seconds

0 to 60 minutes Default 0 minutes

This parameter adjusts the volume of blood that can be contained in the unstretched venous
system without an increase in venous pressure. Additional volume greater than the set venous
capacity causes distension of, and therefore, increased pressure within the venous system. A
value of 2 doubles the capacity of the venous system (i.e. causing venous “pooling”); a value of

0.5 reduces the capacity of the venous system by 50% (e.g. following administration of a
venoconstrictor).
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The Respiratory Tab

Selecting the Respiratory tab opens a window providing a means of changing parameter
settings that control patient conditions related to the respiratory system. Airway is selected by
default in the Show menu, which also contains options for Lung and Respiratory Control. These
two options also display a Parameters panel and a panel with the settings for those parameters.
At the bottom of the Lung and Respiratory Control windows is a Description of the selected

parameter.

[ =
- Simulation

Cardiovascu

Sho — | organized under Airway, Lung
Lung | and Respiratory Control
Respiratory Control .

| Laryngospasm headlngS

—~ : ’
[_ Bronchial Occlusion

Respiratory parameters are

The Respiratory Tab

The Show menu contains three sub-sections, each with its own set of parameters.

Laryngospasm

Bronchial Occlusion

PEEP

Respiratory Parameters

Respiratory Control

COy Production Factor

CO5 Setpoint

Fixed Neuromuscular Blockade

| to E Ratio (1: X)
05 Consumption

Respiratory Gain Factor

Respiratory Quotient

Respiratory Rate Factor

Respiratory Rate Override

Shunt Fraction

Tidal Volume Factor

Tidal Volume Override

Volume/Rate Control Factor
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Airway

The Airway parameters are selected by clicking the corresponding radio button.

Laryngospasm

The Laryngospasm parameter can be turned On or Off using the radio buttons in the bottom

panel. The default setting is Off.

Bronchial Occlusion

Selecting Bronchial Occlusion displays radio buttons for Occluded or Unoccluded.

—~ ~ o
e Both (O Left (_ Right
Resistance Onset
Minutes
0.6941 9
(_) Seconds
cmH20/Ipm
@ Unoccluded 100.0000 0
C Occluded = =
0.6941 = 0
cmH20/lpm E minutes
= f \
0.1000 ] Set

Bronchial Occlusion Settings

Selecting Occluded creates a 100% obstruction of the left and/or right mainstem bronchi and
makes ventilation through the obstruction impossible. Setting the parameter to Unoccluded
restores the mainstem bronchi to the flow resistance prior to occlusion. The rate of this resistance
can be controlled using the Resistance and Onset settings. The default setting is Unoccluded
in Both lungs at a rate of 0.6941 cmH50/lpm.

PEEP

The PEEP parameter specifies the amount of positive end expiratory pressure applied during
mechanical ventilation. Setting this parameter results in clinically appropriate intrathoracic
pressures and hemodynamic responses.

Positive End Expiratory Pressure (PEEP)
Value

5.00 cmH20

BT W o 1 o o P P b o o ot o fent Y 4

5.00

cmH20

" s
N

PEEP Settings

When applying a PEEP valve to a patient circuit (i.e. a ventilator), set the PEEP value within the
software to get a true clinical response. The default setting is 0 cm HyO.
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Lung

Adjusting the Lung parameters affects the manner in which the patient’s lungs function. Lung
parameter values are controlled using either numerical or discrete settings, depending on the
parameter.

Breath Sounds

Value: Normal (Default)
Biphasic Wheeze
Bronchovesicular
Crackles
Prolongation
Rhonchi
Stridor
Wheeze

Normal and abnormal breath sounds are selected using this parameter. Breath sounds are
independently synchronized with ventilation of the left and right lungs. The volume control slider
is used to increase or decrease the breath sound volume.

Chest Wall Compliance Factor

Value: 0.15 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

This parameter describes the interaction of the chest wall with the lungs. The chest wall
compliance parameter defines the volume-pressure relationship in the normal operating lung
volumes. Once distended, however, the chest wall rapidly becomes much less compliant (i.e.
much “stiffer”) and resistant to further inflation.
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Fraction of Inspired Oxygen Override

Value: -1to 100% Default -1

This parameter is used to simulate changes in the Fraction of Inspired Oxygen (FiO»), such as
would occur with the administration of supplemental oxygen.

Fraction of Inspired Oo Override can be used in the following contexts:
Settings greater than 21% simulate the administration of supplemental oxygen.

Settings less than 21% simulate hypoxic conditions.

When set to -1, the FiOy defaults to the ambient concentration of oxygen in room air,
about 21%.

Functional Residual Capacity

Value: 50 to 300 ml Default 200 ml

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

Sets the total (combined left and right) lung volume remaining at the end of a
normal, spontaneous, tidal volume. The minimum FRC with the baby mannequin is 50 ml.
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Intrapleural Volume (Left)
Intrapleural Volume (Right)

Value: 0to 100 ml Default 0 ml
Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

Normally, the visceral and parietal pleural surfaces are closely approximated with virtually no
volume in between. The intrapleural volume parameters allow intrapleural volume to accumulate,
for example, as happens during pneumothorax, hydrothorax, or hemothorax. Accumulation of a
“displacing” volume in the intrapleural space causes compression of the lung tissue because
both lung tissue and intrapleural volume are contained within the chest wall. Thus, attempts to
inflate the compressed lung are prevented by the relative indistensibility of the chest wall at
higher lung volumes.

Lung Compliance Factor (Left)
Lung Compliance Factor (Right)

Value: 0.15 to 10 (no units) Default 1

Onset: 0 to 60 seconds

0 to 60 minutes Default 0 minutes

iy

These two parameters independently set the left and right lung compliance, respectively. With the
Lung Compliance Factor set at 1, the resulting baseline compliance (combined lung and chest
wall) is approximately 8 ml/cmH,O. The lung compliance factors can be used to configure a
patient with altered baseline lung compliance or to create acute changes during a scenario. For
example, a patient who develops a “rigid chest” following administration of fentanyl. Low
compliance factors (less than 1) create “stiff” lungs. High compliance factors (greater than 1)
create “loose” lungs that easily inflate.
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Value: -0.51t0 0.5 (no units) Default 0

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

This parameter is used to create a metabolic acidosis or metabolic alkalosis under script control.
Respiratory acidosis and respiratory alkalosis are simulated in real-time depending on the
alveolar concentration of COo.

Please note that changes in pH may alter the shape of the standard oxyhemoglobin dissociation
curve as described below:

As acidity increases (pH decreases), the affinity of hemoglobin for oxygen decreases, and
oxygen dissociates more readily from hemoglobin. In other words, increasing acidity
enhances the unloading of oxygen from hemoglobin.

When pH decreases, the entire oxyhemoglobin dissociation curve shifts to the right, a
change termed the Bohr effect. By contrast, elevated pH increases the affinity of
hemoglobin for oxygen and shifts the dissociation curve to the left.

Seesaw Breathing

Value: On
Off (Default)

During normal spontaneous infant breathing, the chest rises and the abdomen follows with only
a brief lag. In seesaw or “paradoxical respiration,” the abdominal wall moves inward during
inspiration and rises during expiration. It is observed as a sign of upper airway obstruction or less
frequently can be a sign of decreased compliance (pneumonia, pulmonary) or elevated resistance
(asthma). When On is selected the mannequin will exhibit a seesaw pattern of respiration (chest
retraction with abdominal distension) such as seen with respiratory distress and impending
respiratory failure in the infant.
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Venous Carbon Dioxide Shift

Value: 0 to 60 mmHg Default 0 mmHg
PvCO2]
A Onset: 0 to 60 seconds
s 0 to 60 minutes Default 0 minutes
- A

The partial pressure of CO» in the venous blood is affected with this parameter. Changing this
parameter allows large and rapid shifts in total body CO, concentration. Increases in alveolar and
arterial CO» follow rapidly in a physiologically correct magnitude and time course.
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Respiratory Control

Respiratory Control parameters affect the patient’s respiratory drive. Respiratory Control
parameter values are controlled using numerical or discrete settings.

Carbon Dioxide Production Factor

Value: 0.5 to 5.0 (no units) Default 1.0
I factor
PAES PaCO2t Onset: 0 to 60 seconds
W 0 to 60 minutes Default 0 minutes
oL

This parameter allows for the manipulation of metabolic CO5 production to simulate a variety of
(patho)physiological conditions. When set to the default value of 1, CO5 production is determined
by the Op Consumption and Respiratory Quotient settings. A value of 2 doubles the CO»
production. A value of 0.5 decreases the CO5 production by 50%. Note that the control of
breathing to maintain arterial carbon dioxide tension and prevent hypoxemia along with other
physiologic controls heavily influence the resulting PaCO».

When set from 2 to 3, this parameter can be used to simulate the rate of rise of PaCO5 for an
apneic anesthetized patient.

Carbon Dioxide Setpoint

. Value: 20 to 70 mmHg Default 40 mmHg
} setpoint
RS PaCO2t Onset: 0 to 60 seconds
WA 0 to 60 minutes Default 0 minutes
- A

This parameter is a setpoint for PaCO». The control-of-breathing model adjusts tidal volume and
respiratory rate in order to bring the PaCO», towards this setpoint. Factors that influence the
“success” of this control effort include baseline tidal volume, baseline respiratory rate,
respiratory gain, Oo consumption, respiratory quotient, lung compliances, chest wall compliance,
bronchial resistances, the presence of artificial airways in the mannequin, and the inspired gas
mixture. Many of these factors can be adjusted by selecting the specific parameter under the
Lung or Respiratory Control section of the Respiratory tab.
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Fixed Neuromuscular Blockade

-.# Value: -1, 0to 100% Default -1 (model driven)
uscular

ckade

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes
\ -~

The degree of neuromuscular blockade is determined automatically by the pharmacokinetic and
pharmacodynamic models based on the neuromuscular blocking agents administered and the
time course of their injection. For some educational applications, however, the instructor may
wish to set a fixed degree of neuromuscular blockade that remains stable for an indefinite
period of time. This can be accomplished using the Fixed Neuromuscular Blockade
parameter. The default value of —1 instructs the pharmacologic models to determine the degree
of neuromuscular blockade based upon the drugs injected and their pharmacologic properties.

When any other positive value is assigned to this parameter, the degree of neuromuscular
blockade is set to that level. For example, Fixed Neuromuscular Blockade 80 causes the
simulator to set the degree of neuromuscular blockade to 80%, regardless of the presence (or
absence) of neuromuscular blocking drugs. Clinically, the spontaneous tidal volume is markedly
reduced.

I to E Ratio (1:x)

Value: 0.5 to 7 (no units) Default 2

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

This parameter sets the inspiratory-expiratory (I:E) ratio for spontaneous ventilation.
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Oxygen Consumption

PetC0O21 Value: 0 to 300 ml/min Default 80 ml/min
7 PaCO2t

Al 0 to 60 minutes Default 0 minutes

T Eng.d.lmmmnfl"

Onset: 0 to 60 seconds

This parameter is used to change the rate of consumption of oxygen and production of carbon
dioxide. Also see Respiratory Quotient.

Respiratory Gain Factor

Value: 0 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The respiratory control section of the physiological model automatically and dynamically controls
the simulated patient’s tidal volume and respiratory rate to maintain a normal arterial carbon
dioxide tension and to prevent arterial hypoxemia.

Respiratory Quotient

Value: 0.7 to 1.2 (no units) Default 0.95
. PaCO2t Onset: 0 to 60 seconds
¥ | 0 to 60 minutes Default 0 minutes
- A

Respiratory quotient is the rate of carbon dioxide production divided by the rate of oxygen
consumption. Changes to the Respiratory Quotient parameter alter the rate of carbon dioxide
production relative to the rate of oxygen consumption. Also see Oxygen Consumption.
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Respiratory Rate Factor

Value: 0.1 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The underlying tidal volume (TV) and respiratory rate (RR) for the respiratory section of the
physiological model are 80 ml and 40 breaths/minute, respectively. The Tidal Volume Factor and
Respiratory Rate Factor parameters are used to change these baselines before the control of
breathing and drug influences are taken into account. A value of 2 doubles the baseline TV or RR.
A value of 0.5 decreases the baseline TV or RR by 50%. Note that the control of breathing to
maintain arterial carbon dioxide tension and prevent hypoxemia and other physiologic controls
heavily influence the resulting TV and RR. Thus, the observed TV and RR may differ significantly
from the baseline TV and RR. The Tidal Volume Factor and Respiratory Rate Factor
parameters can be used to configure a patient with altered breathing pattern such as the
tachypneic patient in heart failure. These are also used to create acute changes in TV and RR
during a scenario.

Note that unless the Respiratory Gain Factor is decreased, changes in Tidal Volume Factor
and Respiratory Rate Factor will be somewhat offset or minimized by the respiratory control
mechanism as they attempt to maintain a normal PaCO».
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Respiratory Rate Override

Value: -1.0 to 80 (breaths/min) Default -1 (model driven)

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The underlying tidal volume (TV) and respiratory rate (RR) for the respiratory section of the
physiological model are 80 ml and 40 breaths/minute, respectively. The Respiratory Rate Override
parameter is used to set the respiratory rate to a given number of breaths-per-minute. Once set,
arterial oxygen and carbon dioxide values have no effect on the resulting respiratory rate, but
continue to influence other components of the physiological models. For example, with
the respiratory rate override set to 60 breaths/minute this will result in a fixed respiratory
rate, regardless of arterial oxygen or carbon dioxide levels. However, the respiratory control
mechanism will adjust the tidal volume in an attempt to maintain normal PaCO5 levels.

Respiratory rate override can be set between 1 and 80 breaths/min, with a setting of -1
returning control of the underlying respiratory rate to the physiological models.

Shunt Fraction

Y fraction Value: 0 to 0.5 (no units) Default 0.01

Onset: 0 to 60 seconds

0 to 60 minutes Default 0 minutes

}Pa2

This parameter is used to create oxyhemoglobin desaturation in a variety of clinical contexts. The
physiologic model uses the Shunt Fraction parameter to determine what portion of blood
passes through the pulmonary shunt circulation (i.e. does not exchange oxygen, carbon dioxide,
and anesthetic gases with the alveolar gas). Typically, values of 0.10 to 0.40 are needed to
create large alveolar-arterial oxygen gradients sufficient to cause arterial hypoxemia.
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Tidal Volume Factor

Value: 0.1 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The underlying tidal volume (TV) and respiratory rate (RR) for the respiratory section of the
physiological model are 80 ml and 40 breaths/minute, respectively. The Tidal Volume Factor and
Respiratory Rate Factor parameters are used to change these baselines before the control of
breathing and drug influences are taken into account. A value of 2 doubles the baseline TV or RR.
A value of 0.5 decreases the baseline TV or RR by 50%. Note that the control of breathing to
maintain arterial carbon dioxide tension and prevent hypoxemia and other physiologic controls
heavily influence the resulting TV and RR. Thus, the observed TV and RR may differ significantly
from the baseline TV and RR. The Tidal Volume Factor and Respiratory Rate Factor
parameters can be used to configure a patient with altered breathing pattern such as the
tachypneic patient in heart failure. These are also used to create acute changes in TV and RR
during a scenario.

Note that unless the Respiratory Gain Factor is decreased, changes in Tidal Volume Factor
and Respiratory Rate Factor will be somewhat offset or minimized by the respiratory control
mechanism as they attempt to maintain a normal PaCO».
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Tidal Volume Override

Value: -1 to 400 ml Default -1 (model driven)

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

The underlying tidal volume (TV) and respiratory rate (RR) for the respiratory section of the
physiological model are 80 ml and 40 breaths/minute, respectively. The Tidal Volume Override
parameter is used to set the tidal volume to a given volume per breath. Once set, arterial oxygen
and carbon dioxide values have no effect on the resulting tidal volume, but continue to influence
other components of the physiological models. For example, with the tidal volume override set
to 100 ml this will result in a fixed tidal volume, regardless of arterial oxygen or carbon dioxide
levels. However, the respiratory control mechanism will adjust the respiratory rate in an attempt
to maintain normal PaCO, levels.

Tidal volume override can be set to a maximum of 400 ml, with a setting of -1 returning control
of the underlying respiratory rate to the physiological models.

Volume/Rate Control Factor

Value: 0.1 to 10 (no units) Default 1

Onset: 0 to 60 seconds
0 to 60 minutes Default 0 minutes

Ventilatory responses to increased arterial carbon dioxide or decreased arterial oxygen may take
the form of increased tidal volume, increased respiratory rate, or both. The Volume/Rate Control
Factor determines these relative changes. At a value of 1, increased and decreased ventilatory
drive affect tidal volume and respiratory rate equally. When Volume/Rate Control Factor is
greater than 1, increased or decreased minute ventilation is predominantly achieved by changes
in tidal volume. When the Volume/Rate Control Factor is less than 1, ventilation changes are
affected primarily by changes in respiratory rate.
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Once the BabySIM system is operational and the software has loaded, changes to the patient’s
physiology manifested in the mannequin and on the waveform display are controlled using the
software accessed on the Patient window.

Defining Patient Profiles

An unlimited number of unique patient profiles are possible for the BabySIM. Baby Ryan, the
preconfigured patient, represents a healthy male infant and provides a baseline for modified or
customized patients.

Baby Ryan™

Name, Age, and Gender Ryan, 6-month-old male

History of Present lliness Healthy infant

None

39-week gestation, uncomplicated vaginal delivery; APGAR 9/9
No perinatal complications. Infant went home on day of life 1.
No known drug allergies.

Past Medical History

Past Surgical/Anesthetic History [N\

Current Medications Vitamins with iron

Family History Not contributory

Immunizations: Hep B, DTaP, IPV, HIB, pneumococcal up-to-date
Social History Diet: Maternal breast milk, rice cereal
Other: Lives with parents, Stan D. and Stannette Ardman and a 6-year-old sibling

Eating well, no fevers

Negative for seizure

No history of heart murmur, no diaphoresis with meals
No cough, wheeze, or noisy breathing

No vomiting, constipation, diarrhea, or jaundice

No rash

Review of Symptoms

General: Healthy appearing, well nourished, alert, and active infant,
nondistressed

Weight, Height: 8 kg (50%ile), length 66 cm (30%ile),
head circumference 38 cm (50%ile)

Vital Signs: Heart Rate 129 beats per minute, Blood Pressure 86/45 mmHg,
Respiratory Rate 40 breaths per minute, SpOo 98%

HEENT: Anterior fontanel soft and flat, anicteric sclera, normal red reflex,
no strabismus, tympanic membranes normal, palate intact
Airway: Normal infant, mandible normal
Physical Examination Lungs: Comfortable.breathing, clear bilaterally to auscultation,
and percussion
CV: S1 normal, S splits normally. No murmur or adventitious
sounds. Pulses normal and equal in both upper and lower
extremities
Abdomen: Soft, nondistended, liver edge at right costal margin, spleen
nonpalpable, bowel sounds normoactive
GU: Testes bilaterally descended
Neuro: PERRL, normal deep tendon reflexes, strength, and tone
Developmental: Rolls over, sits up alone, reaches for objects, recognizes
strangers
Laboratory, Radiology, and Hemoglobin: 12.24g/dL
Other Relevant Studies Hematocrit: 36%
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Developing a New Patient

Patients are created either by modifying an existing patient or by clicking the New icon on the
Patient Palette and selecting the Untitled Baby Patient option (see Creating a New Patient in
the Software Basics section of this User Guide).

When a new patient is created, the Patient window appears without information regarding the
new baby patient’s name, history or photograph. However, the initial underlying physiology of the
new baby patient is that of Baby Ryan, the healthy, preconfigured patient.

800 Untitled Baby Patient (1) @ localhost (=)
00 = 00:03:35 MEH R
Save Step Llogs Detach Tab Recorder Patient Time Connections
ﬁ MAP c.0o. Simulation Scenarie Cenditien Drugs Fluids Cardiovascular Respiratory
66 1.6 / Drag a picture file to the Image box and drop in
ABP CVP PAP
e the new photo.
83/53 0 14/4 i

Untitled Baby Patient
Het E Name, Age, and Gender:
98 “‘w History of Present lliness:
Past Medical History:

Left Vol. Spom \"13| Right Vol.

119 119 Past Surgical/Anesthetic History:
PAQ2 Spom AR PACO2 Review of Systems:
108.6 38.3 R
urrent Medications: . . . .
Pa02 PaCc02 Edit the history by clicking to place the cursor
98.8 745 39.3 Physica Examinaton: and using standard editing tools to add, delete,
m - VS and format text.
fmqasy: U
Heart:

The HUD initially displays the
physiology of a healthy infant.

| TJULT T.U gTr.U

Laboratory, Radiology, and other relevant studies:
HCT.

Narrative:

The Untitled Baby Patient Window

To complete the patient, new information needs to be added and the physiology changed.
Adding a Photograph

If desired, load a picture file (e.g. TIFF, JPEG, GIF) onto the laptop, select the file from the
desktop, drag the file to the Image box to the left of the patient’s name, and release the file. The
new picture appears in the Image box, replacing the text, “No Image Available.”
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Completing the Patient History

To create the patient’s history, click the mouse in the appropriate spot on the history field and
enter the desired text. The standard Cut, Copy, Paste and Clear functions are available via the
Edit menu when text is highlighted. Text formatting (i.e. Bold, Underline, Italics) is available via
the Format menu.

To remove the entire history, click anywhere in the text and choose the Select All option from the
Edit menu before pressing the Delete key. New text can be entered on the blank page.

Any changes to the history must be saved to have them for future reference.
Changing the Patient’s Physiology

A patient’s physiology is changed by adjusting the parameters available beneath the various tabs
located on the Patient window.

To create a new physiology for the patient:

1. Select the appropriate tab (e.g. Cardiovascular tab, Respiratory tab).

2. Select, when available, the appropriate tab sub-category (from the Show pull-down menu).
3. Choose the desired parameter (e.g. Heart Rate Factor, Breath Sounds).

4. Change the values of the selected parameter.
5

. Allow the patient’s vital signs to stabilize. Cardiovascular changes usually equilibrate
rapidly whereas respiratory changes may take several minutes to stabilize.

6. Save (when desired) the new patient.

New patients are saved using the Save icon on the Patient window or the Save option located
on the File menu. For more information on saving patient files, see Saving Patient Files found
in Software Basics section of this User Guide.

Details regarding the various parameters are located in the Tabs section of this User Guide.
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Altering an Existing Patient

Any existing patient, either Baby Ryan or a previously saved user-defined patient, can be
changed to display a different name, background or physiology.

The original file for Baby Ryan cannot be overwritten, so a new file name must be created for
edited versions of this preconfigured patient. Unless permanently modifying a user-defined
patient file, any changes to a user-defined patient should be saved using the Save As option
under the File menu. All changes must be saved to preserve the patient file for future use.

Editing the Patient History

To edit the patient’s history, highlight and type over the existing text. The standard Cut, Copy,
Paste and Clear functions are available via the Edit menu when text is highlighted. Text
formatting (i.e. Bold, Underline, Italics) is available via the Format menu. To remove the entire
history, click anywhere in the text and choose the Select All option from the Edit menu before
pressing the Delete key. New text can be entered on the blank page.

Any changes to the history must be saved to have them for future reference.
Changing the Patient’s Physiology

A patient’s physiology is changed by adjusting the parameters available beneath the various tabs
located on the Patient window.

To edit an existing patient:

1. Select the appropriate tab (e.g. Cardiovascular tab, Respiratory tab).
. Select, when available, the appropriate tab sub-category (from the Show pull-down menu).

2
3. Choose the desired parameter (e.g. Heart Rate Factor, Breath Sounds).
4. Change the values of the selected parameter.

5

. Allow the patient’s vital signs to stabilize. Cardiovascular changes usually equilibrate
rapidly whereas respiratory changes may take several minutes to stabilize.

6. Save (when desired) the modified patient.

For more information on saving patient files, see Saving Patient Files found in Software Basics
section of this User Guide. Details regarding the various parameters are located in the Tabs
section of this User Guide.
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Employing Clinical Features

The method of producing a specific clinical situation may involve the mannequin, the software,
or both. Likewise, user interventions can take place with the mannequin, the software, or with a
combination of the two. Below is a breakdown of the various clinical features and how they are
utilized.

Airway Management
The mannequin’s anatomically realistic upper airway provides for the opportunity to intubate the

infant patient, while various clinical signs (i.e. breath sounds, chest excursion, airway patency)
can be simulated using software commands.

Airway Management

Anatomy, Physiology,

Software Control Manual Control

and Clinical Signs

None required. None required.
Realistic Upper Airway
(Oropharynx,
Nasopharynx,and Larynx)

Esophagus, Lower None required. None required.
Esophageal Sphincter,
and Stomach

TAB: Respiratory None required.

SHOW: Airway

RADIO BUTTON: Laryngospasm
SRR 574

Laryngospasm

TAB: Respiratory None required.
SHOW: Airway

Bronchial Occlusion RADIO BUTTON: Bronchial
Occlusion

Seepagera]

None required, but volume can None required.
be adjusted.

TAB: Condition

SHOW: Assessment

| .PARAMETER: Baby Sounds
hSee page 5.40 1

None required, but volume can Set channels and

be adjusted. adjust the volume on
TAB: Condition the wireless

SHOW: Assessment microphone.
PARAMETER: Microphone
Vel

"See page 5.45"

Baby Sounds

Phonation and Patient
Voice

Most sounds (i.e. Breath Sounds and Baby Sounds) are controlled through the software, but a
wireless microphone is available to provide additional phonation or a voice from the patient. To
use the wireless microphone, attach the transmitter to a belt or pocket and snap the microphone
to a lapel or shirt pocket.

Verify that the two antennas located behind the wireless receiver on the PCU are extended and
that the transmitter has been set to the same channel as the receiver on the PCU.

Switch the receiver and the microphone to the ON position.
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Pulmonary System

The mannequin’s lungs produce carbon dioxide and react realistically to intubation as well as to
pathophysiologic states. The patient’s upper chest rises and falls synchronously with the
inflationary state of the underlying lungs.

Pulmonary System

Anatomy, P hysn_ology, Software Control Manual Control
and Clinical Signs

None required, but adjustable. | None required.
TAB: Respiratory

Spontaneous, Self- SHOW: Respiratory Control

Regulating Breathing

None required.

CO» source required.

Exhaled COo

None required, but adjustable. | None required.

Symmetric and TAB: Respiratory
Asymmetric Lung SHOW: Lung and/or Airway

Ventilation

None required. None required.

Chest Excursion

None required, but adjustable. | None required.
TAB: Respiratory
Breath Sounds SHOW: Lung

See pages 5.79

None required, but adjustable. | None required.
TAB: Respiratory

Pulse Oximetry SHOW: Respiratory Control
PARAMETER: Shunt Fraction
Béepage

None required, but adjustable. | None required.
TAB: Respiratory

. SHOW: Lung and/or
Arterial Blood Gases Respiratory Control
tiple
0 5.86:

None required, but adjustable. | None required.
TAB: Respiratory

SHOW: Lung and/or
Venous Blood Gases Respiratory Control
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Cardiovascular System

The mannequin produces realistic heart sounds and a wide range of pathophysiologic conditions
synchronized to the QRS complex of the ECG and audible to a standard stethoscope.

Cardiovascular System

Anatomy, P hysn_ology, Software Control Manual Control
and Clinical Signs

None required, but specific None required.

sounds can be selected.

TAB: Cardiovascular

Heart Sounds SHOW: Heart
PARAMETER: Heart Sounds

L]

L .9.5. -

None required, but specific None required.

rhythms can be selected.

TAB: Cardiovascular

3-Lead ECG SHOW: Heart

PARAMETER: Cardiac Rhythm

Querride . . .

See page 5.611

None required, but adjustable. None required.
TAB: Cardiovascular
SHOW, Pulses,
Palpable Pulses 1See page 5.661

None required. See Manual Blood
Pressure for using
Manual Blood Pressure the modified blood
Lrressure cuff,
ppage 6.9
None required, but adjustable. None required.
. . TAB: Cardiovascular
Invasive Hemodynamic SHOW: Catheters
Monitoring P&R-AM-EIERSI A-LL
%ée pages 5.56 10 5.57":
None required, but adjustable. None required.
TAB: Cardiovascular
SHOW: Heart
PARAMETER: Baroreceptor
Ga_in ((_:a_rdiac Factor
Baroreceptor Reflex \See page 5.801
SHOW: Systemic
PARAMETER: All Baroceptor
Selections
pages 557 o553 |
None required, but adjustable. None required.

TAB: Fluids

Circulation TAB: Cardiovascular
SHOW: Heart
PARAMETER: All Contractility
Selections
156e bage 5.5
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Palpable Pulse Thresholds

A pulse deficit automatically occurs when the systolic arterial blood pressure falls below the
following thresholds:

Palpable Pulse Thresholds

Location Systolic Pressure Threshold

Brachial 30 mmHg

Femoral 30 mmHg

Invasive Hemodynamic Monitoring

The following parameters can be displayed on the Waveform Display Monitor:

Invasive Hemodynamic Monitoring

Arterial Blood Pressure

Central Venous Pressure

Right Atrial Pressure

Right Ventricular Pressure

Pulmonary Artery Pressure

Pulmonary Artery Occlusion (Wedge) Pressure

ECG Signals

To produce ECG signals on a monitor, connect a 3-lead unit to three of the four contacts (or
snaps) located on the mannequin. The fourth contact may be used as a ground.

Connect to three of the
ECG contacts.

ECG Contacts
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Manual Blood Pressure

To use noninvasive blood pressure monitoring techniques (i.e. a blood pressure
cuff), configure a standard infant cuff with the supplied T-fitting and adapters:

Blood Pressure Cuff Splice Kit
1. Cut the hose that connects to the pressure gauge on the cuff.

2. Insert one of the supplied adapter fittings into each of the open ends
of the tube, using a female fitting on one end and a male fitting on the
remaining end.

3. Attach the adapter cuff around the tubing to hold the adapter fitting into
place.

4. Insert the T-fitting into the hose adapters, noting the male and female
connections.

5. Connect the remaining portion of the T-fitting to the hose located on the
mannequin’s shoulder just behind the left arm.

6. Attach the cuff to the upper left arm and take the noninvasive blood
pressure reading using the return-to-flow technique.

Store the modified blood pressure cuff with the BabySIM system for future reuse.
Korotkoff Usage
To use this feature:

1. Have the learner palpate the left brachial pulse to identify its presence or
absence.

2. As the learner places the stethoscope in his or her ears, disable the left
brachial pulse by clicking the Off selection on the Pulses screen of the
Cardiovascular tab (See page 6.66).

3. Allow the learner to auscultate the BP, hearing the beginning of sounds at the
systolic pressure and the absence of sounds indicating the diastolic pressure.
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Metabolic System

The BabySIM patient mannequin delivers metabolic features that are physiologically modeled
within the software so that the results are made available on the Instructor Workstation or the
optional Remote Control. The ABG data displayed corresponds accurately and dynamically to
the alveolar concentration of CO5 and Oo. Metabolic acidosis and alkalosis are simulated with a
few simple adjustments to the ABG pH level made by the instructor. For example, simple
calibrations can accurately simulate a patient response to metabolic acidosis.

Genitourinary System
To use the Genitourinary features:

1. Insert the genitalia desired for the exercise.

2. Set the IV pole set up near the PCU. 0

3. Fill an IV bag and attach it to the supplied IV solution set to yield a
clinically appropriate colored liquid (e.g. for simulated urine, add 1 to ,‘
2 cc of yellow food dye per liter of distilled water and mix to achieve
the desired color). Be careful not to make the mixture too thick as this #
can clog the system.

4. Verify that the dark blue slide clamp and the light blue roller clamp are L
in the closed position to close off the flow before filling and hanging £
the bag. ’

GUS B

5. Hang the bag on the IV pole. ource Bag

6. Connect the mannequin by attaching the end of the IV solution set to the orange hose in
the Umbilical Assembly.

7. Open the clamp and allow fluid to flow into the mannequin. There is a reservoir inside the
mannequin that serves as a bladder and will fill up with the fluid.

8. When fluid begins to flow from the mannequin, adjust the clamp to control the flow.

Measurement of urinary output can be made by weighing the diaper.

NOTE: Clean up is very important when using simulated fluids. ;See page 7.65 of the

Care/Maintenance section of this User Guide for proper clean up instructions.
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Pediatric Advanced Life Support (PALS) System

The BabySIM system includes several realistic Pediatric Advanced Life Support (PALS) System

modules offering advanced hands-on skills acquisition in airway management and ventilation,
chest compression, as well as the use of defibrillators and transthoracic cardiac pacers.

Pediatric Advanced Life Support (PALS) System

Anatomy, Physiology,

and Clinical Signs Software Control

Manual Control

Oxygen administration must be
input by the instructor.

TAB: Respiratory

SHOW: Lung

PARAMETER: Fraction of
Inspited Op Oerride
el

Airway Management and
Ventilation

None required.

None required, but adjustable.
TAB: Condition
SHOW: Trauma
PARAMETER: Chest
Cgl:\ergs_sion I_Ef:icacy

a

Chest Compression

None required.

The response to clinical
intervention must be controlled
by the instructor.

TAB: Cardiovascular

SHOW: Heart

PARAMETER: Cardiac Rhythm
OlIe;rride

Cardiac Arrhythmias

None required.

Defibrillation can be simulated
by the instructor.

TAB: Cardiovascular

SHOW: External Cardiac
Simulation

PARAMETER: Defibrillation
Sée page 558 1

Defibrillation

See Defibrillation
for defibrillation disk
locations and
instructions,
kpages 6.727an '

.-6-13'------l

The instructor can set the level
at which electrical capture and
mechanical capture occur.
TAB: Cardiovascular

SHOW: External Cardiac
Simulation

PARAMETERS: All Pacing
Parameters

Cardiac Pacing

See Pacing for
cardiac pacing disk
locations and
instructions,

hPags €137
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Chest Compression

The patient mannequin supports normal finger placement and standard compression techniques.
Set the mannequin on a safe and sturdy work surface when administering chest compressions.

Defibrillation

The BabySIM is designed to safely absorb the energy discharged from manual defibrillators.
However, use of a defibrillator for training purposes represents an operational hazard equivalent
to use of a defibrillator on a real patient. Consequently, all safety precautions for use of
defibrillators must be followed as if the mannequin were a patient. Consult the defibrillator's User
Manual for further information.

The following cautions should be observed:

Defibrillation should be performed on the defibrillation electrodes only. If defibrillation is
performed over any ECG or pacing electrode, high voltage may be present on the remaining
connectors during the shock. This may also damage ECG and pacing circuitry.

To prevent overheating, do NOT provide more than three (3) defibrillator discharges
(maximum 32 Joules) in a sequence. Do NOT exceed an average of two (2) defibrillator
discharges per minute during the training session.

Do NOT let the mannequin come in contact with electrically conductive surfaces or objects
during defibrillation. A flame-supporting atmosphere, for example, with a high content of
oxygen, should be avoided during defibrillation.

Keep the mannequin chest dry. Special attention should be taken when using the urinary
system or the chest tube feature.

To prevent pitting of the chest skin electrode, do NOT apply conductive gel or conductive
defibrillation pads intended for patient use.

Do NOT use cables or connectors having visible damage.

Do NOT spill fluids over any component inside the mannequin torso. This could damage the
system and may also present a possible hazard for the operator.

When using a manual defibrillator, the ECG can be monitored via the defibrillator paddles.
Coarse ventricular fibrillation and high-rate ventricular tachycardia cardiac rhythms are
automatically recognized as “shockable” rhythms.

With each defibrillation, the BabySIM automatically records the amount of energy discharged and
the time defibrillation was performed. The simulated patient response to defibrillation is
determined by the scenario script or instructor intervention. Thus, cardioversion is not
automatically determined by the physiological models.
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For paddle placement on the chest, the mannequin has two defibrillation disks, which can be
unscrewed leaving threaded connections if required.

§Place the paddles on
< ( :  [the defibrillation disks.

Defibrillation Disks

The BabySIM is compatible with a wide variety of manual defibrillators [1.77 inch (4.5 cm) rated
for infants up to one year]. Defibrillators employing a monophasic waveform (as used by
Physio-Control® equipment) and some biphasic difibrillators, such as those made by Zoll®,
automatically report the energy discharge.

Do NOT allow defibrillator paddles to come in contact with pacing disks or ECG nodes.
Defibrillating an ECG or pacing location will damage circuitry within the mannequin.

Pacing

Disks on the front and back of the mannequin are used for cardiac pacing. To use this feature,
make sure the metal pacing disks are attached to the mannequin. Next, attach the pacing pads
from a standard transthoracic cardiac pacer to the mannequin at the site of the pacing disks, the
negative lead on the anterior location and the positive lead on the posterior location of the heart.

, : ) Anterior and posterior locations _,
¥/ . for the pacing disks. ‘
- 1 e = . —

Pacing Disks

The software automatically detects and responds to pacing signals.
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Trauma System

The mannequin can produce various trauma conditions using a combination of manual

adjustments and software settings.

Trauma System

Anatomy, Physiology,

Software Control

and Clinical Signs

Manual Control

Eye blinking can be set by the
instructor.

TAB: Condition

SHOW: Assessment
PARAMETERS: Eyes:Blink
Control and Eyes;Blink Speed

Eye Signs

Manual adjustments
for normal (3.5mm),
blown (8 mm) and
pinpoint (2mm)

h See page 6.15, Eye.
'Slgn Adjustment. :

The instructor must adjust the
amount of physiologic
intrapleural fluid present.
TAB: Condition

SHOW: Trauma
PARAMETER: Intrapleural
NOLINE u u -,

See page 5:47.s

Chest Tube Placement

Eee Ghest"l'ubel
'Setup on page 1

B8t

None required.

Intraosseous Site

The instructor must adjust the
amount of physiologic
intrapleural air present.
TAB: Condition
SHOW: Trauma
PARAMETER: Needle
.DEQPIID"#W

See page 5. 48 .

Needle Decompression

pSee Intraosseous 1
lSlte on page 6. 17 .

T
See Needle .

Decompression a
etup on page :
16.17. .

None requlred.
Secretions

i SceSecretions”
hpage 6.18.

-
ony
n
n
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Eye Sign Adjustment

Each pupil of the BabySIM can be set independently to a fixed diameter of 2, 3.5 or 8 mm
(pinpoint, normal or blown) by carefully lifting the eyelid and rotating the eye from left to right or

right to left until the proper size appears.

g Cardully pull back the
‘ eyelid and rotate the eye.

Adjusting the Eyes

Additionally, eyelids can be programmed to open and close spontaneously or can be fixed in the
closed position. When closed, a learner can manually open the eyelids for clinical inspection.

In the HPS software, the settings for the eyelids are located in thejEyes: _B!ip[(_(gqr!t_rgl_:and Eyes:
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Chest Tube Setup
To use the chest tube feature:
1. Set up an IV pole near the PCU.

2. Fill an empty IV bag with the appropriate colored liquid (e.g. for
simulated blood, mix distilled water with 5-cc of red food dye and fill
the bag). Be careful not to make the mixture too thick as this can clog
the system.

3. Attach the IV solution set to the IV bag and make sure the blue clamp
is closed.

4. Hang the bag on an IV pole set up near the PCU.

5. Connect the hose from the IV solution set to the white Trauma Source
hose in the Umbilical Assembly.

Simulated Blood

6. Once the hoses are connected, open the clamp and allow the fluid to flow into the
mannequin. A reservoir inside the mannequin collects the fluid.

7. Insert a 10 to 12 Fr. chest tube (lubricated with silicone spray) into the insertion point at
the mid-axillary line of the fifth intercostal space on the right side of the mannequin. The
tube must be inserted far enough to engage the valve on the reservoir. The system is
primed when water flows from the hose.

Chest Tube Insertion Point

8. Remove the chest tube if the procedure is to begin with chest tube insertion.
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Intraosseous Site

The intraosseous site is located on the anterior tibia of the right leg.

.\

SR
The Intraosseous Site

After multiple injections into the site, the plug can be removed and replaced. A replacement plug
is included with the Replacement Parts Kit.

Needle Decompression Setup
To set up Pneumothorax Needle Decompression,

1. In the HPS software, go to the Condition tab and under Trauma, select Needle
Decompression.

2. Click the Enabled button. After a few seconds, click the Disabled button. The momentary
enabling of Needle Decompression allows air pressure into the mannequin’s internal air
reservoir, charging the reservoir. Once the air reservoir is filled, the system is primed and
ready for a Pneumothorax puncture.

3. Insert the needle and (18 to 20 gauge) catheter into the small hole located in the
mid-clavicular line of the second intercostal space. It is necessary to use a 3 to 6 cm long,
14-gauge needle directly into the mannequin until the hissing sound of the valve release is
heard. If no sound is heard, the needle wasn’t inserted properly (either in terms of depth
or location).

Needle Decompression

on the Respiratory tab:Zs-ee page 5.77)
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Secretions

Fluids can be excreted from the baby mannequin’s eyes, ears and mouth using the three tubes
extending from the left side of the baby.

4
Connect the Secretion Adapters to the
fittings located at the end of the three
tubes extending from the baby’s left side.

The Secretions Connections

The fittings at the end of these tubes connect to the three Secretion Adapters included in the
Replacement Parts Kit. The opposite end of the Secretion Adapter connects to either an IV bag
for gravity flow secretions or to a syringe, which can be used to push fluid through the baby’s
eyes, ears and/or mouth.

When disconnected, a small valve in the fittings prevents leakage into the system.

6.18



Using the System

Employing Clinical Features

Pharmacology System

The BabySIM supports pharmacological interventions
pharmacokinetic and pharmacodynamic parameters that are established for

drugs. A permanent access catheter is located in the left femoral vein.

through pre-programmed

six intravenous

Pharmacology System

Anatomy, Physiology,

Software Control

and Clinical Signs

Manual Control

Administered IV medications
must be set by the instructor.
JaB:Drugs ...
See pages 5.49t0 5.50 1

IV Medication
Administration

All administered IV
medications are
collected in the bag
attached to the blue
(IV Drain) hose.

Administered IV fluids must be
set by the instructor.

TAB: Fluids

PARAMETER: Infusion (Colloids,
Crystalloids, Packed Red Blood
Cells or Whole Blood

BéepageS 5.517t6 5,547 1

IV Fluid Administration

All administered IV
fluids are collected
in the bag attached
to the blue (IV Drain)
hose.

Medications and fluids are administered through the permanent access catheter located at the
left femoral vein. Before using the access catheter, attach an empty bag to the blue hose (labeled

IV drain) to collect those fluids introduced through the catheter.
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Monitoring Patients

The Waveform Display Monitor provides a visual reading of key cardiovascular parameters. The
display can be customized to suit the needs of a given scenario.

Waveform Display Parameters

There are eight parameters available that may displayed as waveforms in addition to providing
their numeric values. An additional eight parameters are available for numeric display only.

Waveform Display Parameters

Patient Parameter Waveform | Numeric

ECG Leads I, II, 1l L1

Arterial Blood Pressure L1

Pulmonary Artery Pressure L1

Pulmonary Capillary Wedge Pressure L1

Central Venous Pressure L1

Pulse Oximetry Plethysmogram L1

Pulse/Heart Rate

Mean Arterial Pressure

Sp02

Blood Temperature

Body Temperature

Rectal Temperature

Axial Temperature

000 oot

Noninvasive Blood Pressure
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Accessing the Waveform Display

If the Waveform Display Monitor has been correctly powered on:(see page 3.14)athe Waveform

Display software automatically launches with the HPS6 software when login is completed for the

Instructor Workstation*(see page 4.1).

However, if the Waveform Display application has been closed or is not running, open the
application by clicking on the Waveform Display icon located on the Dock.

Select the Waveform Display icon to open

+ METI the Waveform Display software.
_[‘ HPS ~ T

The Waveform Display Icon

When the Waveform Display opens, a blank screen appears and the Waveform Display menu is
shown at the top of the window.

/| The Waveform Display Menu Bar

Waveform Display File Edit Simulators Patients View Layouts |
e 00 No patient selected

The Waveform Display Title Bar

The Waveform Display Status Bar

Select a patient from the "Patients” menu

The Waveform Display with No Patient Selected

Beneath the menu bar, No Patient Selected should appear in the Waveform Display title bar. If
No Simulator Selected appears, select the simulator from the Simulators menu.

Waveform Display File Edit Patients View Layouts
192.168.1.92 )
192.168.1.197

Selecting a Simulator

In most cases, only one simulator will be available, located on the localhost.
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Once a simulator is chosen, select a patient from the Patients menu.

Waveform Display File Edit  Simulators View Layouts

Fussy Baby [ ID: 2]

¥ Automatically switch to Patient on Mannequin

Selecting a Patient

The Patients menu contains a list of all patient files currently running. If no patient is running,

open a patient file from the Patient Palettej(see page 4'6)5

The patient’s information is loaded and displayed on the Waveform Display Monitor.

The title bar displays the patient
800 byl file name and ID number.

R Y PO TN PN PN PO PN PO P oy PN I 129

S P PN I N ST S DU T DY PN I

79 | 54

mmHg

17 | 6

mmHg

1

The status bar displays the the patient’s name

simulator name (or number),

and the waveform layout.

Simulator: 192.168.1.7 { Local )  Patient: Baby Rvan  Lavout: ICU-OR

The Waveform Display with Patient Information

In the Waveform Display window, the patient’s file name and ID number appears in the title bar
at the top while the status bar at the bottom contains the simulator’s identification, the patient’s
name, and the active waveform layout.

To change the patient, select a new name from the Patients menu.

NOTE: By default, the option Automatically switch to Patient on Mannequin is selected. When
this option is chosen and multiple patients are running, the waveform software automatically
reflects the physiology of the active patient. However, because performance may be
significantly affected, running multiple patients is not recommended.
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Modifying the Waveform Display

The default configuration can be modified to change or customize the layout, suspend or reset
alarms and change or mute the audio.

Viewing NIBP

Initially, the NIBP panel appears with no (--- / ---) value. To take an isolated reading of the
noninvasive blood pressure at the current moment, select the NIBP option from the View menu.

Waveform Display File Edit Simulators Patients Layouts
i > e
Thermodilution Cardiac Qutput
|

Selecting NIBP to View

The NIBP reading appears in the NIBP panel and remains in view until another reading is taken.

Changing the Layout

The Waveform Display can show up to six waveform readouts with their accompanying numeric
values plus an additional four numeric readouts.

There are three preconfigured METI Layouts:

EMS-ED-Telemetry - preconfigured with a waveform and numeric readout for ECG Lead Il
and numeric readouts for SpO» and noninvasive blood pressure (NIBP).

ICU-OR (default layout) - preconfigured with waveform and numeric readouts for ECG Lead
I, ECG Lead V (unused), ABP, PAP, CVP and Pleth, and numeric readouts for NIBP,
Thermodilution C.O (unused), Blood Temperature and Body Temperature.

Saturation-Pulse - preconfigured with numeric readouts for SpO5 and pulse.

Select the appropriate layout from the list located under the Layouts menu.

|  Waveform Display File Edit Simulators Patients View

+ ICU-OR N
Saturation-Pulse

Edit Custom Layouts...

Selecting a Layout
Only the ICU-OR layout makes use of every parameter panel and the preconfigured layouts
cannot be overwritten or changed, but any configuration of waveform/numeric and numeric
values can be created by customizing the layout (see below).

When customized layouts are created, they appear in the Layouts menu beneath a Custom
Layouts heading.
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Customizing the Layout

To customize the Waveform Display layout, select the Edit Custom Layouts option from the

Layouts menu.

.. Waveform Display File Edit Simulators Patients View

~

* EMS-ED-Telemetry
ICU-OR
Saturation-Pulse

Selecting Edit Custom Layouts

The Waveform Display Layout Editor appears, displaying the current layout. This layout can then
be modified by selecting waveform/numeric or numeric parameters for the various panels.

[5)

elect the waveforms and numerics you would like to monitor.

Waveform Display Layout Editor

The Available Layouts appear on the
right, including the Custom Layouts.

A menu appears when one of the six max range = 1 mv
Waveform/Numeric panels is clicked. [

Il ECGV

min range = 0

o e

max range = 0

lll OFF =

Avallable Layouts

METI Layouts 7

_ EMS-ED-Telemetry
_ ICU-oR

_ Sawration-Pulse,
Custom Layouts

__ Group L Monitor
__ Group 2 Monitor

ABP
MAP
PAP
PCwWP
Cvp
5p02

\")

V ow

e is c

max range = 40 mmHg

A menu appears when one
of the four Numeric panels

licked.

Continuous C.0.

Blood Temperature
Body Temperature
Axial Temperature

V| Pleth

Numeric Panel | Numeric Panel Il Numeric Panel Ill

NIBP
§ OFF

®

Continuous C.0.

Save Layout

Layout Name

Group 2 Monitor

Thermodilution C.O.

Rectal Temperature

Reset To Defaults

Delete Layout

Close

The Waveform Display Layout Editor

To CHANGE the settings on a WAVEFORM/NUMERIC panel (one of the
1. Click the panel to edit. A menu with ten options pops up.
2. Select the appropriate menu option:

a. Select one of the cardiovascular-related options (ECG V is cu

top six panels):

rrently unavailable).

b. Select Blank if the display is to leave an unused space for the panel.

c. Select OFF if the display is to omit the panel, allowing additional space for the

remaining waveform readouts.
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3. Use the slider bars to adjust the minimum and maximum ranges for the readings.

4. Click the palette icon to the right of the panel to open a window with a color spectrum
used to change the color of the waveform and numeric displays.

5. Click on the box on the far right to set the numerics to On or Off. (Waveform parameters
set to the OFF position have numerics set to Off by default.)

To CHANGE the settings on a NUMERIC panel (one of the bottom four panels):
1. Click the panel to edit. A menu with fifteen options pops up.
2. Select the appropriate option:

a. Select one of the cardiovascular-related options (Thermodilution C.O. is currently
unavailable).

b. Select OFF if the display is to darken the panel, leaving the space empty.

3. Click the palette icon at the bottom of the panel to open a window with a color spectrum
used to change the color of the numeric display.

To CLEAR CHANGES, click the Reset to Defaults button on the lower right-hand side of the
window.

When changes are complete, SAVE the new Iayout.E(See page 6.26 for information on Saving a
Customized Layout.)

CHANGES are LOST if the Waveform Display Layout Editor is closed without saving the new
layout.
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Saving a Customized Layout

To SAVE the new format once changes are complete:
1. Highlight the name in the Layout Name field.
2. Enter the name of the new layout.
3. Click the Save Layout button.

The customized layout now appears listed among the Custom Layouts in the Available Layouts
panel on the right. This layout also appears in the Layouts menu.

Once changes have been saved, click the Close button to close the Waveform Display Layout
Editor. The Waveform Display now displays the newly saved customized layout.

B Waveform Display Layout Editor

Select the waveforms and numerics you would like to monitor.

Avallable Layouts

min rai =-1mV max ral =1 mv|
| ECGn noe nge

———— —— The new layout appears in the Available

Il ECGV TR, Layouts list beneath the Custom Layouts.
n— o . . iRl e e S AR Custom Layouts /

OFF minjzees _ Group 2 Monito
[ s S s 9

\")

L

s 3 Click Reset to Defaults to clear changes or
delete the customized layout by selecting it
from the list and clicking Delete Layout.

Numeric Panel Il Numeric Panel lll Numeric Panel IV

Enter the new name in
the Layout Name field.

Rody Temperature

Reset To Defaults
®
7 7 7 Delete Layout

Layout Name

Croup 2 Monitor Close

A Customized Layout for the Waveform Display

Deleting a Customized Layout

To DELETE a customized layout:
1. Select the layout from the list beneath Custom Layouts in the Available Layouts panel.
2. Click the Delete Layout button.

The customized layout is deleted.
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Changing the Audio

The Waveform Display includes an audio feature with a choice of clinical monitoring sounds. To
choose a setting, open the Edit menu and click Audio to access the sound options.

|  Waveform Display File Simulators Patients View Layouts

1 L

i R+ Auto

‘ Pleth (Sp02)
Alarms *» ko

| Art

Mute

Selecting the Audio Menu
All settings are synchronized with the patient’s heartbeat.
There are five available audio settings:

Auto (default) - depending on the layout, sounds are selected in order of these parameters:
Pleth (SpO»), ECG, and Art. If, for example, both Pleth and Art parameters are in the layout,
the sounds related to the Pleth readout are heard. To hear the sounds of the Art readout when
either the Pleth or ECG parameters are also present, the Art option must be chosen.

Pleth (Sp02) - pitch changes according to the value of the SpO5. When the SpO, value
increases, the pitch becomes higher, and when the SpO, value decreases, the pitch
becomes lower.

ECG - rate of sound reflects changes to the patient’s heart rate while maintaining a constant
unvarying pitch unaffected by the patient’s condition.

Art - rate of sound reflects changes to the patient’s Arterial Blood Pressure (Art) while
maintaining a constant unvarying pitch unaffected by the patient’s condition.

Mute - eliminates all sounds based on the patient’s heartbeat. Does not remove any alarms
set to sound when minimum and maximum levels of the layout’s parameters are met.

Choose the appropriate sound from the Audio menu.
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Setting the Alarms

The Waveform Display includes an alarm feature that registers a two-tone (high-low) sound when
patient parameter readings fall below or exceed a specified minimum or maximum setting. The
alarm feature can be turned on (the default) or off by selecting the Suspend option from the
Alarms menu located beneath Edit on the menu bar.

When alarms have been suspended, a diamond appears to the left of the option showing that
Suspend has been selected.

The Alarm settings can also be modified. To change the settings for the alarms, select the Alarm
setup option from the Alarms menu.

. Waveform Display File Simulators Patients View Layouts

Suspend

Selecting the Alarm Setup

The Alarm Setup window appears, displaying six parameters, three of which have pull-down
menus.

Three of the six alarmable parameters
. Alarm Setup
offer pull-down options.

o Hear' Rate

Each parameter has a minimum and
maximum setting for the alarm to sound.

¥ Blood f»

Restore Defaults | Cancel ) OK

The Alarm Setup Window
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Including the pull-down settings, there are eleven parameters that may be associated with an
alarm. However, only six alarm settings (one for each of the primary parameters displayed in the
window) are possible at one time.

Parameter

Heart Rate

ABP (Sys)

ABP (Dia)

PAP (Sys)

PAP (Dia)

CVP

SpO0y

Temp (Blood)

Temp (Body)

Temp (Axial)

Temp (Rectal)

To set an alarm:

1. Check the box to the left of the parameter.

2. Choose an option from the pull-down menu, if available.

Units

BPM

mmHg

mmHg

mmHg

mmHg

mmHg

%

Alarm Settings

Default Default Alarm

Maximum Range Minimum | Sound
T
300 70 to 180 -40 :I‘?;%:Ig;e/
300 20 to 110 -40 :I‘?;%:Ig;e/
300 10 to 40 -40 :I‘?;%:Ig;e/
300 5 to 20 -40 :I‘:;% :’g vr; e/
300 0to 15 -40 :I‘?;%:Ig;e/
100 90 to 100 50 :I\?;%:Ig;e/
45 36 to 38 10 :I‘?;%:Ig;e/
S T T
S T
S T T

3. Use the slider bar to set the maximum and minimum levels.

4. Click the OK button.

To turn off a specific parameter’s alarm, uncheck the box to left of that parameter and click OK.

To undo any changes, click the Restore Defaults button.
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Using the Wireless Remote Control (OPTIONAL)

After the system is operational, the Wireless Remote Control laptop can be integrated into the
simulator session.

The HPS6 software must be running on the Instructor Workstation for the Wireless Remote to
work. KEEP the cover of the Instructor Workstation OPEN. Closing the cover will terminate
operations.

Turning on the Wireless Remote Control
To turn on the Wireless Remote Control

1. Power on the Wireless Remote by pressing the power button on the upper right-hand
corner of the keyboard. If the HPS6 software does not launch automatically, click the
HPS6 Launcher icon in the Dock.

The Connect to Patient Model window appears. (If the window fails to appear, select the
Connect to Patient Model option from the HPS menu.

600 Connect to Patient Model

vPatient Models

"Simulators

Select a simulator from the Simulators list.

€ ps 4 Click Connect.
Hos(.>10.127.127.220:28999 f  Connect " ‘

Connecting to the Patient Model

2. Select the simulator and click Connect.

3. Confirm the strength of the AirPort wireless signal by noting that 3 or 4 bars are present
on the AirPort icon located toward the right of the HPS menu bar.

= ) @ Fri4:25PM |
Confirming Signal Strength

‘ Signal strength

The AirPort wireless signal range is approximately 150 feet.

Shutting Down the Wireless Remote Control

The Wireless Remote Control is shut down prior to the shutdown of the Instructor Workstation.
Stop the patient file and quit HPS before powering down the remote laptop by choosing Shut

Down from the Apple menu. :_See page 4.11 Efor information on saving and stopping a patient file.)
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Warranty Programs

BabySIM Care and Maintenance

Maintaining the METI BabySIM requires careful treatment of the electronic and mechanical
components. Each time the BabySIM system is assembled or disassembled make sure all
components are properly handled and either removed from or placed into storage correctly.

BabySIM® Warranty Programs

General Information

METI patient simulator products come with a one-year Basic Service Warranty at no additional
charge. All warranties begin at date of shipment or METI installation. You may upgrade your first
year Basic Service Warranty to an Enhanced Warranty and receive remedial and preventative
maintenance. To prevent equipment downtime and delays after your warranty expires, we
encourage you to contract for extended maintenance services for all subsequent years.

Units Out of Agreement

For units no longer under warranty requiring repairs, the Time and Materials service plan will
apply (see Time and Materials section below).

To place an out-of-warranty unit under a warranty contract, METI reserves the right to have the
patient simulator inspected by a METI-approved technician at the customer’s expense. If
necessary, the unit would have to be repaired at the customer’s expense prior to issuance of a
warranty contract.

The repairs required, as the result of the examination, will be quoted on a time and material basis.

How to Contact Customer Support

United States Office: US Military Office:
Toll Free (866) 462-7920 Phone (941) 379-1626
Direct (941) 342-5605 Fax (941) 379-1621
Fax (941) 342-5600 Internet Address: ljung@meti.com
Internet Address: support@meti.com
Web URL: www.meti.com
European Office: Australian Office:
Phone +49-6131-971-3546 Phone +31-625-542873
Internet Address: international_support@meti.com Internet Address: jbankuti@meti.com

Canadian Office:

Phone (888) 516-9199
Internet Address: Ichmielewski@stars.ca
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Service Hours

The principal period for performance of service is:

United States Office: European Office:
Monday through Friday Monday through Friday
7:00 AM to 6:00 PM, 8:00 AM to 5:00 PM,
Eastern Standard Time Central European Time
Canadian Office: Australian Office:
Monday through Friday Monday through Friday
8:00 AM to 5:00 PM, 8:00 AM to 5:00 PM,
Mountain Standard Time Australian Eastern Standard Time

Holiday and non-business days are excluded.

Contract Period

Warranty contracts are not ordinarily offered for periods of less than one year. However,
multiple-year warranty contracts may be arranged for up to an additional three years. Discounts
are available for purchase of multiple year contracts.

Limitations of Agreement

Your exclusive remedy for any defective patient simulator is limited to the repair or replacement
of the defective patient simulator.

METI may elect which remedy or combination of remedies to provide at its sole discretion. METI
shall have a reasonable time after determining that a defective product exists to repair or replace
defective product. METI's replacement product will be manufactured from new and/or
serviceable parts. METI's agreement applies to repaired or replaced products for the balance of
the applicable period of the original warranty or ninety days from the date of shipment of a
repaired or replaced product, whichever is longer.

METI shall not be liable under this warranty for incidental or consequential damages, or in the
event of any unauthorized repairs or modifications have been made or attempted, or when the
product, or any part thereof, has been damaged by accident, misuse or abuse. This warranty
does not cover normal wear and tear, staining, discoloration or other cosmetic irregularities that
do not impede or degrade product performance. Any damage or malfunction as a result of the
installation of software or hardware, not authorized by METI, will be repaired under the Time and
Materials service plan (see Time and Materials section below).

METI's warranty does not cover products that have been received improperly packaged, altered
or physically damaged. Products will be inspected upon receipt.

Some states in the USA do not allow the exclusion or limitations of incidental or consequential
damages, so the limitations above may not apply to you. This warranty gives you specific legal
rights and you may also have other rights, which vary from state to state.
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Return Materials Authorization (RMA)

No product may be returned directly to METI without first contacting METI for an RMA number.
If it is determined that the product may be defective, you will be given an RMA number and
instructions for product return. An unauthorized return, i.e. one for which an RMA number has not
been issued, will be returned at your expense. Authorized shipments are to be shipped prepaid
to the address on the RMA. Your original box and packaging materials should be kept for
storing or shipping your product. To request an RMA, please contact Customer Service.

Basic Warranty Service Program

The METI patient simulator comes with a one-year Basic Warranty Service Program. The Basic
Warranty Service Program provides return-to-factory hardware and software maintenance. Basic
service provides corrective maintenance support for the timely repair or replacement of METI
products. METI may either repair or replace failed components. The Basic Warranty Service
option includes:

¢ Labor and materials for the repair of METI products at METI's facility.

¢ Timely replacement of faulty modules/sub-modules.

e Software upgrade services (see System Software Upgrades Support section).

e Basic application support.

e Customer Service Hotline (telephone, fax and e-mail).

e On-site repair provided at METI discretion.

¢ Freight costs to the METI center are not covered. However, METI bears the return freight
costs utilizing a standard delivery service selected by METI.

e METI assumes the responsibility for loss or damage of goods in METI's Sarasota Facility
during maintenance or service.

Enhanced Warranty Service Program

The Enhanced Warranty Service Program provides the same features as the Basic Warranty
Service Program with the addition of Preventative Maintenance (PM) of METI products. PM takes
place at METI’s facility and is performed once per year. Freight costs to and from the customer
site, shipped by standard ground transportation, will be paid by METI. Preventative Maintenance
consists of evaluation and performance testing of the following:

¢ Physical inspection and cleaning.

e Functional check of equipment.

e Lung calibration.

e Calibration of METI-produced equipment.

e Pneumatic adjustments as necessary.

e Electrical checks and adjustments as applicable.

e Mechanical inspection and adjustments.

e Repairs / alignments as necessary.
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System Software Upgrade Support

Customers with current warranty contracts are entitled to receive upgrades to applications
software previously purchased. Installation of the system software is the user's responsibility.

The System Software Upgrades Support includes software upgrades for base software and
purchased optional software modules.

**This does not apply for major upgrades or technological enhancements.**

Pricing Structure
Time and Materials

For those institutions not under agreement, service will be provided as required on a Time and
Material basis:

Description In-House On-Site

Technical Support $145 per hour
Minimum 4 hours

Material As quoted at time of repair

Travel Priced at METI’s fully
burdened cost plus fee

Principal period of on-site support (customer’s local time) is:

¢ Monday through Friday, 8:00 AM to 5:00 PM (customer's time zone)
¢ Holiday and non-business days excluded
e Support outside the principle period is billed at the premium rate (hourly rate x 1.5)

A minimum of 48 hours notice is required for scheduling an on-site support call. Urgent on-site
support with less that 48 hours notice will be charged at the premium hourly rate.

On-site time is described as the time period commencing from arrival at customer site through
departure from customer site.
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Breakdown

After each use, the BabySIM should be properly disassembled, cleaned and stored in a secure
place. To ensure that the BabySIM remains in good working condition, follow the prescribed
METI breakdown procedures below. These procedures are estimated to take less than 30
minutes.

The table below outlines the steps required for disassembling, cleaning and storing the BabySIM

Breakdown Steps

Clean Systems

system.

Flush Genitourinary (GU) System
Flush IV System
Flush Chest Tube System

Decompress the Chest

Wipe Off Mannequin

Turn the Air and Gas Supplies Off

Shut Down the Software

Disconnect the Computer Components

Shut Down the PCU

Disconnect Hoses and Cables from the PCU

Ready the PCU for Storage

Disconnect the Umbilical from the Mannequin

© 0O N o a A~ O D

Store the Mannequin

Further details for each of these steps are included in the pages that follow.
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Step 1: Clean Systems

To maintain the BabySIM in top condition, thoroughly clean the outside and flush those systems
that were used during the session.

A. Flush Genitourinary (GU) System

If distilled or sterile water was not used during the simulation exercise, flush the system with at
least 1-liter of distilled or sterile water.

To flush the GU system,
1. Replace the GU source IV bag with a 1 liter IV bag of distilled or sterile water.
2. Prime the the bulb of the IV stake and ensure that flow has started.
3. Run the IV supply of distilled or sterile water until the bag is empty.
4. Close the clamp on the GU source IV bag.

5. Remove the IV bag from the stake set and disconnect the stake set from the GU fitting on
the Umbilical Assembly.

6. Drain the Umbilical Assembly and the stake set.

7. Connect a large (e.g. 60 cc) syringe filled with air to the orange hose (the GU fitting) of the
Umbilical Assembly.

8. Using the syringe, force the air through the system until no water remains in the system.
9. Disconnect and drain the urine collection bag.
After the flushing procedure is completed, make sure the mannequin’s skin is clean and dry.

To prevent mold, mildew and fungus from fouling the GU, occasionally flush the GU system with
a 1 liter IV bag of distilled or sterile water mixed with 20 cc of bleach. Follow the procedure
outlined above for flushing the system first using the beach solution. Repeat the procedure using
distilled or sterile water only. The system should be cleaned in this way about once every two
months (or as appropriate).
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B. Flush IV System

To flush the left femoral IV site,

1

2.

7.

8.

. Remove the IV source bag from the red hose in the Umbilical Assembly.

Fill a 60 cc syringe with air and insert the tip into the end of the red hose.

. Force air through the hose until no moisture exists.
. IF COLORED WATER WAS USED, Fill a 60 cc syringe with fresh distilled or sterile water.
. Insert the tip of the syringe into the red hose.

. Inject all the water from the syringe into the hose and let it collect in the drain bag attached

to the blue hose.
Continue to inject water until the water flowing into the bag is clear.

Refill the syringe with air and force the air through the hose until no moisture exists.

C. Flush Chest Tube System

To flush the Chest Tube system,

1.
2.

w

o N o o b

Disconnect the Trauma source bag from the white hose in the Umbilical Assembly.

Lubricate the priming tube with silicone spray.

. Push the priming tube into the insertion site on the right side (if not already present) far

enough to engage the valve and allow the water to drain out.

. IF COLORED WATER WAS USED, fill a 60 cc syringe with fresh distilled or sterile water.
. Insert the tip of the syringe into the end of the white hose.

. Inject all the water from the syringe into the hose and let it drain out through the tube.

. Repeat this process until the water draining through the tube is clear.

. Fill the syringe with air and, inserting the syringe into the white hose, force the air through

the system until no water drains from the tube.

. Remove the tube.
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D. Decompress the Chest

Always decompress the chest when using the Pneumothorax Needle Decompression feature
before completing the shutdown procedures. Do not store the mannequin until decompression
has been performed.

E. Wipe Off Mannequin

After all fluids have been removed, carefully inspect the mannequin for evidence of any
remaining colored liquids. If a stain is found, use a soft cloth with mild soap to wash the area.
Rinse and dry. Once the mannequin is thorough flushed and cleaned, it is ready for storage.

Step 2: Turn the Air and Gas Supplies Off

The first step in the breakdown process is to turn off any air or gas supply in use.

Turn off Air Supply
If air was used,
Shut off the air supply (i.e. the central air supply resource)
or

Turn off the OPTIONAL Air Compressor, drain any condensation and store the
Compressor. The Quiet In-Room Air Compressor (introduced on page 2.13) is drained
using a small plug at the one end. Remove the plug and tip the unit toward the opening
to drain. Replace the plug after the procedure has been completed.

Turn off Gas Supply
If COo was used,

Close the CO5 supply using the supplied wrench to tighten the valve, and properly store
the tank.

Once the air and gas supplies have been turned off, remove the Regulator Assembly from the
CO, source, coil the assembly and set it aside for storage.

7.8



MEI'W Care/Maintenance

Breakdown

Step 3: Shut Down the Software
To shut down both the Waveform Display and HPS6 software:

1. In the HPS6 software, Click the Disconnect icon on the Patient window (see page 4.18 for
more information on the Connection Icons).

2. From the Waveform Display software, select Quit Waveform Display from the Waveform
Display menu.

3. If desired, click Save to save the patient file (see page 4.11 for information on the Save
icon or page 4.25 to learn about Saving Data).

4. From the HPS6 software, click the Stop icon in the Patient window or Patient Palette (see
page 4.11 for information on using the Stop icon). A warning box appears providing
another opportunity to Save the patient file.

5. Select Quit HPS from the HPS menu.

If using a Wireless Remote Control, quit the HPS6 application using the same steps described
above for the Instructor Workstation.

Step 4: Disconnect the Computer Components
To disconnect and store the computer components:

1. Power off the Waveform Display Monitor using the power button on the front of the
monitor.

2. Power off the Instructor Workstation by selecting the Shutdown option beneath the @&
menu on the Finder menu bar.

3. Unplug the Instructor Workstation and Waveform Display Monitor power cables from the
outlet.

4. Disconnect the cable adapter (that is attached to the Waveform Display video cable) from
the Instructor Workstation.

5. Remove the AC power cable and the video cable (with cable adapter attached) from the
Waveform Display Monitor.

6. Disconnect the Ethernet cable from the Instructor Workstation.
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7. Disconnect the power supply cable from the Instructor Workstation.

8. Coil the cords and store them along with the Waveform Display Monitor and Instructor
Workstation.

If using the battery to power the Instructor Workstation or if using the Wireless Remote Control,
recharge the battery using the power cable and a surge-protected power source. The Instructor
Workstation and Wireless Remote Control both have a green light that indicates a fully charged
unit, when lit.

Step 5: Shut Down the PCU

With the air and gas supplies turned off (from Step 1):

1. Power off the PCU by pressing the POWER SWITCH on the Interface Panel into the OFF
position.

2. Unplug the power cord from the power outlet. (If using the OPTIONAL Auxiliary Power
Supply, disconnect the cable from the Auxiliary Power Supply.)

3. Remove the power cord from the PCU port labeled AC IN. (If using the OPTIONAL
Auxiliary Power Supply, remove the cable from the port labeled AUX POWER IN 12VDC.

4. Coil and set aside the power cord.

If using the Auxiliary Power Supply, recharge the internal battery by plugging the component into
an AC power outlet when one becomes available.

Step 6: Disconnect the Hoses and Cables from the PCU

To disconnect the PCU’s hoses and cables:
1. Disconnect the EXPIRED COo hose connected to the PCU.
2. Disconnect the MAIN SUPPLY GAS AIR-OR-CO» hose.
3. Disconnect the Fluidic/Pneumatic Coupler from the lower UMBILICAL port.
4. Disconnect the Electrical cable from the upper UMBILICAL port.
5. Disconnect the Ethernet cable from the INSTRUCTOR WORK STATION port.
6. Coil the hoses and cables and set them aside to be stored.

Do NOT disconnect the umbilical from the BabySIM at this time. The hoses must be flushed
through the simulator prior to disconnection.
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Step 7: Ready the PCU for Storage

Once all of the hoses and cables are disconnected from the PCU Interface Panel, fold the
Wireless Receiver antennas back into position and close the PCU door. Lock the clamps on all
three sides of the PCU into place to ensure the safety of the equipment.

Step 8: Disconnect the Umbilical from the Mannequin
To disconnect the Umbilical Assembly from the mannequin,

1. Unlock the fluid/pneumatic hose system by pressing the red lever.

2. Disconnect the electrical cable by twisting the outer fitting.

3. Wind the umbilical carefully and set it aside to prepare it for storage.

Step 9: Store the Mannequin

Place the mannequin in the hard mannequin case for storage, using the foam inserts to hold it in
place. Use any remaining room in the case for clinical supplies and other teaching tools used in
the next session.

Before storing the wireless microphone, be sure the transmitter has been turned off to maintain
battery power for the next session.
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Maintenance Advice

Simple care and maintenance helps to ensure that the BabySIM system stays in good working
condition. Many problems are caused by inadequate or improper maintenance. Perform a
thorough check of the various components each time the simulator is used.

General Mannequin Care

B Avoid the use of writing instruments and sharp objects near the patient mannequin to prevent
unattractive markings on or tears in the skin.

B A mild detergent and warm water will remove most marks and stains. Gently rub the soiled
area with a soft cloth. Do NOT use ABRASIVE soaps or pads.

M If more stubborn markings appear on the mannequin, METI suggests a specialty cleaning
product (such as Goof Off or Orange-Sol, available at home improvement or hardware stores).
Following the manufacturer’s practices and warnings when using these types of cleaners
should allow for gentle and easy removal of the marks and stains.

M Prior to using moulage of any kind, METI suggests the application of a very light coating of
petroleum jelly, followed by a light dusting of baby powder to the mannequin’s skin. This
application makes cleaning the skin easier. For cleanup, use alcohol and gauze or a gentle
cleaning solvent (such as Goof Off® or Orange-Sol products).

M If any of the trauma, genitourinary or IV features of the BabySIM have been used, flush out the
mannequin as described in the previous pages. Failure to flush the systems may cause
problems for the system during attempts at future use.

[l Store the mannequin in the hard case provided for storage and transport.

Il Do NOT stack items on top of the mannequin case.
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Airway Inspection

The BabySIM is equipped with an anatomically accurate airway which supports the practice of
difficult airway management techniques. In the process of performing these techniques
improperly or aggressively, the upper airway can be damaged. While such damage may be
readily apparent (manifested as a "leak in the breathing circuit) during mechanical ventilation, it
may not be obvious during spontaneous or bag and mask ventilation.

Because damage can occur, occasional visual inspection of the airway is recommended. Using
the light of a laryngoscope blade or a flashlight, visually examine both the upper and lower
airway. While tears in the upper airway resulting from intubation may be obvious, needle holes in
the lower bronchus resulting from techniques such as transtracheal jet ventilation may not be
readily apparent.

If damage to the airway is found, small cuts or tears may be reparable (see below). However, for
permanent repair of damaged mannequins contact METI Customer Support.

Mannequin Repair (Cuts and Abrasions)
Perform the following steps if a cut occurs,

1. Clean the area around the cut thoroughly using alcohol swabs or liquid alcohol and cotton
balls.

2. Allow the area to dry completely.
3. Apply a small bead of cyanoacrylate adhesive (e.g. Superglue™) to the open surfaces.
4. Wipe any excess glue away with an alcohol-coated cotton swab.
5. Firmly press the surfaces together taking great care not to touch the adhering area.
The following tips may be useful when completing the above procedure,
B The repaired area may be gently sanded using a fine grit paper.
M Disposable examination gloves are recommended to prevent inadvertent adhesion of skin.

Contact METI for permanent repair of damaged mannequins.
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Care of Electronic Equipment

Il Do NOT use any of the computer components associated with this system for any other use.
Il Do NOT connect the computer components to any network of any kind.

M Install any METI software updates as soon as they become available.

M NEVER stack other equipment on computer components or the PCU.
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Index

Accessories, 2.11 - 2.12 Instructor Workstation, 1.13, 2.10, 3.9 - 3.12
Air Compressor, 2.13, 3.7 - 3.8 Intraosseous Site, 6.17

Airway Management, 1.2, 1.8, 5.74, 6.5, 6.11 Intubation, 1.2, 6.11

Assessment, 5.40 Invasive Hemodynamic Monitoring, 6.8
Auxiliary Power Supply, 2.12 IV Access, 6.16, 7.7

Korotkoff Sounds, 6.9
Blood Pressure, 1.5, 6.9

Cardiac Arrhythmias, 1.8 Login, 4.1
Cardiac Pacing, 1.8, 6.13 Logs Drawer, 4.11 - 4.12
Cardiovascular, 1.5 - 1.6, 6.7 Logs, 4.11 - 4.15
Cardiovascular Tab, 5.55 Macintosh, 1.13, 4.1 - 4.3
Chest Compression, 1.8, 6.12 Mannequin, 1.1, 2.3, 3.4
Chest Tube, 1.9, 6.16, 7.7 Carrying Case, 2.4
Condition Tab, 5.39 Pigtail, 2.3, 3.4 - 3.5
Connection to Simulator, 4.18 Medication, 5.49 - 5.50, 6.19
Custom Patients, 6.2 Metabolic System, 1.7, 6.9
Microphone (see Wireless Microphone)

Defibrillation, 1.8, 6.12 - 6.13 Monitor (see Waveform Display Monitor)
Detach Tab, 4.16 Needle Decompression, 1.9, 6.17
Disconnecting Simulator, 4.18 Neurologic System, 1.7
Discrete Parameters, 4.22
Drugs Tab, 5.49 PALS (Pediatric Advanced Life Support), 1.8, 6.11
ECG, 1.5, 6.8, 6.20 Palpable Pulse Thresholds, 6.8
Effector Site Concentration, 5.50 Parameters, 4.22 - 4.24
Electrical Therapy, 1.8, 6.12 - 6.13 Patient
Event Recorder, 4.16, 5.36 - 5.38 History, 6.3
Eye Signs, 1.9, 5.42 - 5.43, 6.15 Create New, 6.2

Change Existing, 6.4
Fluids Tab, 5.51 Patient Files, 1.11, 4.6 - 4.9
Genitourinary System, 1.7, 6.10, 7.6 Patient Palette, 4.6
Heads Up Display (see HUD) Patient Time, 4.17
Hematology Model, 5.53 PCU (Power and Communications Unit), 2.5 - 2.9,
HPS Software, 1.13, 4.1 3.6-3.8,3.12-3.13
HUD (Heads Up Display), 4.19 - 4.20 Pharmacology, 1.8, 1.10, 6.17

Printing, 4.28

Pulmonary System, 1.3 - 1.4, 6.6
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Recorder (see Event Recorder)
Replacement Parts Kit, 2.4
Respiratory Tab, 5.73
Saving Patient Files, 4.25 - 4.28
CD-Rom, 4.26
USB Memory Device, 4.28
Saving Scenarios, 5.34
Scenario Tab, 5.2
Scenarios, 1.11, 5.3 - 5.12, 5.34, 5.38
Events, 5.16 - 5.27, 5.32 - 5.33
States, 5.13 - 5.15
Transitions, 5.28 - 5.33
Simulation Tab, 5.1
Sounds (see also, Wireless Microphone)
Baby Sounds, 5.40
Breath Sounds, 5.41
Bowel Sounds, 5.40 - 5.41
Heart Sounds, 5.44, 5.64

Tabs, 4.21
Cardiovascular, 5.55
Condition, 5.39
Drugs, 5.49
Fluids, 5.51
Respiratory, 5.73
Scenario, 5.2
Simulation, 5.1

Trauma, 1.9, 6.14

Umbilical Assembly, 2.3, 3.6

Waveform Display Monitor, 1.12, 2.10, 3.9 - 3.11,
6.8, 6.20 - 6.29

Wireless Microphone, 2.9, 3.14
Wireless Remote Control, 1.13, 6.30
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Scenario Scene

This is a 5-month-old male brought by his mother to the
Emergency Department after falling off the bed. He cried
initially and then became lethargic. He had a brief episode of eye
deviation and right arm jerking. The mother has had to stimulate
him to keep him awake.

Past Medical History: Ex-premature infant, 29-week gestation
and 1350 g. He was mechanically ventilated for 9 days and on
oxygen for 15 days. Discharged home on no medications at 5
weeks and 2.3 kg.

Review of Systems:
CNS: Lethargy. Possible seizure episode.
Cardiovascular: Noncontributory
Pulmonary: Noncontributory.
Renal / Hepatic: Noncontributory
Endocrine: Noncontributory
Heme / Coag: No active bleeding

Current Medications: None

Physical Examination

General: Floppy, lethargic, pale infant responds
minimally to painful stimulus

Weight, Height: 4.5 kg

Vital Signs: Temp 36.6°C, HR 109 / min,
RR 28 / min., BP 105/78, SpO5 98%

HEENT: No visible external signs of trauma,
Anterior fontanel bulging, PERRL, Possible retinal
hemorrhages, no nasal or ear drainage

Airway: Patent

Lungs: Clear

Heart: No murmur, capillary refill 3 seconds

Laboratory, Radiology, and other relevant studies:
HCT 23%

Allergies: None as reported by mother

Learning Objectives

Recognize signs of intracranial
hypertension in an infant.

Describe several etiologies for intracranial
hypertension in the infant.

Recognize the importance of prompt
airway management to maintain
oxygenation and to prevent hypercapnia.
Understand and demonstrate
management of head trauma and
intracranial hypertension in the infant.
Effectively communicate with other
members of the healthcare team.



Scenario States

State Patient Status Learning outcomes or actions desired
Baseline HR=129, BP 88/55 1. In each state, reassesses condition and
(Baby Ryan) RR=40; response to treatment
Cardiac Rhythm=NSR;
Sp0y=98%; Transition: When the instructor is ready to
Breath Sounds=clear; start the scenario, click the next button.
LOC=alert; PEARL
Intracranial HR=108; BP=103/68; 1. Completes initial assessment, evaluates
Hypertension | RR=32; data collected, and documents

Cardiac Rhythm=NSR
Sp09=98% on room air;
Breath Sounds=clear
LOC=Lethargic, responds
minimally to painful stimuli;
Weight=4.5 kg; PEARL;
Anterior fontanel bulging;
ICP=25 mmHg

2. Initiates monitoring and interprets

3. Implements measures to decrease
anxiety of parents

4. Establishes IV access

Transition: If time in state >5 minutes go
to Worsening ICP

HR=82; BP=110/64; RR=22;
Cardiac Rhythm=Sinus
Rhythm;

Cheyne-Stokes respiratory
pattern;
LOC=Unresponsive;

Right pupil blown;

Worsening ICP

1. Reassess, interprets findings, and
documents

2. Continues to monitor oxygenation and
neurological status

3. Recognizes worsening condition

4. Applies oxygen to maintain SpOy >95%.

5. Institutes measures to decrease ICP

ICP=35 mmHg
Transition: If Time in State > 3 minutes go
to Respiratory Arrest
Respiratory RR=0; 1. Initiates PALS
Arrest Breath Sounds=absent 2. Controls airway
bilaterally; 3. Reassess, interprets findings, and
Pupils blown bilaterally documents
4. Maintains head neutral, slightly elevated
once airway management completed
Transition: Manual to Improved at instructor’s
discretion
Improved RR=BV assisted ventilation; 1. Reassess, interprets findings, and

Breath Sounds=present
bilaterally with assisted/
controlled ventilation;
LOC=Unresponsive

documents
2. Establishes intravenous access
3. Gives isotonic fluid bolus of 20 mL/kg
4. Transitions care to a higher level
5. Calls report to admitting unit

Equipment/Supplies Needed

Body Substance Isolation/Standard
Precaution Supplies

Airway: Oxygen, Infant Oxygen Mask
(Medium and High Concentration),
Self-inflating Bag, LMA Size 1.5,
Endotracheal Tubes (Uncuffed Size 3.0,
3.5, 4,0 mm) and Stylet, Miller 1 Blade
and Laryngoscope, Infant Airways,
Suction

Equipment: Cardiac Monitor, Pulse
Oximeter, PediCAP/etCO5, NIBP,
Flashlight

IV Supplies: IV Catheters (24 gauge
Angiocath), Simulated 0.9% Saline IV
Solution, IV Tubing, Tape

X-ray Films

Printed Lab Values

Run Report or Appropriate Forms for
Documentation

References

Instructor’s Notes:

This scenario was created with “Baby
Ryan.” Other patients may be used, but
the physiology will be different than
what appears on this simulation card.

References:

Bayir H, Kohanek PM, Clark RS.
Traumatic brain injury in infants and
children: mechanisms of secondary
damage and treatment in the intensive
care unit. Critical Care Clinics. 2003.
19:529-49.

Dias, MS. Traumatic brain and spinal
cord injury. Pediatric Clinics North
America. 2004. 51: 271-303.

Listman, DA and Bechtel K. Accidental
and abusive head injury in young
children. Current Opinion Pediatrics.
2003. 15: 299-303.
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Scenario Scene

This is a 3-month-old male brought to his pediatrician for fever,
diarrhea and vomiting and poor oral intake. Mom and Dad state
he has had 24 hours of watery diarrhea and vomiting (nonbilious).
This afternoon he developed tactile fever and refused oral
intake. He is tachycardic, mottled and listless. The pediatrician
immediately transports the infant to the hospital ED across the
street from her office.

Past Medical History: Healthy up to 24 hours ago.
Immunizations up to date.

Past Surgical/Anesthetic History: None

Review of Systems:
CNS: Listless, poor oral intake, no seizures
Cardiovascular: None
Pulmonary: Noncontributory
Gl: Non-bloody watery diarrhea, greater than 10 stools
today. Emesis. No jaundice.
Renal / Hepatic: unknown if he has voided, mixed with stool
in diaper.
Endocrine: None
Heme / Coag:None

Current Medications: None

Physical Examination

General: Pale, mottled, listless

Weight: 6.7 kg

Vital Signs: Temp 39.3°C, HR 198 / min, RR 67 /
min BP 58/48, SpOy 93% room air, improves to
97% with blow by oxygen

Skin: Maculopapular rash chest and abdomen
HEENT: Fontanel flat (sunken), PERRL, Tympanic
membranes red and bulging, no nasal
discharge, mucous membranes dry

Airway: Patent, normal infant

Lungs: Quiet tachypnea, clear

Heart: Tachycardic, cold extremities below knees,
capillary refill time 6 seconds

Abdomen: Soft, mild diffusely tender, slightly
distended, hyperactive bowel sounds, liver 2 cm
below right costal margin

Laboratory, Radiology, and other relevant studies:
HCT 34%, WBC 16.7 with 53 segs, 18 bands,

23 lymphs, 6 mono

Platelet: 114,000

Chem 10: Na 129, K 5.6, CL 97, HCO3 15,
BUN 41, Cr1.2,Ca 7.9, Mg 1.6, POy, 4.3

ABG: 7.32, PaCOj 27, PaOy 78

Chest radiograph: Normal cardiac silhouette, clear
lung fields

Allergies: None as reported by mother

Learning Objectives

Recognize the manifestations of shock in
the infant.

Describe common etiologies for shock in
the infant: hypovolemic, septic,
cardiogenic.

Develop a treatment plan for infant shock
including fluid management,
vasopressors, and other medications such
as corticosteroids.

Understand the requirement for rapid
institution of intravenous access including
interosseus infusion.

Effectively communicate with other
members of the healthcare team.



Scenario States

State Patient Status Learning outcomes or actions desired
Baseline HR=129; BP=88/5; RR=40; 1. In each state, reassesses condition and
(Baby Ryan) Cardiac Rhythm=NSR; response to treatment
Sp0o=98%;
Breath Sounds=clear; Transition: When the instructor is ready to
LOC=alert; PEARL start the scenario, click the next button.
Shock HR=98; BP=57/46; RR 67; 1. Completes initial assessment, evaluates
Cardiac Rhythm=Sinus data collected, and documents
Tachycardia; 2. Initiates monitoring and interprets
Sp0»=93% on room air and | 3. Initiates oxygen therapy to keep
improves to 97% with blow Sp0o>95%
by oxygen; 4. Implement measures to decrease
Breath Sounds=clear; anxiety of parents
Temp=39.3°C; 5. Establishes IV access
LOC-=listless, responds to
painful stimuli; PEARL; Transition: If time in state >3 minutes to to
Anterior fontanel sunken Worsening Shock
Worsening HR=220; BP=52/39; RR=70; | 1. Reassess, interprets findings, and
Shock LOC-nonresponsive documents
2. Continues to monitor oxygenation and
neurological status
3. Recognizes worsening condition.
4, Considers fluid bolus
5. Considers vasopressor therapy to
maintain SBP >60 mmHg
Transitions: If time in state >5 minutes go
to Cardiopulmonary Failure
If crystalloid infusion >120 mL go to
Improved AND
If dopamine infusion started at
>5 mcg/kg/minute go to Improved
Cardiopulmonary | HR=72; BP=47/29; RR=10; 1. Initiates PALS
Failure Breath Sounds=diminished 2. Controls airway
bilaterally 3. Reassess, interprets findings, and
documents
4. Considers fluid bolus
5. Considers vasopressor therapy to
maintain SBP >60 mmHg
Transition: If crystalloid infusion >120 mL
go AND
If dopamine infusion started at >5
mcg/kg/minute go to Improved
Improved HR 140; BP 82/50; RR 40 1. Reassess, interprets findings, and

Breath Sounds=present
bilaterally; LOC=Responsive
to painful stimuli

documents
2. Transitions care to a higher level
3. Calls report to admitting unit

Equipment/Supplies Needed

Body Substance Isolation/Standard
Precaution Supplies

Airway: Oxygen, Infant Oxygen Mask
(Medium and High Concentration),
Self-Inflating Bag, LMA Size 1.5,
Endotracheal Tubes (Uncuffed Size 3.0,
3.5, 4,0 mm) and Stylet, Miller 1 Blade
and Laryngoscope, Infant airways,
Suction

Equipment: Cardiac Monitor, Pulse
Oximeter, PediCAP/etCO», NIBP,
Flashlight

IV Supplies: IV Catheters (24 gauge
Angiocath), Interosseus Needle,
Simulated 0.9% Saline IV Solution, IV
Tubing, Tape

X-ray Films

Printed Lab Values

Run Report or Appropriate Forms for
Documentation

References

Instructor’s Notes:

This scenario was created with “Baby
Ryan.” Other patients may be used, but
the physiology will be different than what
appears on this simulation card.

References:

Han YY, Carcillo JA, Dragotta MA, Bills
DM, Watson RS, Westerman ME, Orr RA.
Early reversal of pediatric-neonatal septic
shock by community physicians is
associated with improved outcome.
Pediatrics. 2003. 112: 793-9.

Thomas NJ and Carcillo JA. Hypovolemic
shock in pediatric patients. New
Horizons. 1998; 6:120-9.
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Scenario Scene

This is a 4-month-old female brought to the hospital for coughing
and wheezing. She has had a runny nose and low-grade fever
for 2 days. Her physician who prescribed Dimetapp elixir and
acetaminophen evaluated her yesterday. She is not breast
feeding well and refused pedialyte.

Past Medical History: She has a past history of prematurity,
born at 32 weeks gestation and 2100 grams. Discharged after a
2-week hospitalization.

Past Surgical / Anesthetic History: Inguinal hernia repair at 4
weeks of age

Review of Systems:
CNS: Fussy, poor appetite
Cardiovascular: Noncontributory
Pulmonary: Tachypnea, cough, yellowish nasal discharge
Renal / Hepatic: Noncontributory
Endocrine: Noncontributory
Heme / Coag: Noncontributory

Current Medications: Dimetapp elixir and Acetaminophen
Family/ Social History: 3-year-old brother has URI and cough.

Immunizations: DTaP / IPV/ Hib / PCV / Hep B (2);
No RSV prophylaxis. No tobacco exposure

Physical Examination

General: Alert, female infant with frequent cough;
Fussy, but consolable

Weight, Height: 4.9 kg

Vital Signs: Temp 38.1°C; HR 171 / min; RR 67 /
min; BP 65/47; SpOo 89% room air, improves to
94% with simple Op mask

HEENT: Fontanel flat, yellow nasal discharge,
Tympanic membranes translucent, pink and
mobile. PEARL

Airway: Normal infant, patent

Lungs: Nasal flaring, mild head bobbing,
intercostals and substernal retractions; Bilateral
equal breath sounds decreased at bases; bilateral
wheezing, expiratory phase prolonged

Heart: RRR, S normal, no murmur, capillary refill
time 3 seconds

Abdomen: Soft, non-tender, healed surgical scar
right groin

Laboratory, Radiology, and other relevant studies:
HCT 33%
WBC 11.9

Chest radiograph: Bilateral hyperinflation, right
upper lobe atelectasis, increased perihilar

markings; RSV nasal rapid test positive

Allergies: None as reported by mother

Learning Objectives

. Recognize signs of respiratory distress in

the infant.

. Understand the etiologies of wheezing and

bronchiolitis in the infant.

. Recognize the pulmonary manifestations of

respiratory syncytial virus (apnea,
bronchiolitis or pneumonia).

. Describe the treatment options for RSV

bronchiolitis including the use of
bronchodilators, corticosteroids and the
timing of instituting mechanical ventilation.

. Effectively communicate with other

members of the healthcare team.



Scenario States

State Patient Status Learning outcomes or actions desired
Baseline HR=129; BP=88/55; RR=40; | 1. In each state, reassesses condition and
(Baby Ryan) Cardiac Rhythm=NSR; response to treatment
Sp0y=98%;
Breath Sounds=clear; Transition: When the instructor is ready to
LOC=alert; PEARL start the scenario, click the next button.
Respiratory HR=170; BP=68/42; RR=66; | 1. Reassess, interprets findings, and
Distress Breath sounds=wheezing documents
bilaterally; 2. Initiates oxygen therapy to maintain
Sp0y=88%; SpOy >90%
LOC=alert; 3. Continues to monitor oxygenation and
Anterior fontanel flat neurological status
4. Recognizes worsening condition
5. Considers fluid bolus
Transition: If time in State >5 minutes go to
Worsening Respiratory Distress
Worsening HR=180’s; BP 95/72; RR 76; | 1. Reassess, interprets findings, and
Respiratory Sp0o=82% on room air and documents
Distress increases to 92% on 100% 2. Considers bronchodilator therapy

oxygen mask

(albuterol or levalbuterol)

Transition: Manual transition when
instructor ready to go to Bronchodilator
Responsive or Respiratory Arrest

Bronchodilator

HR=160; BP=82/50; RR=46;

1. Reassess, interprets findings, and

Responsive Sp0o=95-97% with 100% documents
oxygen mask; 2. Transitions care to a higher level
Breath Sounds=crackles 3. Calls report to admitting unit
bilaterally

Respiratory HR=92; RR=12; 1. Initiates PALS

Arrest Sp0y=78-83% on 100% 2. Reassess, interprets findings, and

oxygen mask;
LOC=unresponsive

documents
3. Transitions care to a higher level
4. Calls report to admitting unit

Equipment/Supplies Needed

Body Substance Isolation/Standard
Precaution Supplies

Airway: Oxygen, Infant Oxygen Mask
(Medium and High Concentration),
Self-inflating Bag, LMA Size 1.5,
Endotracheal Tubes (Uncuffed Size 3.0,
3.5, 4,0 mm) and Stylet, Miller 1 Blade
and Laryngoscope, Infant Airways,
Suction

Equipment: Cardiac Monitor, Pulse
Oximeter, PediCAP/etCO», NIBP

IV Supplies: IV Catheters (24 gauge
Angiocath), Simulated 0.9% Saline IV
Solution, IV Tubing, Tape

X-ray Films

Printed Lab Values

Run Report or Appropriate Forms for
Documentation

References

Instructor’s Notes:

This scenario was created with “Baby
Ryan.” Other patients may be used, but
the physiology will be different than what
appears on this simulation card.

References:

Black CP. Systematic review of the
biology and medical management of
respiratory syncytial virus infection.
Respiratory Care. 2003. 48: 209-31;

Davison C, Ventre KM, Luchetti M,
Randolph AG. Efficacy of interventions
for bronchiolitis in critically ill infants: a
systematic review and meta-analysis.
Pediatric Critical Care Medicine. 2004.
5:482-9.

Panitch HB. Bronchiolitis in infants.
Current Opinions Pediatrics. 2001.
13:256-60.
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Scenario Scene

This is a 6-month old male with cystic fibrosis. You are called
urgently to the patient’s room because the pulse oximeter
oxygen saturation has dropped into the low 80’s and the infant
is less active. He just returned from the treatment room where a
PICC line was inserted under conscious sedation. The patient’s
nurse had flushed the IV injection port just before the event.
Fentanyl and midazolam were administered into the injection
port during the sedation.

Past Medical History: Cystic fibrosis, mild lung disease.

Past Surgical / Anesthetic History: Exploratory laparotomy for
meconium ileus, DOL 1

Current Medications: Vancomycin, ceftriaxone, Vitamins (A, D,
E, K), Pancreatic enzymes

Physical Examination

General: Unresponsive, cyanotic lips and nail beds
Weight: 7.8 kg

Vital Signs: Temp 36.5°C, HR 116 / minute,
RR 8 / minute, BP 88/64, Sp0s 84%

Airway: Normal appearing infant
Lungs: Suprasternal retractions, paradoxical
respirations, decreased breath sounds bilaterally,

no wheezes. Some crackles bilaterally

Heart: RRR no murmur

Laboratory, Radiology, and other relevant studies:

None

Allergies: None

Learning Objectives

Recognize apnea and its manifestations.
Identifies the etiologies of apnea.
Describe treatments for sedation-induced
apnea including various airway
management techniques and antagonist
therapies (naloxone, flumazenil).
Effectively communicate with other
members of the healthcare team.



Scenario States

State Patient Status

Learning outcomes or actions desired

Baseline
(Baby Ryan)

HR=129; BP=88/55; RR=40;
Cardiac Rhythm=NSR;
Sp0y=98%;

Breath Sounds=clear;
LOC=alert; PEARL

1. In each state, reassesses condition and
response to treatment

Transition: When the instructor is ready to
start the scenario, click the next button.

Opioid Induced | HR=116; BP 68/42; RR 8;
Apnea/UAO Breath sounds=crackles
bilaterally; Sp0y=84%;
Temp=36.5°C;
LOC-unresponsive;
Pupils pinpoint bilaterally;
Weight=7.8 kg;
Laryngospasm on

1. Assess, interprets findings, and
documents

2. Initiates oxygen therapy to maintain
SpOy >90%

3. Controls airway

4. Continues to monitor oxygenation and
neurological status

5. Recognizes worsening condition

6. Considers antagonist administration

Transition: Manual transition to Improved
once antagonist administered

Manual transition to Airway Insertion upon
discretion of instructor

Airway Insertion | Laryngospasm off

1. Reassess, interprets findings, and
documents
2. Controls airway

Transition: Manual transition to Improved
once antagonist administered

HR=120; BP=82/50; RR=40;
Sp0o=98% on room air;
Breath Sounds=crackles
bilaterally;

LOC=alert;

PEARL 4 mm bilaterally

Improved

1. Reassess, interprets findings, and
documents

Equipment/Supplies Needed

Body Substance Isolation/Standard
Precaution Supplies

Airway: Oxygen, Infant Oxygen Mask
(Medium and High Concentration),
Self-inflating Bag, Miller 1 Blade and
Laryngoscope, LMA size 1.5,
Endotracheal Tube (Uncuffed Size 3.0,
3.5, 4.0 mm) and Stylet, Infant Airway

Equipment: Cardiac Monitor, Pulse
Oximeter, NIBP and PediCAP/etCO»

IV Supplies: Has PICC, Simulated IV
Fluid and Tubing

X-ray Films
Printed Lab Values

Run Report or Appropriate Forms for
Documentation

References

Instructor’s Notes:

This scenario was created with “Baby
Ryan.” Other patients may be used, but
the physiology will be different than what
appears on this simulation card.

References:

Gozal D. New concepts in abnormalities
of respiratory control in children.
Current Opinions Pediatrics. 2004.
16:305-8.

Gill AM, Cousins A, Nunn AJ, Choonara
|A. Opiate-induced respiratory
depression in pediatric patients.
Annuals Pharmacotherapy. 1996.
30:125-9.

Coté CJ, Notterman DA, Karl HW,
Weinberg JA, McCloskey C. Adverse
sedation events in pediatrics: a critical
incident analysis of contributing factors.
Pediatrics. 2000. 105: 805 -814.
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E}Ba bySI Mo ?t?rting A Patient Starting A METI Preconfigured Scenario

- -'. imulation |- Scenario| Condition  Drugs | Fluids < s th Ste
Patients H < Fourth Ste < even p
P With a patient open, select

IMPORTANT: To set up your BabySIM for use, you will

Baby Ryan.hps In the Patient Palette, select Show: | Player [ — .
need to follow the steps on the BabySIM Set Up Map or the Open icon to get a list of :;ﬁ;‘::“;;:’;;:"s;tt:‘; ;
refer to the Set Up/Breakdown section of the BabySIM available patients, or select  Scenario &) . . Player is the active selection.

New to create a new patient.

Use the Scenario pull down
menu and click Open.

User Guide. The following content and screen shots
include software oriented instructions to help you quickly

and easily start a session.

Selection:

Baby Ryan.hps

Login Steps S (o) @OE Scenario [ = <Shortcut
Open... 4 %20 The Scenario menu also has
Edit_Format__Window Increased ICP.hs6 an Open Recent selection
New 5 <Shortcut Close Sl onchiahtishst that will list the last 10
Open... %0 = In the HPS b Inknt Shock he6 /. opened or saved scenarios.
. Fussy Baby.hps n the N menu bar, Clear Menu
4First Step K Baby Ryan.hps under Patient, you can
When prompted e o — select Open Recent to
by the login : P see a list of the last
window, select Stop 10 patients previously
“HPS User.” opened or saved.
T Password Page Setup... e <] Open file... .
Print... 8P m 4 Elghth Step
When Open is selected, an Open/Save
s AL dialog box will appear. Use the pull down
RSV Branchiolitis.hs menu to scroll through the list of available
Sedation Induced Apnea.hsé . .
preconfigured scenarios or custom
scenarios you may have saved.
«second step | COnnecting a Patient to a Simulator
Type in the password:
hps (all lowercase). Saby fyan (1) @ focalhass =
T Selection:
n-u?'-s .E’ un:u:l:j:.'wlll ,WE.'.',“ <Fifth Step Infant Shock hsé ]
- SRR vt S0 Comihfon s g o oo = Ry’ On the far right of the Patient W Ready. ( cancel )
AP

AT icons. Select the Connections

@ MEI'I Window, there are two connection
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Bby Ryan mannequin. Scenario ¥ [ Infant Shock.hs6 + 1] o]
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will appear. T Dom B Onwel e EE Baseline 00:00:27  (( Next )

A Connection Drawer will
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Opening a Saved

- Simulation | Scenarie | Condition Drugs

Show + Player

' Scenario

I Simulation | Scenario | Condition = Drugs  Fluig

H,.’_

Show: Player

' Scenario ﬁ

ace Open file...

Baby Scenarios E

Increased ICP hah

Infant Shock b6

RSV Bronchiolitis, heé
Sedation induced Anneahsg

. | <Third

double

Scenario for Editing

4First Step
With a patient open,
select the Scenario Tab,
then select Editor from
the Show pop up menu.

4Second Step
Using the Scenario pull down menu,
open the desired scenario using
either Open or Open Recent.

Step

If you use Open, click on
the desired scenario
sub-directory and then

click on the

scenario or select Open.

£ The scenario is now ready
preien ] for editing.

| Sadarion induced Apreshit

T o) (EBRRD

Developing a New Scenario

~! Simulation | Scenario | Condition Drugs

Show v Player

' Scenario

4First Step
With a patient open, select the
Scenario Tab, then select
Editor from the Show pop up
menu.

4Second Step

Using the Scenario pull
down menu, select New.

[scenario [+
New 23N s
Open... 080
Open Recent »
Close O3B
Save a2
Save as..
New State CIEN
New Event >
New Transition vosel |
Smisos BWRMNS Condiion  Drug | Mudy  Caveassisr  Resorsioy
Show: | Edaor =
s L — L
No Selection

4Third Step
The new scenatrio is displayed as
a blank template in the Scenario
Editor window, and “Untitled”
appears in the name field.

General Scenario Editing Pointers

' Scenario H Untitled1
. New 38N
Open... {380
Open Recent >
Close 8w
Save {8V
Save as...
New State 3N
New Event >
New Transitior el b
Scenario ¥ | Untied1 i) il
I
» Events
» Transivons
[ = — MLl
Change state name to:
Newstatel ( Apphy

Redo

8o Cut X i
3 ~ Copy  %C
New=Q r'_' Paste AT
T Brere
PN EieE ey

Bl Find

Undo

lect All - %A

| 2
Ell  Spelling >

Format  Window

EZ
D87

Shaw

Emidorion (RS Cordiion e
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Fisdy | Candimac,

lar | Regpiramory

4New State & New Event

To create New States and New Events,
use the Scenario Editor menu.

4 Editing New State Names
Select the state you wish to name
and type in the name in the editor
window. Click Apply. Use the same
steps to edit existing state names
you wish to change.

4Deleting States
Highlight the state you want to
delete and press the Delete key
(not the “del” key) or select
Clear from the HPS Edit menu.

4Closing a Scenario
Click on the Scenario menu in
the Scenario Tab. Select Close
from the pull down menu.

Scenario [ | infant Shock bk 7] helll
| Open.. oX0 |
| Open Recem rl
» irproved
Cwrrens frace: Se3te nme
show: | Edisor )
scenario 8] urived1 ] [ []
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Save RV
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4Saving a Scenario
You must use the Save As menu
selection from the Scenario menu
to save changes that you made to
a preconfigured scenario.

4 An Open/Save dialog box will
appear so you can save your
scenario to your user directory
(i.e. /Users/Shared/).

Stopping a Patient

Baby Ryan (1) @ bocalhant

00:01:41 W
Detach Tak Necorder Patiest Time

4 Stopping a Patient
To quickly end your session, simply
click on the Stop icon in the
Patient Window toolbar (or in the
sy Ryat  Patient Palette). The system will
automatically prompt you to save
your patient. Select Don’t Save.

B ——— g

Save  Stop Lo_gs D¢

Power Off Steps

ﬂ'.\faveform BIEHETE File Edit  Simulato

About Waveform Display. ..

4First Step
Quit the Waveform Display
application by selecting Quit from
the Waveform Display menu bar.

Preferences
Services >

Hide Waveform Display  86H
Hide Others HEH

howAll Once the software is shut down,
Quit Waveform Display [ #Q turn off the Waveform Display
Monitor.

BHPS Patient Edit Format Window

About HPS...
Modify User Drug Responses...

4Second Step
Quit the HPS application
by selecting Quit from the
HPS menu bar.

Connect to Patient Model... 8K

Services | J

Hide HPS
Hide Others
Show All

#®H

Quit HPS [

Finder File Edit View Co Windo

About This Mac
Get Mac OS X Software...

4Third Step
Shut down the Instructor
Workstation by clicking on
the Apple and selecting
Shut Down.

System Preferences...
Dock >
Location >

Recent Items >
Force Quit...

Sleep
Restart..

Fourth Step Disconnect hoses and cables from PCU

Fifth Step Close PCU and set aside for storage

Sixth Step Clean up mannequin and prepare for storage

Seventh Step

Secure all gases and store all equipment
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16

Prepare Work Area and Place Mannequin on the Work

Attach Umbilical Assembly to Mannequin

Prepare the PCU

rface

Connect the Fluidic/Pneumatic Umbilical to the PCU

Connect the Electrical Umbilical to the PCU

Connect Compressed Air/Gas to MAIN SUPPLY Port

Connect Gas Supplies

Set up the Instructor Workstation for Power

Set up the Waveform Display Monitor for Power

Connect Instructor Workstation to the Waveform Display Monitor

Connect Ethernet Cable to Instructor Workstation and to the PCU

Connect PCU Power Cord

Power on the PCU

Power On the Waveform Display Monitor

wer On the Instructor Workstation and

Power On the Wireless Remote Control and Login

Set up the Wireless Remote Microphone

Mannequin Umbilicals

a
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Connect Workstation & Waveform : Ethernet Port
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Attach Fluidic/Pneumatic UmbiIicaI‘ " yoo = 4 = Power On

Step 15
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Power On Waveform - Sét Up Wireless Remote






